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LICENSE NUMBER

ASM uses the License Server to store and validate ASM licenses. During installation, you are
prompted to choose whether you are installing an evaluation copy of the product or a licensed
copy of the product.

To install ASM as an evaluation copy, select the evaluation option on the licensing page of
the setup wizard. Installing an evaluation copy of ASM will not require you to enter any
licensing or license server information. The evaluation version of ASM is valid for 30 days.
ASM automatically sets up an Alert notifying you of the pending expiration of your
evaluation version each time the ASM service starts.

Once you purchase a license for ASM, you must contact your sales representative to obtain
the product license number. A license number based on your machine ID and other licensing
requirements you provide them will be sent to you for activating ASM. Enter that license
information using the New License Wizard in the License Server Administrator.

Once the ASM license is entered in the License Server, use the Setup wizard to update the
licensing information for ASM. Select the Edit product license information option in the
Setup wizard and enter the name for the License Server computer into the wizard on the
Licensing Information page.

For further information about registering license information in the License Server, refer to
the License Server System Guide.
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PREFACE

APPLICATION STORAGE MANAGER AND DISKXTENDER

The Windows NT/2000 edition of Application Storage Manager™ (ASM) was
developed for StorageTek by OTG Software and is based on their DiskXtender (DX)
product. With ASM and a full line of world-class tape drives and tape libraries,
StorageTek can deliver A COMPLETE SOLUTION for cost-effective storage
management of your standalone and distributed Windows NT/2000 systems.

BENEFITS

DISKXTENDER allows you to extend the capacity of NTFS volumes by automating
migration of files to storage media. DISKXTENDER uses separate media services to
manage media in storage devices, so that all drive, library, and media specific issues
are handled and optimized by the media service (like MEDIASTOR). This enables
DISKXTENDER to focus specifically on the management of files, allowing clients to
simply save and retrieve files on any extended NTFS volume.

With DX, many terabytes of data storage can be made available on an NTFS volume
without adding to the physical capacity of the hard disk where the volume is located.
DX can be used to represent the contents of multiple pieces of media as folders on a
single volume, keeping track of the exact location of all files on media. CD-ROM,
Erasable-Optical (also called Magneto-Optical), WORM, DVD, and Tape media can
all be managed easily and effectively, using a variety of file systems.

DISKXTENDER adds value to the NTFS file system, enhancing Windows native
capabilities by providing file migration services. Because of the design of
DISKXTENDER, file migration can be added without losing any Windows features.
Windows NT/2000 manages all issues like security, long file name support, and
network connectivity.

DX provides a rule-based system for file storage management. Rather than simply
migrating all files to media without distinction between files, DX allows you to set
criteria that govern which files will be stored where. Using the rules you create, DX
manages file storage locations in the background, moving files to media and purging
their data to make space on the extended drive. To the end user, however, all files
appear to be located on the drive extended by DX.

APPLICATION STORAGE MANAGER vii
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DX provides comprehensive file management capabilities, a single point of
administration, and scheduling features to optimize system performance. Time-
consuming processes that compete for system resources — such as media restore,
media compaction, and file movement to media — can be set to occur at convenient
times. DX also monitors system warnings and errors, and can be configured to send
alerts to specific users or computers.

This data management guide explains how to setup and configure the components
necessary for file migration in the DX system. In addition, the Storage Media Tasks
chapter provides information and instructions for scheduling media tasks, allowing
you to more effectively utilize downtime for accessing network resources.

CHAPTER SUMMARY

The following table summarizes each chapter of this document:

Table 1: Chapter Summary

CHAPTER:

DESCRIPTION:

Chapter One:
Introduction on page
1

Chapter Two: Setting
Up File Migration on
page 31

Chapter Three:
Managing File
Migration on page 83

Chapter Four: Space
Management on page
137

This chapter provides a brief overview of the system,
including its concepts and components.

This chapter details the steps for extending an NTFS
volume. Instructions are provided on creating extended
drives, creating media folders, assigning media to media
folders, grouping media into move groups, and creating
move rules for the files on the extended drive.

This chapter provides information on administrative
activities for file migration components. Details on
removing and modifying move groups and move rules
are contained in this chapter.

This chapter discusses the components necessary to
manage space on the extended drive. Instructions are
provided for creating and managing purge and delete
rules.

viii
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CHAPTER: DESCRIPTION:
Chapter Five: This chapter provides details on accessing and executing
Managing Storage media commands and media manager functions.

Media on page 177

Chapter Six: Storage
Media Tasks on page
225

Procedures for viewing media properties are also
documented here. In addition, use of the Media Task
Manager, Copy Media Manager and Media Prepare
Manager are discussed.

This chapter describes and provides instructions for
assignment of each of the media tasks that can be
performed in DX: format, label, label copy, file report,
compact, restore, prefetch, check disk, add to extended
drive, remove from extended drive, add to move group,
and remove from move group.

RELATED DOCUMENTATION

Refer to the following additional documentation:

% DISKXTENDER System Guide

& & & ¢

DISKXTENDER Getting Started Guide
MEDIASTOR System Guide if using OTGMS as a media service
ACSLS documentation if using ACSLS as a media service

Tivoli Storage Management documentation if using TSM as a media service

DOCUMENTATION CONVENTIONS

Consistent formatting is used throughout the DISKXTENDER Data Management Guide
to represent certain information.

APPLICATION STORAGE MANAGER
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Table 2: Documentation Conventions

THIS CUE: REPRESENTS:

monospaced text Characters that must be typed on your screen exactly
as they appear in this document.

<SMALL CAPITALS> Keys on your keyboard used in combination or
sequence. For example <ALT>+B means to hold down
the <ALT> key while pressing B, and <ALT>, F, X
means to press and release each of the keys in order:
first <ALT>, then F, then X.

ALL CAPITALS Directory names, filenames, and acronyms.
italics References to manual titles, chapter titles, and section
headings; placeholders; and emphasis.
Warnings about actions that could have adverse
WARNING & affects on the functionality of the DX system.
Precautionary note

between two lines.

Additional information needed as you follow the step-
NOTE & by-step operations in this manual.
Explanatory note

between two lines.

Help is available online from any DISKXTENDER dialog box. For a description of the
dialog box, press the <F1> key. A Help window appears, outlining the dialog box
parameters and fields.

A knowledgebase help file with error descriptions, tech notes, software notes,
fixed/known bugs is also available in the OTG DISKXTENDER program group on the
Start menu. All DX2000 guides, including this one, are also available in PDF format
on the installation CD.

X APPLICATION STORAGE MANAGER
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CHAPTER
ONE

INTRODUCTION

DISKXTENDER (DX) is a storage management system that provides support for
multiple media types, flexible media and data organization, and rules-based file
migration. DX accomplishes this through an easy-to-navigate interface, and
transparent communication with storage locations and device management software.

DISKXTENDER allows you to extend the storage capabilities of NTFS volumes by
using DX file migration services to move files from the NTFS volume to other, less-
expensive storage media. For example, users on your network may typically save
data to an NTFS volume on your Windows NT/2000 file server. You can vastly
expand file storage capabilities by extending one or more of the file server’s drives
with DISKXTENDER. File data on a drive extended by DX can be moved to media
through a media service (e.g., to tape in a library managed by OTG’s MEDIASTOR)
without affecting the file listing seen by the end user.

You are the architect of the DISKXTENDER system. DISKXTENDER allows you to
leverage your existing hardware configuration or create a new one. The powerful
features of DX, combined with an easy-to-use graphical user interface, allow you to
fine-tune a file storage strategy for any type of application requirement. Because DX
supports several media services, media types and file systems, you can select a
storage configuration most suited to your available resources and your storage needs.
You can design move rules that control the transfer of files to media, using detailed
criteria such as file age, file size, file type, and file attributes. You can set up purge
rules that purge file data that has already been moved to media in order to maintain
available space on the extended drive. You can also choose which folders on the
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extended drive will contain DX files and what media will be used to store files
moved under a particular move rule.

Before designing a storage strategy, you should be comfortable with DISKXTENDER
terminology and concepts. In addition, many of the issues discussed in this guide
should be carefully planned before implementing a DX storage strategy. Take the
time to read all sections, as this will help you attain the best performance,
functionality, and organization for your storage solution.

This section identifies key terminology and concepts that are vital for you to
understand. Included are descriptions of DX modules, conceptual and practical
definitions, as well as guidelines for planning and implementing your DX storage
strategy.

A DISKXTENDER GLOSSARY

To make it easier for you to follow the discussion of DX architecture in this chapter,
here are brief descriptions of key terms used in the DX Concepts section and
throughout this guide. You can either read this glossary first or refer to it as needed
while you read about DX.

Table 3: DISKXTENDER Glossary

TERM: DEFINITION:

ACSLS ACSLS is a device management software product that runs
on a UNIX platform. DX can use an ACSLS installation as a
media service. ACSLS has the ability to manage retrieval of
media in some StorageTek tape libraries.

Compaction Compaction is the process of reclaiming used storage media
in the DX system by eliminating wasted space taken up by
outdated copies of files or files marked for deletion.
Compacting media copies all active (non-deleted and current
versions of) files from media back to the extended drive, and
then removes the media from the media folder, so that it can
be reformatted and used again. The files that were copied to
the extended drive will ultimately be moved back to media
based on the move rules for the media folder.

Drive A drive is a hardware device through which media can be
read or written to.
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TERM:

DEFINITION:

Extended Drives

File Data

File Tag

File Migration

File System

Hard Drive

Hardware Device

Jukebox/ Library

An extended drive is an NTFS volume (hard drive) from
which DISKXTENDER provides file migration services by
moving files to media and fetching files from media
according to the parameters you set.

File data is defined as the contents of a file. For example, in
a word processing file, the File Data is the actual information
or content in the file, as opposed to the metadata that the
operating system, software program, or DX uses to identify
and manipulate the file.

A file tag is the identifying information for a file. The file tag
includes such information as file location, file attributes, file
size, and file age. This is sometimes referred to as
“metadata,” though true metadata includes other information
in addition to the file tag.

File migration is the process of moving files between an
extended drive (NTFS volume resident on the DX computer)
and external storage media. Moving files from the extended
drive to storage media is called a “move,” and retrieving files
from storage media back to the extended drive is called a
“fetch.”

A file system is software that provides an interface for saving
and retrieving files on storage media. File systems control all
aspects of media management, including directory/file
structures, data layout, and data transfer.

A hard drive is computer hardware that holds and spins a
magnetic or optical disk, and reads and writes information to
the disk. Often, large hard drives are partitioned into multiple
drives or “volumes.” These multiple volumes are also
sometimes referred to as “hard drives” or just “drives.”

A hardware device is a device that contains one or more
drives through which media can be accessed.

A jukebox or library is a hardware device containing one or
more removable media drives, shelves for pieces of media,
and a mechanism for moving pieces of media between the
shelves and the drives.

The terms “jukebox” and “library” are interchangeable. In
most instances in this manual, the term “library” is used to
refer to libraries or jukeboxes.
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TERM:

DEFINITION:

Logical Media

Managed Files

Media

Media Pool

Media Service

Media Type

Network
Attached Storage
(NAS)

A “logical” piece of media is a piece of media that is defined
by its location on a piece (or pieces) of media rather than by
the physical constraints of the media itself.

For example, a network share that shares a single folder to
the network could be treated as a piece of logical media in
DX. In contrast, a RAID device, which has multiple drives,
could also be treated as a single piece of logical media if the
entire device was shared as a single network share.

A file is not considered “managed” by DISKXTENDER until
DX has moved the file’s data to media. Even if a file is saved
to a DX media folder on an extended drive, DX does not
recognize responsibility for management of the file data until
DX has moved the file’s data to external storage media.

Media refers to a physical medium on which data is written,
and from which data can be retrieved. Depending on the type
of media, the medium may be different and the information
may be recorded in different ways.

In most instances in this manual, the term “media” refers to
the storage media to which DISKXTENDER files are migrated.

A media pool is a reserve of pieces of media available for
use with a particular extended drive.

A media service provides access to media to which DX
migrates files. In some cases, the media service is a network
share. In other cases, a media service is a device
management service that will retrieve a specific piece of
media, and mount the media in a device (such as a library
drive) when requested to do so.

The type of a piece of media is determined by the
composition of the media and the method used to record
information on that media. Some examples of media types
are Erasable Optical (Magneto-Optical) media, CD-ROM
media, DVD-RAM media, and tape media.

Network Attached Storage is logical media that has been
shared to the network to allow network users to access the
media. DX can point to any network share as a piece of
Network Attached Storage media.
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TERM: DEFINITION:

NTFS Volume An NTFS volume is a piece of stationary media or a partition
on a piece of stationary media that has been formatted with
the NTFS file system.

OTG MEDIASTOR OTG’S MEDIASTOR is a device management package that

(OTGMS or can be used as a media service by DX. OTGMS has the

MEDIASTOR) ability to manage retrieval of media in a wide variety of

Removable Media
Drive

Removable Media

Stationary Drive

Stationary Media

hardware devices.

A removable media drive is a drive where different pieces of
media can be inserted and removed as needed, such as a CD-
ROM drive.

Removable media is media that must be mounted in a drive
before it can be accessed. Removable media can be inserted
and removed as needed to allow for access to multiple pieces
of media.

A stationary drive is a drive where the same piece of media
is always mounted, such as the hard drive on your computer.

Stationary media is media that is always mounted in a drive
and cannot be removed without removing the entire drive.

The architecture, components, and data management tools of DISKXTENDER are
discussed in this section. For an overview of each of the following concepts, see the

following sections:

Y  DISKXTENDER Components - see below

& & & & &

DISKXTENDER'’S Distributed Storage Model — see page 8
Media Services — see page 9

Extended Drives — see page 10

Media Tasks — see page 19

Media Management Tools — see page 25
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Y  Event Scheduling — see page 26

% Client Connectivity — see page 29

DISKXTENDER COMPONENTS

DISKXTENDER is comprised of several components, or modules and each have
specific functionality within the system. Several of these modules are discussed
briefly in the sections that follow.

DISKXTENDER Data Manager Service

The DISKXTENDER Data Manager Service is a Windows NT/2000 service that runs
on the computer where DISKXTENDER is installed. All media, schedule, and extended
drive management is coordinated by the DX Data Manager. The DX Data Manager
service uses two auxiliary drivers; the DxSpy driver and the DxSpyRec driver, to
monitor and report file activity on the extended drive. These drivers watch for
changes in the folders designated for DX file migration services, intercept requests
for migrated files, and track the addition, modification, or deletion of files. The DX
Data Manager moves, purges, and deletes files on the extended drives according to
the file move, purge, and delete rules that have been set for the extended drives. The
DX Data Manager communicates with computers offering media services (hardware
device management) in order to retrieve files that need to be fetched from media, and
to send files that need to be migrated to media.

DX Data Manager functionality can be managed through the DX Administrator,
either on the DX Data Manager machine or from any remote installation of the DX
Administrator.

DX Administrator

The Administrator allows you to view and configure the underlying structure of the
DX system. The Administrator provides you with a single interface for managing
one or more DX computers and the extended drives on those computers. Through
this module, you can manage all major aspects of the DX system:

% Media services connectivity (connectivity to storage media and to the device
management software that manages the storage hardware devices containing
storage media)

% Drive saver and timeslice settings (for drives in the storage devices managed by
the media services)
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% Functionality of extended drives (the NTFS volumes for which DX provides
data management services)

The Administrator has an intuitive “tree” view where DX extended drives and the
configuration items for those extended drives are grouped as sub-trees.

All aspects of extended drive functionality can be configured through the
Administrator. You can assign pieces of media to an extended drive and to media
folders, and then define rules to control the management of files in the media folder.
You can set up schedules to control when events, such as file migration and
processing of media management tasks, occur. You can configure alerts to send
messages alerting a particular user or workstation to DX errors or warnings relating
to the extended drive. In addition, you can view event, warning, and error logs and
run reports on various aspects of DX system functionality.

Enterprise (Remote) Administration

Regardless of whether you are running a full installation of DX or only the Remote
Administrator, the Administrator interface for DX can be used to configure any DX
computer visible on the network (provided security settings allow access). Because
enterprise (remote) administration capability is automatically installed when you
install DISKXTENDER, you can remotely administer any DX computer from any other
DX computer. You can also use the DX Remote Administrator Setup to install only
remote administration components, if that is all you need on the administration
computer. DX (full installation) needs only to be installed on computers containing
the NTFS volumes that DX will use as extended drives. It is important to be sure,
however that the same version of DX (or DX Remote Administrator) is installed on
both the administering computer and the remote DX computers it is being used to
administer.

Online Help

DX contains context-sensitive help links that provide instructional help and
examples. The Online Help is automatically installed with DX and with the DX
Remote Administrator). Press the <F1> key at any time to get help on the currently
displayed dialog box, window or wizard page. You can also access the online help
from the program group in the Start menu. The program group also provides access
to the OTG Knowledge Base.
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DISKXTENDER’S DISTRIBUTED STORAGE MODEL

DISKXTENDER is one component of a distributed storage system. Within this system,
DX is responsible for managing the movement of data from NTFS volumes to a pool
of storage media. Once a media service has provided access to media, DX
communicates directly with the media to read and write data and perform media
tasks.

Various media services can be responsible for providing access to media pools. Four
types of media services are available for use with DX: Network Attached Storage
(NAS), OTG MEDIASTOR (OTGMS), StorageTek’s ACSLS, and Tivoli Storage
Manager (TSM) media services. DX connects with these media services either
through a network share or through Remote Procedure Calls (RPC). DX transfers
files to the media provided by the media services and sends requests for pieces of
media to the media services as needed.

Figure 1: DISKXTENDER Architecture
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This architecture allows you to set up the components of your storage solution on
several computers, and avoid the bottleneck of a single-server/multiple-client
architecture. You can configure remote storage of files distributed across a network,
while maintaining a high level of scalability and administrative flexibility.

DX monitors activity on extended drives and then communicates with media services
for media to be retrieved as needed. DX relays each request for a piece of media to
the appropriate media service. The media service then mounts the media so DX can
retrieve or store files or carry out media tasks. DISKXTENDER transparently manages
the connections between DX and the media services and the movement of files
between the extended drive and the media pools. The client (i.e., end user)
connection to the extended NTFS volume is managed entirely by Windows
NT/2000; DISKXTENDER is not involved in client connectivity at all.

This configuration allows you as the administrator to “extend” the capacity of hard
drives on your network servers, seamlessly to the end user. The end user saves files
to and retrieves files from the NTFS volume, unaware that that volume has been
extended and is being managed by DX. Because clients connect to Windows
NT/2000 rather than DX, the extensive connectivity offered by Windows NT/2000
remains in effect. Any client that can connect to a Windows NT/2000 server can
access files on an extended drive.

MEDIA SERVICES

When you configure a DX computer, you must configure media services for that
computer before you can move files to media. Media services provide access to
media. When you configure a media service in DX, you point to the location where
the media for the media service resides and, where appropriate, to the device
management software that controls the device(s) that will access the media.

DX manages all functions relating to the transfer of information to and from media.
The only role of a media service is to place pieces of media in a location where DX
can work with the media. DX performs all movement and fetching of files and all
media tasks through direct communication with media and media drives.

When DX needs a piece of media, it sends a request to the appropriate media service
for that media. If the media service is a network share (NAS media), the media is
already available and DX can proceed with the function that needs to be performed.

If the media service involves a device management product, the media service will
cause the device being managed to retrieve the media or will prompt the
administrator of the media service to insert the appropriate piece of media. For
example, if MEDIASTOR is being used to manage an optical library, MEDIASTOR will
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cause the picker arm of the library to retrieve the correct piece of media and insert
that media in a drive where the media can be read from or written to. Once the media
is in the drive, DX can write files to the media, fetch files from the media, or carry
out media tasks such as formatting or labeling the media.

An extended drive is an NTFS volume (hard drive) from which DISKXTENDER
provides file migration services, moving files to media and fetching files from media
according to the parameters you set. Frequently used files can be kept on the NTFS
volume, while less active files can be moved to storage media. It is the addition and
use of the storage media through DX that “extends” the space on the NTFS volume
by moving files to storage media and purging the file data while making the file
appear to still reside on the extended drive.

To a client retrieving files from a drive extended by DX, all files appear to be present
on the NTFS volume, whether the file data is actually present on the extended NTFS
volume or only on the storage media. According to move and purge rules that you
configure, DX moves files to storage media and then purges the file data from the
extended drive. When the file data is purged, DX leaves a file “tag” on the extended
drive containing file information, such as the size and time and date of creation or
modification. The file tag also contains an attribute, left by DX, that points to the
location of that file on storage media. When the extended drive is viewed through
Windows Explorer, the entire file appears to still be stored on the hard disk of the
extended drive, even if its file data has actually been purged.

Every DX computer must have at least one extended drive that defines relationships
between directories, media, and ultimately where new or modified files are moved.

ENABLING FILE MIGRATION FOR AN EXTENDED DRIVE

Once a drive or NTFS volume has been extended, certain steps must be taken before
DX can migrate files from the extended drive to storage media.

Add media to the media folder(s)

Adding media defines the media folder(s) in which the media will be placed on the
extended drive. A media folder is an actual directory on the extended drive whose
contents represent the directory structure on the media that is “in” that folder. If
media added contains existing files and directories, those files and directories can be
added (restored) to the media folder on the extended drive so that they are available
to client applications.
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Create move groups

Move groups allow you to create sets of media within a particular media folder. Each
set or group contains the media to which each move rule will migrate files.

Create move rules

This process defines a list of rules that determine what new/modified files will be
moved to storage media. Each move rule points to a move group, which determines
to what media the qualifying files will be moved.

Create purge rules

You create purge rules to automatically remove file data for files that have been
moved to media. Purging a file only removes the file data, leaving behind a file tag
that holds file information to be displayed in Windows Explorer and marks the
location of the file on the media. These file tags are what make the file appear to still
be resident on the extended drive.

Create delete rules

You can also set up rules that will automatically delete files from the extended drive
when the files meet specified criteria. When files are deleted using a delete rule, they
are deleted from both the extended drive and the media where they are stored. Once
deleted, DX has no way to track files, and cannot retrieve them.

Set up a Drive Scan schedule for extended drive

Any files that qualify for move or purge under rules that include age exclusions
cannot be added to the move or purge lists unless the extended drive is scanned to
find those files. If you configure any time delays when you create your move and
purge rules, you must periodically perform drive scans to update the move and purge
lists.

While files qualifying for a move rule with no time delay are automatically added to
the move list, file-sharing issues or sharing violations can prevent files from being
added to the move list when appropriate. DX must have full access to the file in
order to obtain information required for the move list. If the file is open or is
otherwise being accessed by a program or user, DX cannot add it to the move list.

Because files may not be added to the move list due to file-sharing issues, regular
drive scans are required to be sure that all appropriate files are written to the move
list when they qualify. Setting a drive scan schedule makes it easy to be sure
extended drive scans are run regularly, and allows you to run them during low
system-traffic times.
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Set up Move Files to Media schedule for extended drive

Once you have configured the rules that determine which files will be moved,
purged, or deleted on the extended drive, you need to make sure that there is an
active move schedule to allow movement of files from the move list to media. You
can set up a specific schedule for the extended drive. It is recommended that you set
your Move Files to Media schedule for times when traffic on the network is low.

You can create multiple extended drives and/or multiple-media folders to make the
file hierarchy more specific and detailed, or choose a more simple structure. Basic
configurations have one type of media, one extended drive containing all media, one
media folder, a single move group that fills media sequentially and a move rule that
moves all files a certain number of days after creation. Configurations that are more
complex can be defined (multiple extended drives, media types, move groups, move
and purge rules, etc.) depending on organizational and migration requirements.

FILE MIGRATION

All files that are migrated by DISKXTENDER are initially saved to the NTFS volume.
New/modified files are then moved to storage media and purged from the NTFS
volume as specified in the move and purge rules that apply to the files. Files are also
retrieved from media and stored on the NTFS volume automatically by
DISKXTENDER. This movement of files to and from media is referred to as file
migration.

One of DISKXTENDER’s main performance advantages lies in the ability of the
system to be configured so that frequently used files are maintained on the faster
access, fixed media (hard drive) whenever possible. You should carefully plan
extended drive size, and move and purge rules around application needs, anticipated
volume, and available time/hardware for migration processing.

Scheduled file moves and scheduled prefetches prevent system bottlenecks resulting
from read and write contention on the same DX computer. With a large enough
extended NTFS volume, the DX computer can process all client read requests at full
speed, processing moves for new/modified files and scheduled prefetches at a later,
less active time.

Different aspects of file migration are controlled in different ways in DISKXTENDER:

%  Fetch requests are automatically processed as quickly as possible (as long as the
Allow fetches from media schedule is active).

%  Prefetch requests are configured for each extended drive by selecting specific
files to be prefetched. Prefetch requests are then processed according to the
Prefetch schedule.
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% Deferred fetch requests are queued requests that are created during inactive fetch
schedule times. When the fetch schedule becomes active, the deferred fetch
requests are processed and retrieved at that time.

% Regular extended drive scans can be scheduled in order to write all appropriate
files to move and purge lists as they qualify against configured move and purge
rules. In addition, regular drive scans ensure complete file synchronization for
the move and purge lists, by capturing any files that may have had sharing
violations when DX originally tried to add those files to the list.

% Move rules control which files are moved to media, or more accurately, which
files are written to the move list for migration to media. The move list is
processed when a Move files to media activity schedule is active. Media
Activity schedules can be configured so that time and system resource
consuming activities take place during reduced traffic times.

Fetch Files from Media

DISKXTENDER provides virtually limitless background mass storage services by
creating the illusion that all files on an extended drive are actually on the NTFS
volume to which clients are connected. In reality, some files on the volume have
been moved to media and purged from the NTFS volume. When a file has been
moved to media and then purged, DX leaves behind a file “tag” which contains only
the file details (size, creation date, etc.) and the location of the file on DX media.
When viewed through the Windows Explorer, all proper file details (i.e., correct size,
date, etc.) appear.

When a read request is issued for a file, the file data may or may not be present on
the NTFS volume. If the file is present, DX allows Windows to handle the file
request. If only the file tag is present on the NTFS volume (i.e., file data has been
moved to storage media and purged from the volume), DX retrieves the file and
completes the request. When a file is retrieved, this process is referred to as a
“fetch.” Fetches are one of the media activities that can be controlled by the media
activity schedule. The Allow fetches from media activity is always active by default,
but can be set to be active for only specified blocks of time, if necessary. If a file is
requested when the fetch schedule is inactive, and the extended drive option to defer
fetch requests is enabled, those requests are queued and the files are retrieved when
the schedule becomes active.

Prefetch Files from Media

DISKXTENDER has a prefetch utility that allows you to schedule file retrieval. You
can designate which files should be fetched to the extended drive and schedule when
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the file retrieval will occur. Any files that you know will be needed can be marked
for prefetch so that they will already be present on the extended drive when they are
requested. You may select specific files to be prefetched, or you can assign a
prefetch task to a particular piece of media (which fetches all files from that media to
the extended drive).

You can schedule a prefetch request to occur once at a set time, to reoccur at set
times, or to be processed immediately. Prefetching files at low traffic times frees
system resources and speeds read request response during high traffic times. When a
file is retrieved in response to a configured, scheduled prefetch request, this process
is referred to as a “prefetch.”

The Prefetch Request Manager, in the Tools menu in the Administrator, can be used
to schedule, configure and manage prefetch requests.

Deferred Fetch Requests

If a client attempts to retrieve a file from media when the Allow fetches from media
schedule is inactive, DX cannot fetch the file at that time. DISKXTENDER contains an
extended drive option that allows you to queue file requests when the Allow fetches
from media schedule is inactive. This option, Defer fetch requests if fetch is
disabled, is available through the Options tab on the extended drive Properties dialog
box, and is disabled by default. If enabled, DX will queue all file requests made
during an inactive fetch schedule as deferred fetches. DX then processes all deferred
fetches when the Allow fetches from media schedule becomes active.

MEDIA FOLDER

The media folder is the folder on the extended drive where media is added and
grouped through DX. When files in a particular media folder are migrated by DX,
they are moved to a piece (or group) of media in the media folder where the file is
located.

Media is added to different media folders depending on desired data organization.
File name conflicts can be resolved using media folders. If two files on different
media have the same file name, it may not be desirable to add these media to the
same media folder. DX’s media folders allow you to plan exact organization of
directory trees and file locations on the extended drive, regardless of individual
media content.
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MoVvE GROUPS

In order to move files to media that have been added to an extended drive, you must
create move groups. Move groups allow you to separate media in a media folder into
groups. You can then choose a move group (i.e., a group of media) to designate
target media when creating a move rule.

Move groups can be used to group media within a folder for specific uses. If, for
example, you wanted to store .gif files and .bmp files to different media in a
particular folder, you could divide the media into a GIF move group and a BMP
move group. You could then designate the GIF move group as the target media for
the .gif files and the BMP move group as the target media for the .bmp files.
Division of the media into separate move groups helps you control data migration by
ensuring that only files of a particular type are written to a particular piece or type of
media.

A move group can only contain media from a single media folder, and is limited to a
single media type. If of one type, all of the media in a media folder can be grouped
as a single move group, or you can subdivide the media within a folder into multiple
groups.

Automated Move Groups

You can configure DX to automatically manage media for a move group based on
media usage. Two of the main administrative activities related to move group
maintenance could be set to automatically occur - automatic media labeling and
automatic media compaction.

The automatic label and automatic compaction features can be used together to
create intelligent move groups that allocate new media and perform compaction as
space is needed. This allows the system administrator to simply load and format
media, and then let other media maintenance activity be triggered by internal DX
events. Auto Label and Auto Compact eliminate a time consuming requirement of
system administration — the need to manage move groups and the available space
within them, by allocating/compacting media, where necessary.
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Automatic Media Labeling

The Auto Label option for move groups can be used to configure automatic addition
of available blank media to a move group. You can enable or disable the Auto Label
feature for each individual move group, either during move group creation or later
through the move group properties. When enabled, a media prefix and watermark
must be defined for use by automatic labeling. For example, the move group named
PAYROLL MEDIA might be configured with a media prefix of ‘PAYROLL’ and a
watermark of 200MB. This means that when the free space available in the move
group falls below 200MB, blank media will be automatically labeled with a
PAYROLL prefix and added to the move group.

DX also contains a batch formatting and labeling utility. This utility is called the
Media Prepare Manager and formats media, and prepares blank media for automatic
labeling. Only media in library devices can be used for automatic labeling.

Automatic Media Compaction

The Auto Compact option for move groups can be used to configure automatic
compaction of media. You can enable or disable the Auto Compact feature for each
individual move group. When enabled, you define a wasted space watermark for use
by automatic compaction that tells DX when to compact the media. Let’s say, for
example, that the PAYROLL move group has a wasted space watermark of 50%.
This means when the amount of wasted space on the move group media (due to
deleted files) exceeds 50%, the media is compacted.

MovVE FILES TO MEDIA

New or modified files remain on the extended drive until they have been moved to
storage media and purged. You control the timing of file moves through move rules
and schedules. When an extended drive scan is run, DX checks the files in each
media folder and attempts to qualify them against the move rules configured for that
folder. If a file is eligible, DX adds it to a move list. Whenever a Move Files to
Media schedule is active, DX processes the move list, writing each file on the list out
to media. When a file is written to media, this process is referred to as a “move.”
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Move Rules

Once you have set up a move group, you can create move rules to move files to the
media in the group. A move rule is a set of qualifications used by DISKXTENDER to
move files from a specified directory. The move rule indicates to DX which
new/modified files in a directory (and optionally, its subdirectories) should be moved
to storage media, to which media, and when.

At least one move rule must exist before any files can be written to storage media.
Your move rule strategy can be simple (one rule for all files in a media folder) or
complex (many move rules, each qualifying different types of files or files in
different sub-folders). The flexibility of move rules allows you to very specifically
control data migration, and to achieve any level of data segregation.

SPACE MANAGEMENT

Part of managing an extended drive involves managing space on the extended drive.
Ideally, files that will be retrieved frequently should remain on the extended drive,
whereas files that will not be retrieved often can be purged once they are moved to
media, leaving more space for frequently accessed files. In order to manage more
files than would actually be able to fit on the extended drive, you need to configure
space management rules.

Space management rules allow you to control what files are kept immediately
available on the extended drive and what files are purged. Using DISKXTENDER as
your data management system allows you to automate not only the movement of
files to storage media, but also the purging and deletion of migrated files from the
extended drive.

Purge Rules and Delete Rules enable automation of file data truncation and file data
deletion based on specific aspects of files, which you determine and configure.

%  Purge rules control when files are truncated on (or purged from) the extended
drive. Files are either purged when moved to media (as a setting of a move rule),
or whenever extended drive capacity is within the range set by the purge
watermarks.

%  Delete rules control when files are deleted from the extended drive and from any
storage media to which they have been moved.

PURGE FILES

The term ‘purge’ is used to describe the process of truncating file data on the
extended drive for files that have been moved to media. When a file is purged, it is
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replaced with a file tag that references the file’s location on media. Purging occurs
either as part of the processing of a move (if the purge after move setting is enabled),
or whenever the extended drive reaches a particular capacity, depending on how you
choose to configure your purge rules. In the properties for each extended drive, you
can set the watermarks that determine when purging based on drive capacity begins
and ends. Purge rules are configured to control which files are purged on drive scan
or moved to the purge list (during drive scans). The purge list is processed when the
purge start watermark is reached.

You can purge files based on file age. Purge rules can be used to dictate file purge
based on create time, last access time, or last modification time. This process is
performed automatically by DX in the background, transparent to client applications.

Purge Rules

Purge rules allow you to reclaim space on the extended drive by truncating files on
an extended drive once the files are moved to media. The parameters used to select
files for a purge rule are similar to those configured for a move rule. File age, file
size, file extension, and file attributes can be used to specify a set of files to be
purged. You can also configure the processing priority for a purge rule. Priorities can
be used to ensure that certain files, such as larger files, are purged first, optimizing
the purge process.

DISKXTENDER will only purge files that have been moved out to media, so non-DX
files are not affected by purge rules. It is recommended, however, that you create
corresponding purge rules when you create move rules, to insure that disk space is
reclaimed as needed. In addition, like with move rules, a regular drive scan is
required to write files that qualify against purge rules to the purge list.

DELETE FILES

Delete rules allow the system administrator to remove files from storage using
similar parameters as used in move rules and purge rules. However, delete rules
actually delete files from the extended drive and from media. When a file is deleted
on the extended drive, the file tag is deleted from the extended NTFS volume and the
file data on the media is marked for deletion. This means that the file data will either
be deleted immediately from media, or (for optical or tape media formatted with
OTG file system) will not be transferred to a new piece of media when the media is
compacted. (You can also configure secure file delete as an extended drive property
option, which will overwrite any deleted files on tape and optical media, making
them completely unrecoverable even before compaction.)
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These rules can be used, for example, to help manage archival of particular files kept
in order to comply with legal requirements. You could create a delete rule that
deletes all files in a particular directory that you are not legally required to keep. As
long as the files fit the legal criteria, they are backed up to media by DX and remain
in the directory. Once the files no longer meet the required criteria (e.g., the files
reach a certain age), however, DX can automatically delete them in accordance with
a delete rule.

Delete Rules

In certain situations, you may not want to keep files after a certain period of time,
even on storage media. You can use delete rules to automatically delete older files
from both the extended drive and from storage media. When a file becomes eligible
for deletion under a delete rule, it is deleted from the extended drive by DX. The file
may still exist on the storage media, but it becomes an “orphaned” file; DX marks
the file as deleted on the media and removes any references to the location of the file.
Removing the location reference makes it impossible for DX to find or retrieve that
file. When the storage media to which the file was moved is compacted, DX will not
copy deleted files to the extended drive (a part of the compaction process). When the
media is reformatted, the deleted files are permanently lost.

It is important to note that when a file is removed using a delete rule, it is removed
permanently. Once the file has been deleted on the extended drive, DX will no
longer keep a pointer to the file anywhere in the DX system. To simply clear space
on the extended drive, but retain file data on storage media, use purge rules rather
than delete rules. To actually remove files permanently, use delete rules.

MEDIA TASKS

A media task is defined as a media function that is assigned to a specific piece of
media. Available media tasks include compaction, file reporting, formatting,
labeling, labeling of copy media, check disk, add media to media folder, add media
to move group, remove media from media folder, remove media from move group,
prefetch, and file restore. Tasks can be managed through the Media Task Queue,
either at the DX computer level (includes all assigned tasks for media) or at the
media level (includes scheduled tasks for that media only.)

Media tasks can be processed immediately (at the time they are assigned) or when
the Process scheduled media tasks schedule is active. Be advised, however, that since
media tasks are assigned to specific media, a// tasks assigned to a piece of media
must be run together — either ASAP or during the media activity schedule.
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FORMAT

All media must be formatted for use with DISKXTENDER. Formatting verifies the
integrity of the media, and makes it available for use with system hardware. It
prepares the media for file writes by creating the specified file system on the media.
DISKXTENDER allows you to format media in a standalone drive, one piece of media
at a time, or in a library, on multiple drives at one time.

NOTE &

DISKXTENDER does not support formatting of CD-ROM, WORM or NAS media.

It is important to examine system needs before deciding upon a file system. OTG file
system media is easily recognized by DX, and provides faster performance.
However, if the media will need to be read by another file system or software
program, it may be necessary to use a Windows Native file system.

A format can be performed on unformatted media, or media that have previously
been formatted for the same or another file system. Both media that have never been
formatted and media formatted in a file system other than the one configured for the
drive will appear as either “unformatted” or “foreign” media to DISKXTENDER.
Media that has been formatted but not labeled will be listed as Blank media.

NOTE &

Formatting double-sided optical media in a standalone drive formats only one side of
the media. Always format both sides of double-sided media at one time, to avoid
confusion.

Force Low-level SCSI Format

By default, when NTFS media is formatted, a quick format is performed. Quick
format clears the file table of all pointers to files on the media, but not the actual
information on the media. A quick format is sufficient if the media is pre-formatted
or has been previously low-level formatted in the drive type being used.

A low-level format is necessary when media has been formatted in a different drive
type than the one being used, or if the media has repeatedly failed due to media
errors. Select this option to perform a low-level SCSI format and prepare the media
for the current drive type.
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NOTE &

If a format fails, it is usually an indication that a low-level SCSI format is necessary
to prepare the media for the current drive type.

Reformatting Media

If erasable optical or tape media has already been formatted, and is not currently
assigned to a media folder, it can be reformatted from the Available Media pool. To
reformat, assign the Format task for that piece of media. The formatting process
erases existing data and recreates the file system on the media.

LABEL

When media is inserted in a device, DX inventories the media to determine if it
recognizes the file system format, and reads the media label as well. If the media is
formatted but has not been labeled, DX will identify the media as blank media and
add it to the list under the Blank media node. Once media has been labeled from the
Blank media list, the media appears with the new label in the Original media node.
Media listed in the Original media node can be assigned to a media folder.

Labeling assigns a name and serial number to a piece of media, so that it can be
tracked by DISKXTENDER. No two pieces of original media should have the same
label, because the media label is what allows you to identify the media in the DX
administrator. For ease of use, then, the media label should uniquely identify the
media.

Automatic Media Labeling

Assigning a media task to a single piece of media is one way to cause a piece of
media to be labeled. You can also use the automatic labeling feature in your move
groups to label a blank piece of media and add it to the media folder and then to the
move group whenever new media is needed for the move group.

Media Naming Conventions

Media label names may be alphanumeric (a-z or 0-9) characters. Media names may
also include the following special characters: $ | - 2.

The recommended approach to naming media is to use a prefix and a sequence
number. The prefix should represent the extended drive name, application name, etc.
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that is writing to the media (i.e., CAD, IMAGES, DOCS). The sequence number
represents the order of the media in the group and optionally should reflect the side
of media (i.e., 1,2,3 or 1A, 1B, 2A, 2B, 3A, 3B). Combined, they give an orderly
system for naming media (i.e., CAD1A, CAD1B, CAD2A, CAD2B, etc.).

Depending upon data organization, all media could be given the same prefix, with
the only difference being the number following the prefix. Alternatively, different
prefixes could be given to media depending upon file type or location, for example.
When labeling media in a standalone drive, one side should be labeled LABELIA,
while the other side should be labeled LABEL1B, where LABEL is the media name.

LABEL CoPY

The Label Copy task allows you to label a piece of blank media to be used as a copy
of a piece of original media. Label Copy can only be performed on blank media.
Blank media available for use as copy media are all blank media of the same type,
format and size as the original media.

Copy media has the same label as the original it corresponds to, but has a unique
serial number. When assigning a Label Copy task, you must select the piece of
original media to be copied. DX assigns the same label to the copy and places the
copy in the Copy media node of the Available media tree. Copy media is updated
when the Update copy media activity schedule is active.

FILE RESTORE

File Restore makes files on media available for client access by placing file tags in
the media folder on the extended drive that point to the files on the media. Whenever
media is added to a media folder, the files on that media must be restored (so that the
media’s files are made available to clients), but file restore can be done at any time.

When assigning a File Restore task, you can enable or disable the Log Duplicates
option. This option allows you to keep a count of duplicate files when restoring. If
there are duplicate files, the newest file is restored and older versions are always
replaced. You can also set the direct read attribute for a piece of media when you
restore it. Setting direct read causes files to be fetched directly from media rather
than fetched to the extended drive.

NOTE &

File tags are information about the file including: name, location, attributes, size and
create time.
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COMPACT

Media compaction allows you to reclaim deleted file space on media by relocating
active (or non-deleted) files from one or more pieces of media to other storage
media. Compaction also allows you to migrate files from one type of media to
another (e.g., CD-ROM to optical or optical to tape).

Compaction takes place by copying (fetching) the files from the media back to the
media folder. Compaction also deletes the attribute identifying the file as a DX file
for each of the files from the media. The compacted files remain in the media folder
until transferred back to storage media based on the move rules established for that
folder. Once a piece of media has been compacted, it can be reformatted for reuse or
removed from the system (depending upon the type of media). Media selected for
compaction is automatically removed from its media folder.

NOTE =

For the best compaction results, you should have the equivalent of one side of the
media available as free space on the extended drive.

Automatic Media Compaction

Assigning a media task to a single piece of media is one way to cause a piece of
media to be compacted. You can also use the automatic compaction feature within
your move groups to compact media in the group whenever the amount of wasted
space on a piece of media exceeds a specified watermark.

PREFETCH

This task prefetches all files from the specified piece of media. If this task is
performed, clients can access any of that media’s files without the media being
mounted to a drive. You can coordinate prefetch with file migration and purge to
make sure that file data for necessary files is always present on the extended drive
when it is needed. This task is particularly useful if you know a specific piece or
pieces of media will mot be available for file retrieval for an extended period of time.
The prefetch task is also a valuable feature to have during disaster recovery.

NOTE &

The Prefetch media task prefetches all files on the specified piece of media. This
media task does not allow you to prefetch specific files. To prefetch specific files,
use the Prefetch Request Manager.
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FILE REPORT

The File Report task obtains file information from the specified piece of media so
that you can run a Media Files report using the Report Generator from the Tools
menu in the Administrator. You must run this task before running a Media Files
report to have current media information in the report. You can choose whether to
obtain a complete listing of files on the piece of media, or a summary of file totals on
the media.

CHECK DiIsK

The Check Disk task is used to run NT’s CHKDSK.EXE on DX media formatted
with the NTFS or FAT file system. For OTG rewriteable media, DX will perform a
scan of DX file tags.

ADD MEDIA TO MEDIA FOLDER

You can assign this task to automatically add a piece of media to a media folder.
This allows you to add media after other tasks are completed without any need for
manual intervention. This task can be scheduled for any piece of media located in the
Original node of the Available Media tree, or media that has the format and/or label
tasks assigned to it. The Add Media to Media Folder task can be used in conjunction
with the Add to Move Group task to automatically add media to a media folder, then
to a move group, all within a single process.

REMOVE MEDIA FROM MEDIA FOLDER

You can assign this task to automatically remove media from a media folder. Any
piece of media in a media folder can be scheduled for removal, but all other pending
tasks must have been carried out for the media before the media is removed.

When media is removed from a media folder, all files and file tags in the media
folder on the extended drive that correspond to files saved on the media, are also
removed. The files on the media will only exist on the media and no longer on the
extended drive. Removing media from a media folder requires an extended drive
scan to remove these files from the extended drive.

24 APPLICATION STORAGE MANAGER
Data Management Guide



Chapter One: Introduction

ADD MEDIA TO MOVE GROUP

This task adds a piece of media to an existing move group. Any piece of media
assigned to the media folder or for which an Add Media To Media Folder task is
pending can be assigned the Add Media To Move Group task.

You can also add one or more pieces of media to a move group when you create the
move group, or through the move group properties dialog box. In addition, you can
use the automatic labeling feature for your move groups to label a blank piece of
media, add it to the media folder and then to the move group whenever new media is
needed for the move group.

REMOVE MEDIA FROM MOVE GROUP

This task removes a piece of media from a move group. Unless specified by
scheduling a subsequent Remove from media folder task, the piece of media remains
in the media folder, though no longer part of the move group.

Media removed from a move group will no longer have files migrated to it.

MEDIA MANAGEMENT TOOLS

DISKXTENDER provides several tools that simplify the management of DX media.

CoprY MEDIA MANAGER

DISKXTENDER has a Copy Media Manager that allows you to view and manage copy
media tasks. You can assign the label copy task to blank media and view the status of
existing copies. You can also promote a piece of copy media to original status. You
can access the Copy Media Manager by selecting the Copy Media Manager option
from the Tools menu in the Administrator.

MEDIA PREPARE MANAGER

DISKXTENDER has a Media Prepare Manager that allows you to assign the format
and label media tasks to several pieces of media at once. You can select pieces of
media in the system and assign either or both of these tasks to them from one
centralized interface. You can access the Media Prepare Manager by selecting the
Media Prepare Manager option from the Tools menu in the Administrator.
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MEDIA TASK QUEUE MANAGER

DISKXTENDER has a Media Task Queue Manager that allows you to view and
manage pending and processing media tasks. Tasks can be removed, added,
promoted, or demoted using the Media Task Queue. All tasks assigned to media in
the DX system can be managed from the queue. You can access the Media Task
Queue Manager by selecting the Media Task Queue Manager option from the Tools
menu in the Administrator.

PREFETCH REQUEST MANAGER

DISKXTENDER has a Prefetch Request Manager that allows you to schedule prefetch
requests and to manage scheduled requests. Requests can be created, modified, or
deleted using the Prefetch Request Manager. All prefetch requests in the DX system
can be managed from the Request Manager. You can access the Prefetch Request
Manager by selecting the Prefetch Request Manager option from the Tools menu in
the Administrator.

EVENT SCHEDULING

DISKXTENDER provides scheduling for many system events, such as moving files to
media, media copy updates, scheduled media task processing, prefetching files, and
drive scans. This allows time-consuming processes to occur at convenient times such
as nights and weekends, thus providing more efficient use of system processing
during active times. Scheduling system events during inactive times ensures that the
events do not compete with network clients for system, drive or library resources.
Schedules can be defined, modified, and deleted through the Administrator.

MEDIA ACTIVITIES

A media activities schedule can be created for DX. Separate schedules can be set up
for each extended drive. Schedules are configured in the Schedule Properties dialog
box, which can be accessed from the Properties dialog box for the extended drive.

Move Files to Media

This schedule controls when the move list for an extended drive is processed, which
writes files from the list out to media.
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Process Media Task Queue

This schedule controls when media tasks that were given a “scheduled” value are
processed. All tasks for a piece of media are processed, and then tasks for the next
piece of media are processed. Media are processed in the order they are listed in the
Media Task Queue Manager.

Update Media Copies

When this schedule is active, copies of original media in the DX system are
automatically updated to match the original media. Copy media is created by
assigning a label copy task for a blank piece of media.

Allow Fetches From Media

When this schedule is active, user requests for files no longer resident on the
extended drive can be carried out. By default, this schedule is always active. Some
enterprises, however, require that fetch access to purged files be restricted at certain
times of the day. This media activity schedule option allows you to configure that
kind of time-based restriction, if necessary. In addition, if you have time-based
restrictions configured, you may want to enable the Defer fetch requests if schedule
is inactive option for your extended drive. If the extended drive option to defer fetch
requests is enabled, those requests are queued and the files are retrieved when the
schedule becomes active.

Prefetch Requests

Prefetch requests are scheduled separately from other media activities, during
prefetch request configuration. Flexible scheduling options are available for
scheduling prefetch requests. Prefetch requests are scheduled in the Prefetch Request
Manager.

Any files that you know will be needed can be marked for prefetch so that they will
already be present on the extended drive when they are requested. You can schedule
a prefetch request to occur once at a set time or to reoccur at set times or you can
configure the request to be processed immediately. Prefetching files at low traffic
times frees system resources and speeds read request response during high traffic
times. When a file is retrieved in response to a configured, scheduled prefetch
request, this process is referred to as a “prefetch.”
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NOTE &

Prefetches will fetch all requested files to the extended drive, to include files marked
for direct read.

EXTENDED DRIVE SCAN

Extended drive scans inventory the contents of the extended drive and determine
what files are to be written to the move and purge lists. Files will not be moved or
purged, even if the extended drive reaches capacity or the Move files to media
activity reaches a scheduled time, unless they are listed on the move list or purge list.
The primary purpose of drive scans is to write files that qualify for move rules with
an age delay to the move list. Files that qualify against move rules with no age delay
are typically written to the move list as soon as they are saved to the extended drive.

If you configure any move rules or purge rules to have age-delays, you must perform
regular extended drive scans to update the move and purge lists. If any of your move
and purge rules use a file age exception to delay move and/or purge of files, you
should set a regular drive scan schedule to make sure that all appropriate files are
written to the move and purge lists.

WARNING é*

While files qualifying for a move rule with no time delay are automatically added to
the move list, file-sharing issues or sharing violations can prevent files from being
added to the move list when appropriate. DX must have full access to a file in order
to obtain information required for the move list. If the file is open or is otherwise
being accessed by a program or user, DX cannot add it to the move list.

Because files may not be added to the move list due to file-sharing issues, regular
drive scans are required to be sure that all appropriate files are written to the move
list when they qualify, and as such, are being written out to storage media (in
coordination with your Move files to media schedule). DX allows you to force drive
scans at any time, and to set a regular schedule for drive scans. Because drive scans
for very large extended drives can be time consuming, and to make sure files due to
be added to the move list are not currently being accessed, you may want to schedule
your drive scans to occur during times of low extended drive and system traffic.

In addition, when you remove a piece of media from the extended drive, you must
run a drive scan to complete removal of the media and remove the files on the media
from the drive.
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Forced Drive Scans

An option is available on the extended drive shortcut menu that allows you to force
an immediate drive scan of the extended drive. A drive scan started using the Force
Drive Scan command is started immediately, independently of any drive scan
schedule you may have in place. You can use this command to run a drive scan if
you remove a piece of media and would like to refresh the extended drive contents
immediately.

Scheduled Drive Scans

You can also schedule drive scans to occur automatically. Drive scans are scheduled
separately from other events (in each extended drive’s Properties dialog box in the
Administrator). Because drive scans for very large extended drives can be time
consuming, and to make sure files due to be added to the move list are not currently
being accessed, you may want to schedule your drive scans to occur during times of
low extended drive and system traffic.

CLIENT CONNECTIVITY

The extended drive is a partitioned volume, which resides on a computer using
Windows NT or Windows 2000 as the operating system. The volume is shared
through a network, so that it is visible and accessible to other users. The client
computers that save and retrieve files to and from the shared drive can use virtually
any operating system to read and write the extended drive files.

FILE STREAM SUPPORT

Because NTFS supports file streams, many applications now take advantage of file
streams to store their data. In addition, MAC and NFS file systems use file streams to
store private data.

Support for file streams ensures that DISKXTENDER can protect all application data in
files (not just the primary data). File streams are moved and fetched along with the
primary file data. In addition, file streams can be restored from storage media (along
with primary file data) for disaster recovery purposes.

File stream properties can be viewed through the Explorer Add-ons, if the file
selected contains file streams.
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CLIENT FILE SYSTEM SUPPORT

Because DX uses the extended NTFS volume to store files before migration, and is
capable of migrating file streams, all clients that can connect to an NTFS drive can
store and access DX files on an extended drive.

FAT (File Allocation Table)

DX2000 supports FAT as a read-only file system. Operating systems that use FAT as
a file system include Windows 3.x, Windows 95, and Windows 98, Windows NT
and Windows 2000. DX cannot format media with the FAT file system and since
FAT is supported as read-only, FAT media cannot be added to move groups.

NTFS (Native Transport File System)

Clients using Windows NTFS can read and write files on DX extended drives.
Windows NT/2000 uses NTFS or FAT as file systems.

MAC (Macintosh)

Maclntosh and Apple computers use the MAC file system. Because DISKXTENDER
protects file stream data, client connectivity drivers for MAC can be used to connect
to DX extended drives.

NFS (New File System)

UNIX and LINUX applications have NFS as a file system. Because DISKXTENDER
protects file stream data, client connectivity drivers for NFS can be used to connect
to DX extended drives.
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SETTING UP FILE MIGRATION

The DISKXTENDER program uses a file migration system to allow you to manage
large stores of data and files. The term ‘file migration’ refers to the function of
moving files from a local hard drive to one or more pieces of storage media, and
retrieving those files for use when requested. In essence, you move files from an
extended drive with limited storage space to media pools with more extended storage
space.

DISKXTENDER automates the migration of files to media using a rule-based system.
Rather than just migrating all files to media without distinction between files, you
can select which files should be moved to what types and pieces of media. DX tracks
each file and each piece of media so that when a client requests file data that has
been moved to media, DX can find the file and retrieve it for the client.

Besides determining what types of files are moved to what media, you can also
configure a time delay for files that will delay movement of the files until some
number of days after creation or last access or last edit. In addition, DX provides a
prefetch function, which allows you to retrieve the most commonly used files during
times of reduced system traffic.

One of the main reasons to use a file migration system to manage your data and files
is to manage data storage space. After file data is moved to storage media, that data
can be removed from the local storage space, freeing up that space for additional
files. The key is to maintain as much local storage space as possible while still
making files easily available. Ultimately, your data management system is also a
Space management system.
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Besides the storage media being written to, DISKXTENDER uses six key components
to automate file and space management. Those components are:

% Extended Drive — an NTFS volume (hard drive) on the computer where DX is
installed

% Media Folder — folder created on the extended drive, through DISKXTENDER,
where clients store (and access) files

% Move Group — group of storage media to which files, stored in a particular
media folder, will be migrated

% Move Rule — rule outlining the attributes of files that determines which files
stored in a particular media folder, will be moved

% Purge Rule - rule outlining the attributes of files that determines which files
stored in a particular media folder, once moved to media, will have their file
data removed from the extended drive (a file tag will remain, identifying the file
for later retrieval)

% Delete Rule — rule outlining the attributes of files that determines which files
stored in a particular media folder, will be deleted entirely from the DX system
(permanently deleted from the extended drive and the storage media)

The extended drive, media folders, move groups and move rules, their creation, and
their management are what enable and automate your file migration and data
management system. The purge rules and delete rules are what enable and automate
space management within your data management system.

In order to set up DISKXTENDER to start migrating files from the extended drive to
media, you need to create and configure several of the file management components.
Executing the following steps, in order, is the quickest way to begin:

To configure DX for the migration of files to media:

1 Configure one or more media services. Information and procedures related to
media services can be found in the DISKXTENDER Getting Started Guide.

2 Create and configure an extended drive. For instructions, see Extended Drives
on page 34.

3 Create a media folder. For instructions, see Media Folders on page 46.

4 Configure/Add media to the Available Media Pool for the extended drive. For
instructions, see Assigning Media to Extended Drives on page 44.

5 Add media to the media folder. For instructions, see Adding Media to a Media
Folder on page 54.
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Create a move group. For instructions, see Move Groups on page 60.
Add media to the move group. For instructions, see Move Groups on page 60.

Create one or more move rules. For instructions, see Move Rules on page 68.

e 0 9 &

Set up a regular Drive Scan schedule. For instructions, see the Extended Drive
Administration chapter in the DX System Guide.

10 Set up the Move files to media activity schedule. For instructions, see
Scheduling Movement of Files on page 80.

Completing the above steps tells DX what files it is supposed to move, when it is
supposed to move them, and to what media. In addition, scheduling regular drive
scans ensures that all files that are supposed to be moved are written to the move list
when they qualify, and that complete file synchronization for the move list is
maintained by regularly checking the extended drive for files that should be moved
to media.

The sections that follow in this chapter provide instructions to setting up all of the
necessary components for migrating files to media. In addition, at the end of this
chapter you will find instructions on how to configure DX to move files to media at
times you specify using the extended drive scheduler.

Because many users prefer to stay with the default settings through the setup process,
the instructions included in this chapter for creating your extended drives, media
folders, move groups, and move rules do not cover configuration options in detail.
This chapter provides enough information to enable you to get your DX system up
and running, and start moving files to media. In addition, this chapter lists
descriptions of the default settings for each of the DX file migration components.

However, if you would like to change default settings to customize your system
during the setup process, you can do so. For information on configuring and
changing the default properties and options for your move groups and your move
rules, see Chapter Three: Managing File Migration on page 83. Because of the
extensive nature and importance of properly configured extended drive settings,
information on changing and managing extended drive properties occupies its own
chapter. Please refer to the Extended Drive Administration chapter of your DX2000
System guide for detailed information and procedures.

For detailed discussion of purge rules and delete rules see Chapter Four: Space
Management on page 137.
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An extended drive is an NTFS volume whose storage capacity is “extended” by
DISKXTENDER’s file migration services. DISKXTENDER allows you to “extend” an
NTFS-formatted hard drive on a DX computer by moving files to other storage
media while making the files appear to remain on the hard drive.

The first step in enabling file migration to media by DX is creating an extended
drive. Once DX software is installed on a computer, any NTFS-formatted hard drives
on that computer can be extended by DISKXTENDER. The extended drive must reside
on the same computer where DX is installed.

NOTE =

If your DX system is installed on a SAN and you are using SANXTENDER, your
extended drive must be a shared fibre RAID drive mapped to the DX computer. For
more information about how SANXTENDER works with DX, see the SANXTENDER
System Guide.

DX and the media services it uses can be located on the same computer or on
separate computers, as long as the computer’s specifications are acceptable for use
with DX. For space requirements, minimum computer configurations, and system
recommendations for the DX computer and the extended drive, please refer to the
Planning Your DX System chapter of the DISKXTENDER Getting Started Guide.

To use DISKXTENDER to the greatest advantage for your organization, you should
plan the organization of data in your DX system prior to creating your extended
drives. For example, you should determine if all files will be saved in a single folder
on one extended drive, or if you want to save different types of files to different
folders, or even to different drives.

You can create multiple extended drives to make your file hierarchy more specific
and detailed, or choose a more simple structure. Basic configurations have one type
of media, one extended drive with a single media folder, one move group, containing
all available media, move rules to fill media sequentially, and a purge rule for all
files moved to media. More complex configurations can be defined using multiple
extended drives, multiple media folders, move groups, move rules, purge rules etc.,
depending on organizational and migration requirements.

To store files, media is assigned to a media folder and then to a move group. To
configure migration of files from the extended drive to the media, you must create a
move rule that selects the files to be migrated and targets the media in the move

group.
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CREATING AN EXTENDED DRIVE

Since each component necessary for file migration is associated with an extended
drive, you have to create an extended drive before you can create any of the other
components. Before an extended drive is created, the DX Administrator is empty
because there is not much to administer. Even if you have already added your media
services, that media is not available for file migration until it is assigned to an
extended drive through the media service.

As with most components in DISKXTENDER, there is a wizard function to help you
create your extended drive. The Extended Drive wizard takes you step-by-step
through all the necessary steps to create a new extended drive.

Within any DX wizard, the Next button continues to the following step; the Back
button (when active) returns to the preceding step. The Cancel button exits Setup,
canceling the process.

When the extended drive is created, DX creates a new tree in the Administrator with
the name of that drive. If you expand the extended drive tree, you will see nodes
representing the other data management components.
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Unless you make changes to the options when creating your extended drive, the
defaults for each extended drive configuration are as follows:

Table 4: Extended Drive Settings Page Defaults

OPTION: DEFAULT SETTING:

Schedule Contains four Media Activities for scheduling: Move files to
media, Process scheduled media tasks, Update copy media
and Allow fetches from media. Default schedules for the first
three run every day from 8 p.m. to 9 a.m. The Allow fetches
from media schedule is active 24/7 by default.

Drive Scan Sets extended drive scan schedule. Drive scans are disabled
by default. Regular Drive Scans are required to write files to
the move list for migration and to ensure complete
synchronization of all files due to be moved to media.
Scheduling drive scans for “off-hours” times makes running
them regularly more convenient, and decreases the likelihood
of a file not being written to the move list due to a file-sharing
violation because a user or other program has the file open.

Backup Sets specifications and scheduling for incremental and full
extended drive backups. Backup schedule is disabled by
default. We strongly recommend setting a regular Backup
schedule in order to ensure that your DX files are saved
regularly to backup.

Table 5: Extended Drive Options Page Defaults

OPTION: DEFAULT SETTING:

Backup mode Sets whether to backup only DX file tags or all file data for

for managed DX managed files when running a system backup. (This

files setting is not related to the DX Extended Drive Backup
function.)

Direct read Sets amount of extended drive memory to be used for direct

memory cache read of files. Default is 1 MB.

Disable file size  Selects the way purged DX files appear in Explorer (0 bytes
fixup or actual size). Shows actual file size by default.
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OPTION:

DEFAULT SETTING:

Disable folder
rename check

Fetch request
timeout minutes

Force direct
read for all files

Force moves
when nothing to

purge

Prevent file
delete

Prevent file
modification

Purge start
watermark
(drive percent
full)

Purge stop
watermark
(drive percent
full)

Warn when free
space is getting
low (MB)

Defer fetch
requests if fetch
is disabled

Manages whether or not users can rename media folders on
the extended drive if not supported by the associated storage
media. Renaming prevented (for applicable media) by default.

Configures the number of minutes DX will wait after a fetch
request has been made before canceling the request.

Allows setting direct read for a// files moved to media. Direct
read for only files marked is default.

Activates processing of move list when used space on
extended drive exceeds purge start watermark and no files are
written to purge list. Forced moves are disabled by default.

Prevents deletion of files when files cannot be deleted from
associated storage media (write-once media). File deletion not
prevented by default.

Prevents modification of files when files cannot be modified
on associated storage media (write-once media). File
modification not prevented by default.

Sets the percentage of space on the extended drive that must
be filled (used) before processing the purge list. Default is 95
percent full.

Sets the percentage of space on the extended drive that must
be filled (used) before purge list processing stops. Default is
90 percent full.

Allows DX to warn you when extended drive free space is
getting low. Warning is disabled by default.

Allows DX to defer rather than reject requests for files made
when the Allow fetches from media schedule is inactive.
Fetch requests are rejected by default.

Because management of the extended drive is critical to optimal performance of your
DX system, we have devoted an entire chapter exclusively to configuration of the
options available and other administrative tasks for the extended drive. For detailed
information and procedures, see the Extended Drive Administration chapter of the
DX2000 System Guide.
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After the extended drive is created you can assign specific media to the extended
drive through the media service(s). Adding media to the Available Media Pool for an
extended drive is discussed in this section.

Starting the Extended Drive Wizard

To create a new extended drive:
1  You have two options:
%  From the DX Administrator's Service menu, select New Extended Drive.

%  Click the New Extended Drive button on the toolbar.

Figure 2: New Extended Drive Toolbar Button
=]

The Extended Drive wizard appears starting with the New Extended Drive page.

Figure 3: New Extended Drive Page

Mew Extended Drive [ %]

Thiz wizard will extend an MTFS volume on any Windows MT or
Windows 2000 computer.

After adding an extended drive, the following configuration steps
must be performed before file migration will begin:

1] Configure one or more media services
2] Create media folders
3) Add media to media folders

4] Define migration rules and schedules

Select Mext to continue creating a new extended drive.

< Back Cancel | Help |

The New Extended Drive page lists the steps that must be performed after an
extended drive has been created in order to begin file migration

2 Click Next. The Select Drive page appears.

38 APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Two: Setting Up File Migration

Figure 4: Select Drive Page

Select Drive [ %]

Fixed dizk drives on thiz computer:

Drive | Wolume Label | File Spstem | Status
=T SYSTEM FAT Mot MTFS file spstem
=D APPS MTFS ar

= F. RESTORE FaT Mot NTFS file system

< Back I Mest > I Cancel | Help |

The Select Drive page lists all partitioned drives on the DX computer, along
with the File System and Status of each drive. Only drives listed with a status of
OK can be extended.

3 From the Select Drive page, select the NTFS volume you want to extend and
click Next.

4 If you have assigned media to a storage hardware management system, the
Assign Media To Extended Drive page appears.
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Figure 5: Assign Media To Extended Drive Page

Assign Media To Extended Drive X

The follawing media are currently unused, and may be assigned to
the new extended drive. This will cauze the media to appear in the
Aailable Media list for the extended drive.

Semvice Mame | hMedia Mame ‘ edia Type | Physical
ZE0TGMS BRONWYN_ CO-ROM

fal | 0|

Select one or more media and press Next to continue.

< Back I MNext > I Cancel | Help |

The Assign Media To Extended Drive page lists all available media and allows
you to assign that media to the extended drive being created. It includes the
following information for each piece of available media:

% The type of media service controlling the media (OTGMS, NAS, TSM)
% The name of the media

%  The type of media (optical, CD-ROM)

% The location of the media

5 Select the media you want to assign to the extended drive. If you do not want to
assign media at this time, do not highlight any media.

6  Click Next. The Settings page appears.

The Settings page contains three buttons: Schedule, Drive Scan and Backup.

%  Clicking Schedule takes you to the media activity scheduler, which allows
you to configure a schedule for four media activities: Move files to media,
Update copy media, Process scheduled media tasks, and Allow fetches from
media.

%  Clicking Drive Scan takes you to the drive scan scheduler, which allows
you to configure regular drive scans for your extended drive. Regular Drive
scans are required to migrate files with time delay attributes to move lists,
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to remove files from media folders when media is removed from the media
folders, and to ensure complete synchronization of the move list for all files

due to be moved to media.

% Clicking Backup takes you to the extended drive backup scheduler, which
allows you to set the location, frequency and timing for full and incremental
backups of all data located on the extended drive. These backups can be
used to restore extended drive data in the event of a system failure.

Figure 6: Extended Drive Settings Page

— Extended Drive Setting:
Specify active times for moving files, media

task processing, and media copy updates. Schedule... |
S pecify the time and frequency of drive 8

scans on the extended drive. Drive Scan... |
Specify the location, time and frequency of

backupsz on the extended drive. Backup... |

Cancel | Help |

< Back

You may configure these schedules now or configure them later using the
Properties option for the extended drive. For more detail on configuring
extended drive settings, see the Extended Drive Administration chapter of the
DX2000 System Guide.

7  Click Next. The extended drive Options page appears.
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Figure 7: Extended Drive Options Page

options x|
Option Mame | Walug |+ |
dackup mode for managed files
[ Direct read memary cache (MB) 1
[H Disable file size fisup Ma
[H Disable folder rename check. Mo
[H Feteh request imeaut minutes 10
[H Force direct read for all files Mo
[H Force moves when nathing to purge Mo
[H Prevert file delete Mo
[H Prevent file modification Mo
[H Purge start watermark [drive percent full 95
[ Purge stop watermark [dive percent full a0 —
[H ‘wam when free space iz getting low [MB) Ma
[T Pynfr Fobede rmonimaba i Fobals i Aisoblad ki~ j
— Option
% Fast backup - read only Diskxtender tracking data
™ Full backup - read all file data, including tracking data

< Back I Mext » I Cancel | Help |

The extended drive Options page allows you to configure various file migration
options for the files on your extended drive. The defaults for these options are
listed in Table 4 on page 36. You may configure these options now or configure
them later using the Properties option for the extended drive.

Proper configuration of these options is critical for optimal performance of your
DX system. For a detailed discussion of each of these options, see the Extended
Drive Administration chapter of the DX2000 System Guide.

8 Click Next. The Summary page appears.
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Figure 8: Extended Drive Summary Page

summary x|
=

Action lisk:
1] Add new extended drive to configuration
2] Start monitoring drive activity

Selected drive:

< Back Cancel | Help |

The Summary page lists the settings you provided through the wizard.

9 Review the information in the Summary page. If you need to make changes,
click Back. If the information is correct, click Finish.

After you have created your extended drive, DX displays a message prompting you
to create a media folder for the extended drive.

Figure 9: Create Media Folder Message

DizkXtender Adminigtrator

‘wiould wou like to add a media Folder
to the new extended drive?

o |

You may create the media folder at this time or create the media folder later. Click
Yes to start the create media folder wizard. For instructions, see Creating Media
Folders on page 49.
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ASSIGNING MEDIA TO EXTENDED DRIVES

If you configured your media services after creating your extended drive, or if you
did not assign media through the Extended Drive wizard, you must now assign the
media in the media service to the Available Media pool for the extended drive to
make it available for use.

To allocate media from the extended drive tree:
1  You have the following choices:

%  From the tree of the extended drive to which you want to allocate media,
select the Available Media node. From the Edit menu, select Allocate
media.

% In the tree of the extended drive to which you want to allocate media, right-
click the Available Media node. From the shortcut menu, select Allocate
media.

The media allocation wizard appears, starting with the Allocate Media to
Extended Drive page.

Figure 10: Allocate Media to Extended Drive Page

Allocate Media to Extended Drive E
Location | Type |
=) Network MNAS

< Bach

Cancel Help

2 From the list of media services, select the media service containing the media

that you want to allocate. Click Next. The Media List page appears.
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Figure 11: Media List Page

Media List E
Media Hame | Media Type | Physical Location |
D atal a5 Whrtender-server\ado...
D ata2 a5 Whrtender-server\ado...
< Back Cancel Help

3 From the list of media, select the media that you want to allocate to the extended

drive. (You can use a standard Windows <Shift> or <Ctrl> technique to select
more than one piece of media.) Click Next. The Summary page appears.

Figure 12: Summary Page

Summary [ x|

Action List: ;I
1. Allocate selected media to extended drive.

Options:
Media Service: NAS
edia Count: 2

< Back Cancel | Help |

4 Review the information that you have provided to the wizard. If the information
is correct, click Finish. A progress message appears.

The selected media appears in the appropriate node of the Available Media tree for

the selected extended drive. Media appearing in the Original node of the extended
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drive tree can be assigned to media folders. For information, see the Media Folders
section below.

MEDIA FOLDERS

After an extended drive has been created and media has been added to the extended
drive, you can create media folders to organize files on the drive. On the computer
on which DX is installed, the DX extended drive is an actual physical volume on the
computer. Media folders created in DX are actual physical folders on that drive.
Through Windows Explorer, each media folder created through DX looks like a
normal folder you might create through Explorer. The media folder appears as part
of the drive’s directory structure.

Media folders are called such because within DISKXTENDER you assign media to a
folder so that files saved in the folder on the extended drive can be moved to that
media. What you are doing when you create a media folder is creating an association
between the real folder on the hard drive volume and the pieces of storage media you
add to the folder in DX.

You can create a media folder in DX using a folder that already exists on the
extended drive, or create a new folder on the extended drive. You can also assign
media to the media folders when you create them or create media folders and add
media to the folders later.

Once a media folder has been created, it appears in both DISKXTENDER and in
Windows Explorer. In Explorer, it appears as a folder on the drive. In DX, the media
folder appears as a node under the extended drive. Under the media folder in DX you
will see additional nodes representing the DX components that can be created for
each media folder to enable file migration and space management.

Media must be added to the media folder in DX before files in that folder can be
written to media. Once added to a media folder, a piece of media is reserved for that
media folder’s files. No two media folders can share the same piece of media.
Original media, which appears in the Available Media list, can be added to any
folder in an extended drive.
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MEDIA FOLDER CREATION CONCEPTS

Before creating your media folders you may want to decide how you want your
extended drive directories structured, particularly if you plan to have multiple media
folders on your extended drive, and especially if you plan to have multiple levels of
media folders (directories with one or more sub-directories).

If you plan to use multi-level directory structures for your DX files, you will also
have to determine if you want to migrate the files for each folder and subfolder
separately to different pieces and/or types of media, or if you will move all of a given
directory’s files and subfolders using the same criteria.

Establishing how you will want directories, files and subfolders migrated to media
will tell you how many media folders you will need to create, and how you will
ultimately set up your media, move groups, and move rules for those media folders.

Planning Extended Drive Directory Structure for File
Migration

If you want to create rules that only apply to media in folders farther down the
directory tree than the root, you will need to create additional media folders. This
allows you to create move, purge, and delete rules separately for those specific
folders.

Any rules created for the root media folder can apply either to only the files within
that directory or to the files within that directory and all subfolders of that directory.
For example, viewing your extended drive through Windows Explorer, you have a
/REPORTS/ folder that is a DX media folder and within that folder you have
subfolders for each month (/JAN/, /FEB/, etc). You could set up DISKXTENDER to
migrate only files saved in the /REPORTS/ root to storage media or you could set up
DISKXTENDER to migrate all files and all subdirectories in the /REPORTS/ folder to
storage media.

You could not, however, create a move rule in the /REPORTS/ folder that would
move files saved in the /REPORTS/ root and files only in the /MAR/ folder. You
would need to create a media folder in DX using the existing /MAR/ folder and then
create a separate move rule in that folder. To keep non-DX files separate from DX
files, you may wish to create separate folders on the extended drive to hold files you
do not want managed by DISKXTENDER.

Files can all be stored in one media folder, or they can be divided into multiple
media folders if segregation of data is necessary. The number of files or directories
that can be placed in an extended drive depends on the size of the NTFS volume.
Although it is possible, it is not recommended to exceed 16,000 files per directory.
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As with any file system, doing so will impede system performance, placing greater
demands on memory and processors, and yielding a slower response time to the
client. As the number of files increases in a single directory, the potential for a
workstation error when connecting or browsing directories on the extended drive
increases.

Planning Media Directory Structure for File Migration

When creating the directory structure on the extended drive, it is important to
consider both the file structure being created on the extended drive, and the directory
structure that will be created on the piece of media.

The directory structure that will appear on the media when files are migrated is
identical to the structure that appears on the extended drive except that the root
media folder will not appear on the media.

For example, you create a media folder /REPORTS/ on the extended drive. Within
that media folder, there are subfolders (that are not specifically configured as DX
media folders) for each month (/JAN/, /FEB/, /MAR/, etc.). The move rule you have
established for the /REPORTS/ media folder migrates all files and subfolders to
media. On the extended drive, your directory structure and files would look like this:

% E:\REPORTS\YEAREND.DOC

% E:\REPORTSJAN\ACCOUNTS.DOC

% E:\REPORTS\FEB\ACCOUNTS.DOC

%  E:\REPORTS\MAR\ACCOUNTS.DOC

However, on the media, the directory structure and files would look like this:
% YEAREND.DOC

%  JAN\ACCOUNTS.DOC

% \FEB\ACCOUNTS.DOC

% \MAR\ACCOUNTS.DOC

Notice that the root media folder name is not migrated with the media. It is for this
reason that a given piece of media can only be assigned to one instead of multiple
media folders. It is also for this reason that we recommend you label your media in
such a way that corresponds with the media folder to which it is or will be assigned.
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Keeping track of what folder’s files have been migrated to what media is particularly
important if media is removed then re-added to media folders. When media is added
to a media folder, any existing files on that media are restored to the media folder on
the extended drive (making those files available if necessary). If the media contains
files with names that duplicate the names of files already resident in the media
folder, the resident files are overwritten if the duplicate files on the media are newer.
This is why organizing the directory structure for both your extended drive and your
media is important to consider before creating the media folders and adding media to
them.

CREATING MEDIA FOLDERS

Creating a media folder in DISKXTENDER creates an association between a physical
directory on the extended drive, and the media to which the files saved in that
directory should be moved. In addition, in the DISKXTENDER interface, creating a
media folder activates the options for creating the media folder components (move
groups, move rules) that will ultimately allow migration of files from the folder to
storage media.

You have the option of creating media folders and adding media to them separately,
or you may create media folders while adding media to the media folder. To choose
the second option, you must have at least one piece of media in the Original node of
the extended drive.

To create a media folder without media:

1  You have the following options:

% In the tree view, select an extended drive. From the Edit menu, select Create
Media Folder.

% Right-click an extended drive. A shortcut menu appears. From the shortcut
menu, select Create Media folder.

The Create Media Folder dialog box appears.
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Figure 13: Create Media Folder Dialog Box

Create Media Folder E
Mew Media Faolder

Enter Folder Mame:

Browsze... |

Cancel | Help |

2 You have the following choices:

%  To create a new folder on the extended drive, type the media folder name in
the Enter Folder Name text box.

%  To use a folder that already exists on the extended drive as a media folder,
click Browse. The Select Folder page appears. Select the folder and click
OK. The folder name appears in the Enter Folder Name text box.

3 Click OK. The media folder is added to the Extended Drive tree under the
extended drive.

To create a media folder with media:
1  You have the following choices:

% In the tree view, select an extended drive and select Add Media to Media
Folders from the Edit menu.

% Right-click an extended drive and select Add Media to Media Folders from
the shortcut menu.

The Select Media To Add page appears.
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Figure 14: Select Media To Add Page

Select Media To Add E

The list below contains unallocated original media on this extended drive.
Media may be added ta any folder on an extended diive.

HMedia:
Media Mame | Media Folder |

Add Hemaye

Media Folder:

< Back I Mext > I Cancel | Help |

The Select Media To Add page lists all Original media available for assignment
to media folders. This box also allows you to select multiple pieces of media,
which creates multiple media folders (each named after the piece of media used
to create them).

2 You have three choices:

%  To create a media folder (or folders) with the same name as the media,
select the media and click Add. The media folder name appears to the right
of the media.

%  To create a media folder with a different name than the media, type the
name of the folder in the Media Folder text box, select the media you want
added to that folder and click Add. The media folder name appears to the
right of the media.

%  To add the media to an existing folder, type the name of the folder in the
Media Folder text box, select the media you want added to that folder and
click Add. The media folder name appears to the right of the media.
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NOTE =

Figure 15: Select Media to Add Page

Select Media To Add E

The list below contains unallocated original media on this extended drive.
Media may be added ta any folder on an extended diive.

HMedia:

Media Mame | Media Folder |
|I DOCS_1

Add Bemave

Media Folder:

< Back I Mext > I Cancel Help

If you select two pieces of media that have the same name (regardless of
capitalization), only one media folder, with that name, will be created and both
pieces of media will be assigned to that folder.

3 Click Next to continue. The Media Restore page appears.
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Figure 16: Media Restore Page

Wizard - Media Restore E

The following media contain existing files and must be restored before
these files can be accessed. Select media and restore options below:

HMedia:
Media | Log | Direct| ASAP [
D

— Option:

¥ Log duplicates [list duplicate file names in media log)

[~ Direct read [retrieve file data directly from media)

¥ Process as soon as possible [do not wait for active schedule]

< Back I Mext > I Cancel | Help |

The Media Restore page options are only active if the media you are adding to
media folders contain files that must be restored to the extended drive. Those
options are as follows:

Table 6: Wizard - Media Restore Page Options

OPTION: DESCRIPTION:

Log Enable this option to keep a count of files on the media that
Duplicates duplicate files already on the extended drive when restoring.

Direct Read Enable this option to apply the direct read attribute to all
restored files. Direct read means that when accessed by a
client, the file will be read directly from media rather than
fetched to the extended drive and read from there.

Process Enable this option to restore the media immediately, rather
ASAP than as a scheduled Media Restore task (according to the
Process scheduled media tasks media activity schedule).

4 Ifavailable, configure the restore options for restoring files to the media folder
on the extended drive and click Next. The Summary page appears.
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Figure 17: Summary Page

Action list:

1) Add media to specified path
2] Schedule media with existing files for restore

Selected media:
Docs 1 [restore, log dups, process now]
Docs 2 [restore, log dups, process now]

< Back

5 Review the information in the Summary page and click Finish.

When new folders are created, these folders appear in the extended drive tree in the
Administrator and through Explorer on the extended drive. In DX, the media
selected in the wizard appears in the Media node underneath the media folder in the
Administrator.

ADDING MEDIA TO A MEDIA FOLDER

Adding media to a media folder makes that media available for addition to move
groups in that folder and ultimately for storage of files saved to that folder on the
extended drive. You can add both previously unused media and media with existing
files to a media folder. When media with existing files is added to a media folder
those files must be restored in order to make them accessible to clients. For more
information, see File Restore below.
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File Restore

When media is added to a media folder in DX, file tags for any files already existing
on the media are copied to that folder on the extended drive. This is called File
Restore.

File restore makes files on media available for access through DISKXTENDER by
placing tags on the extended drive that point to the files on the media. File tags
contain information about the file including name, file size, age and other attributes
that define the file. The file tag allows the file to appear as if the file is resident on
the extended drive, but the file data remains on the media.

When files and directories are restored to the extended drive, file tags and directory
structures are created in the media folder on the extended drive. File data is moved to
the hard drive when a client requests the file, unless the Direct Read option is
selected. If the restored files are marked for Direct Read, upon request from a client,
the file data is read directly from the media rather than fetched to the extended drive.

Adding Media to Existing Media Folders

Adding media to media folders is done through a wizard. The Add Media wizard
allows you to add media to an existing media folder or create a media folder and add
the media simultaneously. For instructions on creating media folders and adding
media simultaneously, see Creating Media Folders on page 49.

To add media to existing media folders:
1  You have the following choices:

% Drag the media from the Original node under the extended drive's Available
Media node to a media folder (or to the Media node under the media
folder). A message appears, prompting you to confirm the addition of the
media to the media folder. Click Yes. Since you have already selected the
media to add, the Add Media wizard appears, starting with the Media
Restore page. Skip to step REF Ref484573243 \r \h 3 to continue.

%  Right-click the Media node under a media folder and select Add Media
from the shortcut menu. The Add Media wizard appears, starting with the
Select Media to Add page.
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Figure 18: Select Media To Add Page

Select Media To Add E

The list below contains unallocated original media on this extended drive.
Media may be added ta any folder on an extended diive.

HMedia:

Media Mame | Media Folder |

@ Docs
@ Docs 2

Add Hemaye

Media Folder:
JsDOCs_ 14

< Back I Mext > I Cancel | Help |

The Select Media to Add page lists all available media that can be assigned.
Notice that the Media Folder text box at the bottom is grayed out but contains
the media folder you selected in the Administrator for adding media.

2 You have the following choices:
% Double-click a piece of media.

% Select one or more pieces of media and click Add.
The media folder appears to the right of the selected media in the Media list.
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Figure 19: Select Media To Add Page

Select Media To Add E

The list below contains unallocated original media on this extended drive.
Media may be added ta any folder on an extended diive.

HMedia:
Media Mame | Media Folder |
DOCS_1 SDOCS_14

Bemave

Media Folder:
JsDOCs_ 14

< Back I Mext > I Cancel |

Help |

When the media folder appears to the right of every piece of media you want to
add to the media folder, click Next. The Media Restore page appears.
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Figure 20: Media Restore Page

Wizard - Media Restore E

The following media contain existing files and must be restored before
these filez can be accessed. Select media and restare options below:

Media:
Media | Log | Diect| ASAP

— Optian:

W Log duplicates [list duplicate file names in media log)
[ Direct read [retrieve file data directly fram media)

V¥ Process as soon as possible [do not wait for active schedule]

< Back I Mext » I Cancel | Help |

Media restore options are only active if the media you are adding to the media
folder contains files. For details on what the media restore function does, see
File Restore on page 55.

Set the appropriate restore options for any media that currently contains files.
Those options are as follows:

Table 7: Wizard - Media Restore Page Options

OPTION: DESCRIPTION:

Log Enable this option to keep a count of files on the media that
Duplicates  duplicate files already on the extended drive when restoring.
Direct Enable this option to apply the direct read attribute to all
Read restored files. Direct read means that when accessed by a

client, the file will be read directly from media rather than
fetched to the extended drive and read from there.

Process Enable this option to restore the media immediately, rather
ASAP than as a scheduled File Restore media task (according to the
Process scheduled media tasks media activity schedule).
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NOTE =

The Process scheduled media tasks schedule is accessed through the Extended
Drive properties. For more information on configuring this schedule, see the

Media Activity Scheduler section on page 219.

5 Once restore options have been set, click Next. The Summary page appears.

The Summary page displays the media that will be added to the media folder

Figure 21: Summary Page

=

Action list:
1) Add media to specified path
2] Schedule media with existing files for restore

Selected media:
DOCS_1
Docs 2 [restore, log dups, process now]

Cancel | Help |

< Back

and the media restore options selected, if applicable.

6 Review the information in the Summary page. If the Summary Page information

is correct click Finish. The media is added to the media folder.

Once you have created your media folders and added media to them, you can create

move groups to subdivide the media in the media folders. For instructions, see

Creating Move Groups on page 61.
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MoVE GROUPS

Move groups are specific groupings of media within a media folder. When you set
up a move rule for a set of files, you point to the move group that contains the media
to which you want to move those files.

To use media assigned to a media folder for file migration, that media must be
assigned to a move group within that media folder. Assigning media to different
move groups in a media folder allows you to subdivide media within a media folder
for separate uses.

By assigning media to move groups, you can control to which set of media files will
be written and to where. This can be useful if segregation of data is necessary. For
example, if you wish to separate files from different months onto different pieces of
media within a media folder, you can create a move group for each month. Separate
media can be assigned to each move group so files for different months are not
stored on the same media.

For example, there might be a media folder, \AACCOUNTS), with several pieces of
media in the folder. One set of the media could be assigned to a move group called
January, and another set of the media could be assigned to a move group called
February. By targeting different move groups, you could create move rules that
move the file \ACCOUNTS\JAN\REPORT.DAT to one set of media and write the
file \AACCOUNTS\FEB\REPORT.DAT to another set. A move rule for
\ACCOUNTS\AN\*.* could target the January move group, and one for
\ACCOUNTS\FEB\*.* could target the February move group.

Because media is first assigned to a media folder, the only media available when
assigning media to a move group are media in that media folder. For example, if you
create a media folder \JAN\ and assign media to it, that media can only be used by a
move group in the \JAN\ media folder.

NOTE =

Move groups can contain only writable media. CD-ROM media, for example, is not
available to be assigned to a move group because it is read-only.
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CREATING MoVvE GROUPS

DISKXTENDER has a wizard to lead you step-by-step through the move group
creation process. Several pages of the Wizard lead you through the Move Group
Properties windows. This allows you to configure your move group properties at the
time you create the move group. You can also access and change these
configurations later. Unless you make changes to the options when creating your
move group, the defaults for each option are as follows:

Table 8:

Move Group Options Defaults

OPTION:

DEFAULT SETTING:

Library mount —
minimum free space on
media

Library mount —
minimum number of files

Library mount —
maximum number of
media

Maximum write errors
before media writes
disabled

Media fill method

Remove media when free
space falls below _ MB

Warn when group space
falls below _ MB

Sets the minimum amount of free space that must be
on a piece of media in order to be mounted for file
migration. Default is 32 KB.

Sets the minimum number of files due to be migrated
before library media will be mounted. Default is 1.

Sets the maximum number of that group’s media that
will be mounted at one time for migration of files.
Default is 1. Default should not be changed if
Sequential fill method option is selected.

Allows for disabling media writes if a specified
number of write errors occurs for a piece of media.
Default does not disable media.

Sets media fill method to random (first available
media is written to) or sequential (media is written to
in the order in which it appears in the move group).
Default is sequential fill.

Allows a piece of media to be removed from a move
group when the amount of free space on the media
falls below a specified number of megabytes. Default
does not remove media.

Instructs DX to enable a warning when the amount
of free space for all media in the move group falls
below a specified number of megabytes. Default
does not send a warning. System warnings are
transformed into alerts using the Alerts tab in the
Service Properties dialog box.

For detailed information on managing the properties and options for your move
groups see Chapter Three: Managing File Migration on page 83.
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Starting the Move Group Wizard

This section describes how to start the move group wizard and briefly describes how
to configure the New Move Group page.

To start the move group wizard:

1

Right-click on the Move Groups node under the appropriate media folder and
select New from the shortcut menu. The Move Group wizard appears, starting
with the New Move Group page.

Figure 22: New Move Group Page

Mew Move Group

— Group M ame
A move group iz identified by a unique descriptive name.

Hanmne: I

Enter a name that will eazily identify this move group.

— Media Type
A move group's media must be of the same supported writable ype.
Media Type:  [NAS =l

Select a media type for this move group from the list above.

< Black I Mest » I Cancel | Help |

In the Name text box, enter a name for your move group. Try to use a name that
will identify what media the move group will be using, and if possible describe
the kinds of files that will be moved to this move group’s media.

From the Media Type drop-down list, select the type of media that will be
assigned to the move group. Each move group can contain only one type of
media.

Click Next. The Media page appears.
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Configuring the Move Group Wizard Media Page

When the Media page appears, it is empty, because no media has been added to the
move group. The Media page allows you to add media to the group, if you want to
do so at this time.

If you are planning a basic file migration setup, we recommend you add all your
available media (of the same type) to the move group at this time. You may remove
it later if necessary.

NOTE =

You may create the move group without media and add it later, however you will not
be able to move files until media is added to your move group.

Figure 23: Move Group Media Page

Media
Media List:
Mame | Total Space | Free Space |
Add... Eemave Eromaote | [emate |
< Back Cancel | Help |
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To continue the move group wizard:
1 You have two choices:

% If you do not want to add media to the move group at this time, click Next.
A warning message appears informing you the move group will be created
with no media. Click OK to continue. The move group Options page
appears.

% If you want to add media to the move group, click Add. The Select Move
Group Media dialog box appears.

Figure 24: Select Move Group Media Dialog Box

Select Move Group Media E
Media:

Mame | Total Spac:e| Free Space|

0K I Cancel | Help |

The Select Move Group Media dialog box lists all media assigned to the media
folder that corresponds to the media type selected in the New Move Group page
of the wizard.

2 Select the media you want to add to the move group and click OK. (You can use
a standard Windows <Shift> or <Ctrl> technique to select more than one piece
of media.) The Media page reappears with the media listed.
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Figure 25: Move Group Media Page

Media
Media List:
Narne | Total Space | Free Space |
@ Docs_1 3,796 MB 3E23MB

Bemove | Eromaote | [emate |

< Back | Mest » | Cancel | Help |

3 Click Next. The move group Options page appears.
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Configuring the Move Group Wizard Options Page

The move group Options page allows you to configure various options for your
move group and its media. For an overview of the available options, see Table 8 on
page 61. A detailed explanation of the move group options can be found in the Move

Group Properties section beginning on page 86.

Figure 26: Move Group Options Page

DOptions

Option Mame

[ Library mount - minimum number of files
[H Library mount - masimum number of media

[H Media fill method

[H wam when group free space falls below [ME)

=R Library mount - minimum free e on media [KB]

[ b asimum wiite erors before media write disabled

M Remove media when free space falls below [ME)

SEQUENTIAL

— Option

Enter the minimum free space that must exist
on library media before it will be mounted to
begin file migration:

[z ke

< Back I Mest » I

Cancel Help

To continue the move group wizard:

1 Configure the options as appropriate (or leave the default settings). You may

change these settings later, if necessary.

2 Click Next. The Automation page appears.
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Configuring the Move Group wizard Automation page:

The Automation page allows you to configure automatic labeling and addition of
blank media to the move group. You can also set automatic media compaction to

occur.

NOTE =

If your move group media type does not allow automatic labeling of media

(example: NAS) these options will be grayed out.

Figure 27: Move Group Automation Page

Automation

— Media Labeliing

" Do not automatically label and add blank media to move group
' Autolabel blank media when free space falls below |5 ME

% Use standard method

Label Prefix: I
Mumber Wwidth: |1 'I
Sample Mame: |

" Use barcode

— Media Compaction
Do not automatically compact, remove and format move group media

& Auto-compact media when wasted space exceeds IED %

Mest > | Cancel | Help

Detailed information about configuring automatic labeling and compaction for your
move group can be found in the Move Group Properties section beginning on page

86.
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To complete the Move Group wizard:

1  Configure the move group automation settings as appropriate and click Next.
The Summary page appears.

Figure 28: Move Group Summary Page

Summary

Action list:
1] Create new move group for specified media type
2] Add zelected media to new move group

Move group details:

Giroup name: Move Docs_To Tape
Media type: TAPE

Mumber of media: 1

Fill methad: SEQUENTIAL
Dizable writing to media after emors: MO

Alert when group low on free space: MO

Femave media with low free space: MO

Minimum free space required for mount; J2KB
Mirnimum files ta trigger mount for migration: 1

b awirnum media mounted at one time: 1

Auto-label blank media: MO
Auto-compact media: Y'ES
Auto-compact wasted space watermark: A0

< Back Cancel | Help |

The Summary page lists all the move group configuration information you
provided through the wizard.

2 Review the information in the Summary page. If the information in the
Summary page is correct, click Finish. The move group is created and appears in
the Move Group node of the media folder.

Once you have created your move groups, you can create move rules. Move rules
determine what files are written to the media in selected move groups. For
instructions, see Creating Move Rules on page 71.

Move rules are designed to allow you to configure, very specifically, what files in a
media folder will be moved to what media. You can configure file movement based
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on file age, file extension, file attributes, and file size. At least one move rule must
exist before files can be migrated to media.

The following options are available during creation (and later management) of your

move rules:
Table 9: Move Rule Configuration Options

WIZARD PAGE/ OPTIONS: DESCRIPTION:

PROPERTIES

TAB:

File Name Media Folder Which folder contains the files to which

you want to apply this move rule.
Include Move only the files in the selected media
Subfolders folder or the files in all the subfolders in
the media folder.
File Name Which files in the selected folder you want
to move to media.
(For example: all files: *.*; only bitmaps:
* BMP)

Size Any Size Move files of any size.

Exclude files Do not move files smaller than the
smaller than __ specified size.

Exclude files Do not move files larger than the specified
larger than size.

Attributes Any Move files regardless of attributes.
Exclude files Do not move files if they have the selected
with selected attributes. Useful for excluding system
attributes files from move. (Though if avoidable, you

should never use a system drive as your
DX extended drive.)

Age Any Move files regardless of age.

Exclude files Do not move files until the specified
with an age less  number of days has passed since the
than __ days selected file action.

Since: (file
action)

The action from which the age of files is
determined for exclusion — Create time,
Last access time, Last write time.
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WIZARD PAGE/ OPTIONS: DESCRIPTION:

PROPERTIES

TAB:

Settings Move Group to  Which move group (group of media) will
Receive files receive these files when moved.

Set Direct Read  Mark these files to be read directly from
media when requested by a client (after the

file data is purged).
Purge Purge these files (remove file data) from
immediately the extended drive as soon as they are
after move moved to media.

There are a number of things you should consider when determining which of these
options to set for your move rules.

For example, if you are using optical media, you may want to set up an age
restriction from Last write time in your move rule because of the way files are
written to optical media. This limits the number of times frequently changing files
are written and rewritten to the media.

You can also configure specific move rules to target very large files for move and
immediate purge, in order to efficiently clear space from the extended drive. In
addition, if your move group contains NAS media, you may want to set the direct
read option for those files, because file retrieval from NAS is faster than with other
kinds of media. When a client requests one of these files in the future, the file is read
directly from the media rather than being fetched to the extended drive first, helping
you maintain extended drive space.

When files qualify for move based on the configurations you set in the move rule,
they are added to the move list, either during a drive scan (if an age delay is set) or at
the time the file is saved to the media folder on the extended drive. The move list for
each extended drive is constructed based on the move rules you create.

The contents of the move list dictates what files are moved to media. The move list is
processed and files are moved to media whenever the Move files to media activity
schedule is active. For more information on scheduling the Move files to media
activity, see Scheduling Movement of Files on page 80.

When a file is written to a media folder on the extended drive, DX checks the file
against the criteria of the move rules for that folder. If the file matches the criteria
under one of the move rules, DX attaches a DX file attribute to the file. The file
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attribute indicates that the file qualifies for movement to media and, if applicable, the
particular file age the file must reach before migration.

If the file qualifies for migration to media under a move rule that does not have a file
age exclusion specified, DX immediately adds the file to the move list. If the file
qualifies for migration to media under a move rule that does have a file age exclusion
specified, DX adds the DX attribute to the file but does not add the file to the move
list until the next extended drive scan.

When a drive scan is run, the existing move list is discarded and DX builds a new list
based on the DX attributes it finds on the files saved in the media folders on the
extended drive. Every file in a DX media folder is checked when an extended drive
scan occurs. If you configure a time delay in your move rules, you must periodically
scan the extended drive to be sure that files initially excluded from the move list
because of age are added to the list after they reach the correct age for migration.

In addition, file-sharing issues or sharing violations can prevent files from being
added to the move list when appropriate. DX must have full access to the file in
order to obtain information required for the move list. If the file is open or is
otherwise being accessed by a program or user, DX cannot add it to the move list.

It is for this reason that proper configuration of your Drive Scan schedule is a critical
part of making sure files are moved to media when appropriate. If drive scans are
permanently disabled, files that qualify for movement to media after a certain time
delay, or those that had a sharing violation when they originally became eligible, will
never be written to the move list and therefore never moved to media. Drive scans
are required to capture these files and regenerate the move list for movement of files
to media. For information on scheduling regular drive scans for your extended drive,
see the Extended Drive Administration chapter of the DX2000 System Guide.

CREATING MOVE RULES

Once move groups have been created for an extended drive, you can establish move
rules to regulate the movement of files to the media in those move groups. A move
rule contains the instructions that DISKXTENDER will follow when choosing which
files to move to a particular piece or group of media.

When you create a move rule, you specify a particular directory’s files be moved,
then further restrict the set of files by file extension, by file size and file attributes.
File age can be used to determine when files are moved.

Each move rule points to a move group as the target location for file migration.
Before you can create a move rule to move files from an extended drive to media,
you must create a move group to establish a group of media to which to move the
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files. You may create the move groups separately before creating the move rules, or
you can create the move group from within the Move Rule Wizard.

The Move Rule Wizard leads you through the step-by-step process of creating and
configuring a move rule. Several pages of the wizard lead you through the Move
Rule Properties windows. This allows you to configure your move rule properties at
the time you create the move rule. You can also access and change these
configurations later, if necessary.

For clarity and speed, the following procedures for creating move rules do not cover
these configurations in detail. For a discussion of each of the Move Rule Properties
pages, see Move Rule Properties on page 108.

Starting the Move Rule Wizard

This section describes how to start the move rule wizard and briefly describes how to
configure the File Name page.

To start the move rule wizard:

1 Right-click the Move Rules node under the appropriate media folder and select
New from the shortcut menu. The Move Rule wizard appears, starting with the
File Name page.

Figure 29: File Name Page

File Name E

 File Selection Criteria

Fuolder:

[+ Include subfolders Browsze... |

File Mame:

< Back I Mest > I Cancel | Help |

The File Name page allows you to define the location and extension for the files
to be moved.
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Select the Folder containing the files for which you want to configure this move
rule. The active media folder is listed by default. To select a subfolder of the
media folder, click Browse. The Select Folder dialog box appears.

Figure 30: Select Folder Dialog Box

Select Folder
Look in: I@ E:\Media_1_Imagesh j &l =
W ame | Size | Modified | Attributes |
1 Bitrnans o 5431/00 12:32 P

Ok I Cancel Help

Select the subfolder to use for the move group and click OK. The file path
appears in the Folder box of the File Name page.

Figure 31: File Name Page

File Name E

 File Selection Criteria

Fuolder:
I “Media 1_Images\Bitmaps' j

[+ Include subfolders

File Mame:

< Back Mest > Cancel Help
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NOTE =

You cannot include more than one selected subfolder of the media folder in a
single move rule. You can include either one or all subfolders only. To move
files in a different subfolder, create a second move rule.

4 Enable or disable the option to include all subfolders in the folder listed in the
Folder text box.

5 Inthe File Name text box, enter the file specification to determine which files
are to be moved using this move rule. For example, entering * . DOC will apply
this move rule to all files in the specified media folder with a DOC extension.

NOTE &

Only one specified file extension can be configured per move rule. To move
files of a different specified extension in the same folder, create a second move
rule. For more information on using wildcards to designate specific file names
for move, see The File Name Tab section beginning on page 109.

6  Click Next. The Size Page appears.

Configuring the Move Rule Wizard Size Page

The Size page allows you to choose configure a specific size range for the files
affected by the move rule, or to move qualifying files of any size.

Figure 32: Size Page

Size E

~File Size

" Move files of any size

& Exclude files with the follawing sizes:

™ Exclude files smaller than: IU KB

™ Exclude files larger thar: IU KB

< Back

Cancel Help
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To continue the move rule wizard:
1  You have the following choices:
% To move files of all sizes, select Move files of any size.

% To configure a file size range for exclusion from the move rule, select the
Exclude files with the following sizes option, enable the appropriate
checkboxes, and enter the sizes as appropriate.

2 Click Next. The Attributes page appears.

Configuring the Move Rule Wizard Attributes Page

The Attributes page allows you to exclude movement of files with the specified
attributes, or to move qualifying files with any attribute.

Figure 33: Attributes Page

— File Attribute:

" Move files with any attribute
& Exclude files with the follawing file attributes:

[T Beadorly [ fwchive [ Compressed
™ Hidden ™ System

< Back Cancel Help

To continue the move rule wizard:
1  You have the following choices:
% To move files regardless of attributes, select Move files with any attribute.

%  To exclude files with particular attributes, select Exclude files with the
following file attributes and then enable the options for the attributes for
files that should not be moved.

APPLICATION STORAGE MANAGER 75
Data Management Guide



Chapter Two: Setting Up File Migration

WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file purge. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

2 Click Next. The Age page appears.

Configuring the Move Rule Wizard Age Page

The Age page allows you to move files of any age or exclude files of a particular
age.

Figure 34: Age Page

Age [ %]

—File Age

" Move files of any age

& Exclude files with an age less than:

Daps: ID

Since:

Create time

< Back I Mest > I Cancel Help

To continue the move rule wizard:
1  You have the following choices:
% To move files regardless of age, select Move files with any age.

%  To exclude files within a particular age range, enable the Exclude files with
an age less than option, and then enter the number of days that must elapse
before a file is moved. Set the date from which that file age is calculated by
selecting one of the following options from the Since drop-down list: Create
time, Last write time, Last access time.

2 Click Next. The Settings page appears.
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Configuring the Move Rule Wizard Settings Page

The Settings page allows you to specify the move group (group of media) to which
files will be moved. This window also allows you to enable the direct read and purge
after move options.

Figure 35: Settings Page

Seltings [ %]

— Move Target

Move Group To Receive Files:
ﬁdove_D ocz_To_Tape j

— Move Option:

™ Mark file for direct read after move

™ Purge files immediately after move

< Back Mest > Cancel Help

To continue the move rule wizard:

1 From the Move Group To Receive Files dropdown list, select the name of the
target move group to which you want files to be moved.

NOTE =

You may create a new move group to receive files for this move rule by clicking
New. This opens the Move Group Wizard. For instructions on creating move
groups using the wizard, see Creating Move Groups on page 61.
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2 Enable or disable move options. The following table describes each option:

Table 10: Settings Page Move Options

OPTION: DESCRIPTION:

Mark file for Enabling this option sets the direct read attribute to all

direct read after files moved to media under this move rule. The direct

move read attribute means that when requested by a client, a
file (whose data has been purged) is read directly from
the media rather than being fetched to the extended
drive first and read from there.

Purge files Enable this option to immediately purge file data for

immediately after  all files moved to media under this rule. Purging files

move removes file data from the extended drive while
leaving behind a file tag containing the file attributes.

NOTE »

Purge rules for files can be configured separately if purging after move is not
appropriate for all files that qualify for this move rule. For details on creating
separate purge rules, see Creating Purge Rules on page 143.

3 Click Next. The Summary Page appears.
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Completing the Move Rule Wizard

The Summary page allows you to review the information that you have provided
through the wizard. If necessary, you can click Back to make changes on a previous

page.

Figure 36: Summary Page

Summaly

Action fist
1] Create new move e for specified file name
2] Set move policies to specified seftings

Mew rule details:
File name: SDOCS 14~
Subfolders Yes
Minimurn size: OKB
M arimum size: OKB
Include subdirs: es
Minimum age: 5 days
Age from: Create time
Move group: Muve Docs_To_Tape
Purge after move:

Direct read No _'_I
Jil

< Back

TR cancel | Help

To complete the move rule wizard:

2 Review the information in the Summary page. If the information in the summary
is correct, click Finish. The move rule is created and appears in the Move Rule
node after the media folder.

Please remember, if you have age delays configured in any of your move rules, you
must run regular drive scans in order to write those qualifying files to the move list.
In addition, DX cannot write files to the move list if doing so would cause a sharing
violation (i.e., a user or program has a file open). Regular drive scans ensure that a//
appropriate files are written to the move list, and thereby moved to media when the
Move files to media schedule is active. In order to be sure that regular drive scans
are run, we highly recommend that you set a schedule for extended drive scans.

For information on setting up your extended drive scan schedule, see the Extended
Drive Administration chapter in the DISKXTENDER System Guide.
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SCHEDULING MOVEMENT OF FILES

Each DX extended drive has its own scheduling capability that allows you to set up
specific processing schedules for media activities. This scheduling capability allows
you to process the tasks for extended drive media at whatever time is most
convenient for you.

When files qualify for movement under the configured move rules, they are written
to the move list, either immediately upon being saved to the extended drive, or
during a drive scan. The move list is not processed, however, until the Move files to
media schedule is active. The Move files to media activity is scheduled through the
extended drive scheduler.

Figure 37: Extended Drive Schedule Dialog Box

Schedule [ x]
— Aitivitie:
! 3 8 3 f 3 B 3
g a a a o P =] P ¥ Move files to media 1
o m m m m m m m

™= I Process scheduled I
media tasks

™ Update copy media 1

I Allow fetches from media 11

Clear

Select one o mare cells in arid, check/uncheck desired tasks. then zet or clear using buttons

oK Cancel Help

You can access the scheduler by opening the extended drive properties, clicking on
the Settings tab then clicking the Schedule button. A dark red line represents the
Move files to media activity. When that line appears across a box, during the
corresponding time(s), the move list is processed and files on the list are moved to
media.

The schedule grid contains columns for each hour of the day and rows for each day
of the week, creating cells which each represent one hour. For example, the blacked
out cell in Figure 37 above represents 5 p.m. to 6 p.m. on Sunday. DISKXTENDER’S
scheduler allows you to set scheduled activities by selecting one or many cells in the
grid. You can easily schedule all activities for a large block of time, or you can
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schedule specific activities for smaller blocks of time. In Figure 37 above, the Move
files to media activity is the only activity scheduled and will run from 6 p.m. to 6
a.m. every day of the week.

For details on how to use the extended drive scheduler to set up media activity
schedules, see the Media Activity Scheduler section on page 219.

NOTE &

If you have more than one extended drive configured for your DX system, you will
have to configure each extended drive schedule separately.
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CHAPTER
THREE

MANAGING FILE MIGRATION

The DISKXTENDER program uses a file migration system to allow you to manage
large stores of data and files. The term ‘file migration’ refers to the function of
moving files from a local hard drive to one or more pieces of storage media, and
retrieving those files for use when requested. Essentially what you are doing is
moving files from an extended drive with limited storage space to media pools with
more extended storage space.

DISKXTENDER automates the migration of files to media using a rule-based system.
Rather than just migrating all files to media without distinction between files, you
can select which files should be moved to what types and pieces of media. DX tracks
each file and each piece of media so that when a client requests file data that has
been moved to media, DX can find the file and retrieve it for the client.

Besides determining what types of files are moved to what media, you can also
configure a time delay for files, that will delay movement of the files until some
number of days after creation or last access or last edit. In addition, DX provides a
prefetch function, which allows you to retrieve the most commonly used files during
times of reduced system traffic.

The idea of using a file migration system to help you manage your data and files is
also about helping you manage data storage space. After file data is moved to storage
media, that data can be removed from the local storage space (extended drive),
freeing up that space for additional files. The key is to maintain as much local
storage space as possible while still making files easily available. Ultimately your
data management system is also a space management system.
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Besides the storage media being written to, DISKXTENDER uses 6 key components to
automate file and space management. Those components are:

% Extended Drive — an NTFS volume (hard drive) on the computer where DX is
installed.

% Media Folder — folder created on the extended drive, through DISKXTENDER,
where clients store (and access) files.

% Move Group — group of storage media to which files, stored in a particular
media folder, will be migrated.

% Move Rule - rule outlining the attributes of files, stored in a particular media
folder, that determines which files will be moved.

% Purge Rule — rule outlining the attributes of files, stored in a particular media
folder, that determines which files, once moved to media, will have their file
data removed from the extended drive (a file tag will remain, identifying the file
for later retrieval).

% Delete Rule — rule outlining the attributes of files, stored in a particular media
folder, that determines which files will be deleted entirely from the DX system
(permanently deleted from the extended drive and the storage media).

The extended drive, media folders, move groups and move rules, their creation, and
their management are what enable and automate your file migration and data
management system. The Purge Rules and Delete Rules are what enable and
automate space management within your data management system.

This chapter focuses on the management of your file migration components: media
folders, move groups, and move rules. While you may have done some configuration
of these components when you created them, you may have to make changes or
updates to your file migration configuration in the future.

In addition, at the end of this chapter you will find a section on configuring Prefetch
Requests. Prefetch requests allow you to retrieve the most commonly used files in
advance, during low-traffic times. This ensures that when a client accesses a
prefetched file, it is available directly from the extended drive and the client will not
have to wait for the file to be retrieved from media.

For a detailed discussion of Purge Rules and Delete Rules, see Chapter Four: Space
Management on page 137.
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MANAGING MEDIA FOLDERS

When you create a media folder for an extended drive, you provide a specific folder
location on the extended drive for files to be stored. When you create move groups
and move, purge and delete rules for a media folder, you are creating a data
management setup for the files saved in that folder. Creating multiple media folders
for an extended drive allows you to subdivide and categorize your files in a way that
makes it easier to apply separate migration strategies to different types of files. It
also allows you be very specific about what files are to be migrated to what pieces or
types of media.

Media folders do not contain specific properties as many other components of
DISKXTENDER do. Instead, managing media folders involves creating, modifying and
deleting move groups and move, purge and delete rules, and applying them to the
appropriate files in each of the media folders on the extended drive.

Media folders are listed under the extended drives for which they are configured.
Each media folder has the move group(s) created for it and the media assigned to
each move group, along with the move, purge and delete rules listed in a tree
structure below the media folder.

Each of the following sections of this chapter provides information about move
groups and move rules. For information and instructions on creating purge rules and
delete rules, see Chapter Four: Space Management on page 137.

MoVE GROUPS

Move groups are specific groupings of media within a media folder. When you set
up a move rule for a set of files, you point to the move group of media to which you
want those files moved.

To use media assigned to a media folder for file migration, that media must be
assigned to a move group within the media folder. Assigning media to different
move groups in a media folder allows you to subdivide media within a media folder
for separate uses.

By assigning media to move groups, you can control to which set of media files will
be written, and to where. This can be useful if segregation of data is necessary. For
example, if you wish to separate files from different months onto different pieces of
media within a media folder, you can create a move group for each month. Separate
media can be assigned to each move group so files for different months are not
stored on the same media.
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NOTE &

Move groups can contain only writable media. CD-ROM media, for example, is not
available to be assigned to a move group because it is read-only.

MoVvE GROUP PROPERTIES

The Move Group Properties dialog box contains five tabs: General, Media, Settings,
Automation, and Statistics. All but the Statistics Tab correspond to pages in the
Move Group Wizard, and contain move group properties configured when you
created the move group.

Accessing the Move Group Properties and selecting each of the tabs allows you to
view and change many of the settings established when the move group was created.
You can change the group name, add and remove media from the group, configure
different labeling options or set different media fill options. You can also promote
and demote media fill order within the move group.

The following sections discuss each of the tabs and their available options.

To access the Move Group Properties:

1 Right-click the move group whose properties you want to view and select
Properties from the shortcut menu. The Move Group Properties dialog box
appears with the General Tab active by default.

2 As with most Properties functions in DISKXTENDER, after making changes you
have three options:

% To save changes and close the Properties dialog box, click OK.
% To save changes and keep the Properties dialog box open, click Apply.

% To discard all changes made since the Properties dialog box was opened
and close the Properties dialog box, click Cancel.

The General Tab

The General Tab is the tab that first appears when you open the Move Group
Properties dialog box. The General Tab allows you to change the move group’s
name and the type of media that will be assigned to the move group.
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NOTE =

You cannot add any media to a move group that is of a different type than what is
specified for the group. This attribute must be changed before media of a different
type can be added.

WARNING é*

If you have media already assigned to the move group, and you attempt to change
the media type, a warning box appears informing you that all media in that move
group will be removed.

To view the General Tab:

1  Click the General tab in the Move Group Properties dialog box. The General
Tab appears.

Figure 38: Move Group Properties: General Tab

Move Group Properties E

General | Media I Dptionsl Automationl Statisticsl

— Group Mame
A move group is identified by a unique descriptive name.

Marne: Move_Docs_Ta MAS

Enter a name that will easily identify this move group.

— Media Type
A move group's media must be of the zame supported writable type.
Media Type:  [NAS =l

Select a media type for this move group from the list above.

Cancel Lol Help
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2 You have the following choices:

% To change the name of the Move Group, type the new name into the Name
text box in the Group Name section of the tab.

% To change the media type, select a different media type from the Media
Type drop-down list in the Media Type section of the tab.

NOTE =

If you change the media type for the move group, you may also want to change
the move group name to reflect the new media type, if applicable.

The Media Tab

The Media Tab lists all media currently assigned to the Move Group and statistics on
the Total Space and Free Space on that media. If you did not assign media to the
group when you created the move group, you may use this tab to add media after the
group is created. You can also use this tab to add additional media to the move

group.

In order to add media to the move group, the media must already be assigned to the
media folder. Each piece of media can only be assigned to one move group at a time.

The Media Tab allows you to add and remove media for the move group and allows
you to promote and demote media. Promoting and demoting media changes the order
of the media in the list and pertains specifically to the Fill Sequentially option for
move groups. For more information on setting the filling media sequentially
attribute, see the Use Sequential Fill Method discussion on page 97.

NOTE =

You can also add and remove media for the move group by dragging media to and
from the move group in the tree view of the administrator or by assigning the Add to
Move Group or Remove From Move Group media tasks. For more information on
assigning the tasks to media, see Chapter Six: Storage Media Tasks on page 225.
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To view the Media Tab:

< Click the Media tab in the Move Group Properties dialog box. The Media Tab
appears.

Figure 39: Move Group Properties: Media Tab

Move Group Properties [ %]
General Media |Dpti0ns| Automationl Statisticsl
Media List:
Mame | Total Space | Free Space |

@ Docs_1 3,796 ME
:Docs 2
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QK | Cancel | Lol | Help |

To add media to a move group:

1 Inthe Media Tab of the move group Properties, click Add. The Select Move
Group Media dialog box appears, listing all media of the specified media type
available in the media folder.
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Figure 40: Select Move Group Media Dialog Box

Select Move Group Media E3
Media:

MName | Total Space | Free Space |

ME

Ok I Cancel Help

2 From the Media list, select the media you want to add and click OK. The
selected media appears in the Media Tab.

To remove media from the move group:

< Inthe Media Tab of the move group Properties, select the media you want to
remove and click Remove. The selected media is removed from the move group,
but remains assigned to the media folder.
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Reordering Media in a Move Group

You can promote and demote media to set the media fill sequence. If Fill media in
the move group sequentially is enabled for the move group, media is filled
sequentially in the assigned list order. If more than one piece of media has been
assigned to a move group, the media can be placed in a particular order so that files
are written to media in the order listed. The piece of media listed first is the first
piece of media to which files will be written; when this piece of media is full, files
are written to the second piece of media, and so on. A piece of media can be
“promoted” to a higher position in the list, or “demoted” to a lower position. (If
sequential fill is disabled, the next available piece of media in the move group is
used, regardless of the order set in this list.)

To promote or demote media in the move group:

1 Inthe Media tab, select the piece of media whose order in the list you want to
change.

2 You have the following choices:

% To move the media up in the list, click Promote. The media is moved up
one position in the list.

% To move the media down in the list, click Demote. The media is moved
down one position in the list.

The Media now appears in the new order.

The order of media listed in the Media tab is relevant only if the Fill Sequentially
attribute is configured for the move group. The Fill Method option can be found in
the Settings Tab of the Move Group Properties dialog box. For more information on
this attribute, see the Use Sequential Fill Method discussion on page 97.
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The Options Tab

The Options Tab lists all configurable options available for the move group. Each of
these options is discussed below. The configuration options that appear in the lower
part of the Options tab correspond to the option selected in the list in the upper part

of the Options tab.

To view the Options Tab:

9 Click the Options tab in the Move Group Properties dialog box. The Options

Tab appears.

Figure 41: Move Group Properties: Options Tab
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Enter the minimum free space that must exist l—
oh library media befare it will be mounted to 2 kB
begin file migration:

QK I Cancel | Lol | Help |

The following sections discuss each of the move group options available for
configuration, in the order in which they appear in the Options tab.
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Library mount - minimum free space on media (KB)

Use this option to configure DX to only mount media that has more than the
specified number of kilobytes of free space available on the media. This setting only
controls whether or not DX will mount the media specifically for media writes. If the
media is already mounted when the file moves are activated, DX will attempt to
write to the media regardless of the amount of free space on the media.

Figure 42: Library mount — minimum free space on media (KB) option
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1
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begin file migration:

[ ke

Cancel | Apply

Help

available on the media for the media to be mounted to the device drive for file writes.

If media in the move group has less free space than the entered number of kilobytes,
the media will not be mounted for file moves to media. The default is 32.
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Library mount - minimum number of files

Use this option to configure DX to only mount media in the move group if at least
the specified number of files will be moved to the media in that move group. This
setting only controls whether or not DX will mount the media specifically for media
writes. If the media is already mounted when the file moves are activated, DX will
attempt to write to the media, regardless of the number of files to be written.

Figure 43: Library mount — minimum number of files option
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In the text box, enter the number of files that must be on the move list before the
media in this move group will be mounted for file writes. The default is 1.
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Library mount -maximum number of media

Use this option to configure the maximum number of media from this move group
that can be mounted for file writes at one time.

Figure 44: Library mount — maximum number of media option

Move Group Properties [ %]
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Option Mame | WValue |
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[ M awirnurn write errors before media wite disabled
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— Option
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may be mounted at one time for file migration: I‘I
[Mote: uzed only for R&MNDOM media fill)

Cancel | Apply | Help |

In the text box, enter the maximum number of media from this move group that can
be mounted in device drives for file writes at one time. The default is 1.

NOTE =

If you have configured Sequential fill for the media in this move group the maximum
number of media that can be mounted at one time will be 1, regardless of this setting.
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Maximum write errors before media write disabled

Use this option to configure DX to stop writing to media if a specified number of
write errors occur when migrating files to media.

Figure 45: Maximum write errors before media write disabled option
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Disable writing to media after write errors occur __: select this to configure DX
to stop writing to media if the specified number of write errors have occurred when
attempting to write files to the media.

Do not disable writing to media after write errors occur: select this to allow DX
to continue to attempt to migrate files to media, regardless of the number of write
errors that have occurred on the media. This is the default.
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Use Sequential Fill Method

The Media fill method option for move groups allows you to determine whether to
fill media in the order in which they appear in the media list in the Media tab, or to
fill media randomly, selecting media based on its availability. For information on
setting media order, see The Media Tab on page 88.

If sequential fill is enabled, DX will wait until the next piece of media in the move
group is available before proceeding to move files to that move group. If sequential
fill is not enabled, DX will use the piece of media in the move group that can be
accessed most quickly, regardless of media order in the move group.

Figure 46: Media fill method option
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Option Mame | Walue |
[H Library mount - minimum free space on media [KB) 32
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— Option
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Cancel | Apply | Help |

Sequential — Write to one media at a time (optimize retrieval): select this option
to fill the media in the move group in the order in which they appear in the Media
tab. This is the default.

Random — Write to any available media (optimized writing): select this option to
fill media based on its availability at the time files are migrated.
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NOTE &

File retrieval can be less efficient when media is not filled in sequence. For example,
several bitmaps could be moved to media according to a particular move rule while
not being moved to sequential media. If all the bitmaps were retrieved at once, DX
might have to mount several pieces of media, which would slow retrieval times.

Remove media when free space falls below (MB)

Use this option to automatically remove media from the move group when the free
space on the piece of media falls below a specified number of megabytes. Removing
the media from the move group means that files will no longer be migrated to that
piece of media. Media removed from a move group remains in the media folder.

You should enable this option if your move group contains media that cannot be

compacted.

Figure 47: Remove media when fee space falls below (MB) option
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Remove media when free space falls below __ MB: select this to automatically
remove pieces of media when free space on that media falls below the entered

number of megabytes.
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Do not automatically remove full media from this group: select this to leave
media in the move group regardless of its fill level. This is the default.

NOTE =

You may not want to enable this option if you use automated media compaction for
the media in the move group (available from the Automation tab). Compacting
media removes the media from the move group and the media folder automatically.

Warn when group free space falls below (MB)

Use this option to configure whether or not you want DX to warn you when the free
space available on all media in the move group falls below a specified number of
megabytes. Warnings can be configured into Alerts using the Alerts tab in the
Service Properties dialog box.

Figure 48: Warn when group free space falls below (MB) option

Move Group Properties [ %]
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Warn when group free space fall below __ MB: select this to configure DX to
send you a warning when the amount of free space in the move group media falls
below the entered number of megabytes.
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Do not warn when group is low on free space: select this to disable any free space
watermark warnings. This is the default.

NOTE =

If you have enabled the automated labeling and automated compaction option
(available through the Automation Tab of the move group properties), you do not
need to configure a warning, as the media in the move group will automatically be
added and compacted as space is required.

The Automation Tab

The Automation Tab of the Move Group Properties page allows you to set up
automatic media labeling and addition of that labeled media to the move group when
the free space on the media in the move group falls below a specified level.

The Automation Tab also contains an automatic Media Compaction option that
allows you to set up automatic compaction of media in the move group when the
amount of wasted space on each piece of media exceeds a specified percentage.

Compacting media reclaims lost space by writing all active files from the media
(those not marked for deletion) back to the media folder on the extended drive, and
removing the media from the move group and the media folder. After media has
been compacted, it can be reformatted (if supported by the media type), allowing that
media to be used again. The files written to the media folder are migrated back to
move group media based on the move rules for the media folder. Automatic
compaction automatically assigns the Format task to the media it has compacted.
Once formatted, the media is added to the Blank media node, and is available to be
re-added to the move group.

NOTE =

If your move group contains a media type that does not support media labeling or
media compaction and reformat (example: NAS), the Automation options will not be
available.
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To view the Automation Tab:

< Click the Automation tab in the Move Group Properties dialog box. The

Automation Tab appears.

Figure 49: Move Group Properties: Automation Tab
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Configuring Automated Media Labeling

You can configure whether to automatically label blank media and add it to the move
group when move group media free space falls below a certain level. The labeling
options available are as follows:

Table 11: Automated Media Labeling Options

OPTION: DESCRIPTION:
Do not Select this option to prevent DX from automatically selecting
automatically blank media, labeling it, and adding it to a move group.
label and a.dd If you select this option, you may want to activate the Warn
blank media to .

when group free space falls below MB option on the
move group

Options tab to alert you when move group free space falls
below a particular level. This will signal you to manually
label and add blank media to the group when needed.

Auto-label blank Select this option to configure DX to automatically select
media when free  blank media, label it, and add it to the move group when the
space falls below total number of free megabytes on media in the move group
MB falls below a specified number.

% Select Use standard method to label media based on a
label prefix and number width. In the Label Prefix text
box, specify a prefix to be used for naming each added
piece of media. From the Number Width drop-down list
box, select the number of digits to be used to create the
incremental numbering for the media label. DX adds the
number to the prefix to create the name for each added
piece of media.

The Sample Name text box provides an example of what
the media name will look like based on the prefix and
number width criteria you set.

% Ifbarcodes are available on your system, and if you want
DX to generate labels for media based on these barcodes,
select Use barcode. To determine if the media device
supports barcode labeling, refer to your device manual.

NOTE =

If your move group contains a media type that does not support media labeling, the
automated Media Labeling options will not be available.
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Configuring Automated Media Compaction

You can configure whether to automatically compact media when the wasted space
on the media exceeds a certain percentage. Media compaction reclaims wasted space
by writing all active (non-deleted) files on the media back to the media folder on the
extended drive. The media is then automatically removed from the move group and
media folder.

Files written to the extended drive are re-migrated back to media based on the move
rules for that media folder. The options for automated media compaction are as
follows:

Table 12: Automated Media Compaction Options

OPTION: DESCRIPTION:

Do not automatically Select this option to prevent DX from automatically
compact, remove and compacting media.
format move group

media
Auto-compact media Select this option to configure DX to automatically
when wasted space compact media when wasted space on the media
exceeds % exceeds the specified percentage.

NOTE =

If your move group contains a media type that does not support media formatting,
the automated Media Compaction options will not be available.
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The Statistics Tab

The Statistics Tab of the Move Group properties contains statistical information
about the media in the move group, including the total number of media, the total
number of move rules, total space usage, and pending move details.

You may only view the statistical information. There are no configurable options in

this tab.

To view the Statistics Tab:

9 Click the Statistics tab in the Move Group Properties dialog box. The Statistics

Tab appears.

Figure 50: Move Group Properties: Statistics Tab

Move Group Properties [ %]
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Tatal Media:

Total Move Rules:

—Space Usage
Free Space:
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7598538752
363,462 656
7.962,001 408
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Total Files:

Total Bytes:

o]
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The information listed on the Statistics Tab is as follows:

Table 13: Move Group Properties: Statistics Tab Information

GROUP: ITEM: DESCRIPTION:
Information Total Media The number of media currently in the
move group.
Total Move The number of move rules currently
Rules configured to write to the move group.
Space Usage Free Space The number of free bytes (total) on move
group media.
Used Space The number of used bytes (total) on move
group media.
Total Space The number of total bytes on move group
media.
Pending Move Total Files The number of files pending move.
Total Bytes The sum of all bytes in files pending
move.

DELETING A MOVE GROUP

A move group can easily be deleted. When a move group is deleted, all
configurations for that move group, including any move rules currently configured to
write to the move group, are also deleted. The media in the deleted move group
remains assigned to the media folder and the files on the media remain listed in the
media folder on the extended drive. The media from the deleted move group is then
available to be added to another move group in the media folder.

If you want to delete a move group without deleting the associated move rule(s),
create a move group and assign it to the affected move rule(s) in place of the group
you want to delete.
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To delete a move group:

1 Right-click the move group you want to delete and select Delete from the
shortcut menu. A verification message appears.

2 Click Yes to delete the move group. If there are any move rules configured to
write to the move group, a warning message appears informing you that the
move rule will be deleted as well.

3 Click OK to continue with the deletion.

The move group and all associated configurations and move rules are deleted.

MOVE RULES

Move rules control what files in the media folder(s) on the extended drive are moved
to media. The path where the files are located is specified, as well as file parameters
delimiting which files within the path are affected by the rule. You can set file
parameters to select only certain files using the file extension, file attributes, and file
size. You can also configure a time delay for files, excluding them from movement
until after a certain specified time period has elapsed since file creation, last file
access, or last file write.

In the Extended Drives tree, each move rule is listed under the Move Rules node of
each media folder, and is represented by a truck icon. Each move rule points to a
target move group of media for migration.

There are a number of things you should consider when determining what option
settings to use for your move rules.

For example, if you are using optical media, because of the way files are written to
optical media, you may want to set up an age restriction from Last write time in your
move rule. This limits the number of times frequently changing files are written and
rewritten to the media.

You can also configure specific move rules to target very large files for movement
and immediate purge to efficiently clear space from the extended drive. If your move
group contains NAS media, you may want to set the direct read option for those files
because file retrieval from NAS is faster than with other kinds of media. When a
client requests one of these files in the future, the file is read directly from the media
rather than being fetched to the extended drive first, helping you maintain extended
drive space.

When files qualify for move based on the configurations you set in the move rule,
they are added to the move list, either during a drive scan or at the time the file is
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saved to the media folder on the extended drive. The move list for each extended
drive is constructed based on the move rules you create.

The contents of the move list dictates what files are moved to media. The move list is
processed and files are moved to media whenever the Move Files to Media activity
schedule is active. For more information on scheduling the Move files to media
activity, see Scheduling Movement of Files on page 80.

When a file is written to a media folder on the extended drive, DX checks the file
against the criteria of the move rules for that folder. If the file matches the criteria
under one of the move rules, DX attaches a DX file attribute to the file. The file
attribute indicates that the file qualifies for movement to media and, if applicable, the
particular file age the file must reach before migration.

If the file qualifies for migration to media under a move rule that does not have a file
age exclusion specified, DX immediately adds the file to the move list. If the file
qualifies for migration to media under a move rule that does have a file age exclusion
specified, DX adds the DX attribute to the file but does not add the file to the move
list until the next extended drive scan.

When a drive scan is run, the existing move list is discarded and DX builds a new list
based on the DX attributes it finds on the files saved in the media folders on the
extended drive. Every file in a DX media folder is checked when an extended drive
scan occurs. If you configure a time delay in your move rules, you must periodically
scan the extended drive to be sure that files initially excluded from the move list
because of age are added to the list after they reach the correct age for migration.

In addition, file-sharing issues or sharing violations can prevent files from being
added to the move list when appropriate. DX must have full access to a file in order
to obtain the information required for the move list. If the file is open or is otherwise
being accessed by a program or user, DX cannot add it to the move list.

It is for this reason that proper configuration of your Drive Scan schedule is a critical
part of making sure files are moved to media when appropriate. If drive scans are
permanently disabled, files that qualify for movement to media after a certain time
delay, or those that had a sharing violation when they originally became eligible, will
never be written to the move list and therefore never moved to media. Drive scans
are required to capture these files and regenerate the move list for movement of files
to media. For information on scheduling regular drive scans for your extended drive,
see the Extended Drive Administration chapter of the DX2000 System Guide.
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NOTE =

Forced drive scans also write time-delayed files to the move list, and you may force
an extended drive scan whenever necessary. However, to ensure that all qualified
files are moved to media when appropriate, we recommend you set up a regular drive
scan schedule for each extended drive.

MoOVE RULE PROPERTIES

The Move Rule Properties dialog box contains six tabs: File Name, Size, Attributes,
Age, Settings and Statistics. All but the Statistics tab correspond to pages in the
Move Rule Wizard and contain the move rule properties configured when you
created the move rule.

Accessing the Move Rule Properties and selecting each of the tabs allows you to
view and change the settings established when the move rule was created. You can
change what files are affected by the move rule by changing or disabling the file size
specifications, changing or disabling the exclusion of files based on file attributes,
and changing or disabling the age (time delay) specifications for moving files. You
can also change which move group’s media is to receive the files, and enable or
disable the direct read and purge after move options.

The following sections discuss each of the tabs and their available options.

To access the Move Rule Properties:

1 Right-click the move rule whose properties you want to view and select
Properties from the shortcut menu. The Move Rule Properties dialog box
appears with the File Name Tab active by default.

Figure 51: Move Rule Properties Dialog Box

Move Rule Properties [ %]

File Mame | Size I Attributesl Age I Settingsl Statisticsl

 File Selection Criteria

FEolder:

I \Media_1_lmagesh j
v Include subfolders Browse... |
File Mame:

Cancel Lpply Help
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2 As with most Properties functions in DISKXTENDER, after making changes you
have three options:

% To save changes and close the Properties dialog box, click OK.
% To save changes and keep the Properties dialog box open, click Apply.

% To discard all changes made since the Properties dialog box was opened
and close the Properties dialog box, click Cancel.

The File Name Tab

The File Name tab is the tab that first appears when you open the Move Rule
Properties dialog box. The File Name tab allows you to view and change the folder
and file name specifications for the move rule.

To view the File Name tab:

9 Click the File Name tab in the Move Rule Properties dialog box. The File Name
tab appears.

Figure 52: Move Rule Properties: File Name Tab

Move Rule Froperties E

File Name | Size | Atributes | Age | Settings | Statistics |

 File Selection Criteria

Folder:
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Cancel Apply Help
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The Folder text box allows you to change the location of files to which the move rule
will be applied. You have the following choices:

©

To apply the move rule to files in a different folder, select the folder/path from
the Folder drop-down list. To select a specific subfolder within the active media
folder, click Browse.

Enable or disable the Include subfolders option. If enabled, all files in the
specified folder and all subfolders and their files will be subject to the move
rule. If disabled, only the files in the specified directory will be subject to the
move rule.

NOTE =

You cannot include more than one select subfolder of the media folder in a single
move rule. You can include either one or all subfolders only. To move files in a
different subfolder, create a second move rule.

In order to change which files in the specified location the move rule applies to, you
can use the standard Windows asterisk (*) wildcard to select only files with specific
extensions or naming conventions for move. The asterisk represents one or more
characters in the name or extension part of the file name. For example:

G

G

To apply the move rule to all files in the directory, type * . * in the File Name
text box.

To apply the move rule to only files of a particular type, type in an asterisk
before the period and the appropriate file extension after the period. For
example, to move only bitmaps type * . BMP in the File Name text box.

To apply the move rule to files with a certain naming convention use the asterisk
as part of the file name. For example, to move only files indicated as reports,
type *REPORT . * or *REPORT* . * in the file name text box.

To use the wildcard to specify only files of a certain type with a specific naming
convention, use the asterisk in the name part of the file name while specifying
the file extension. For example, to move only text files indicated as reports, type
*REPORT* . TXT in the file name text box.

NOTE &

Only one file name specification can be configured per move rule. To move files of a
different specification in the same folder, create a second move rule.
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The Size Tab

The Size tab allows you to view and change the file size qualifications for the move

rule.

To view the Size tab:

9 Click the Size tab in the Move Rule Properties dialog box. The Size tab appears.

Figure 53: Move Rule Properties: Size Tab

Move Rule Properties [ %]
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—File Size
" Move files of any size
& Exclude files with the following sizes:

¥ Exclude files smaller than: |5 KB

¥ Exclude files larger than: 700 KB

Cancel | Apply | Help |

To move files of all sizes, select Move files of any size. This is the default.

To only move files of a specified size range, select the Exclude files with the
following sizes. You have the following options:

% Enable the Exclude files smaller than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must match or exceed in order to be
moved to media.

% Enable the Exclude files larger than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must be equal to or smaller than in
order to be moved to media.

If both options are enabled, only files whose size falls in between the kilobyte
specifications will be subjected to the move rule. Files whose size falls outside
of the range set by both options will never qualify for movement to media under

this move rule.

The Attributes Tab

The Attributes tab allows you to view and change the specific file attribute
qualifications for the move rule.
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To view the Attributes tab:

1  Click the Attributes tab in the Move Rule Properties dialog box. The Attributes
tab appears.

Figure 54: Move Rule Properties: Attributes Tab

Move Rule Properties E

File Namel Size  Altibutes |Age | Settingsl Statisticsl
— File Attribute:

" Move files with any attribute
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™ Hidden ¥ System

Cancel Apply Help

2 You have the following choices:

% To move files with any attributes, select Move files with any attribute. This
is the default.

%  To exclude files with certain attributes from being moved to media, select
Exclude files with the following attributes. Then click a check the boxes
corresponding to the attributes that will disqualify a file from being moved
to media.

WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file purge. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

The Age Tab
The Age Tab allows you to configure a time delay for the movement of files to
media.
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If there is no age specification configured for the move rule, all files that otherwise
qualify for movement to media under this move rule will be written to the move list
immediately upon being saved to the media folder on the extended drive.

If an age specification is configured for the move rule, all files that otherwise qualify
for movement to media under this move rule will be written to the move list when
the entered days have elapsed since the selected file action and the next drive scan is
run. For information on Drive Scans, see the Extended Drive Administration chapter
of the DX2000 System Guide.

NOTE =

Files written to the move list are moved to media when the Move files to media
schedule is active. For information on scheduling the Move files to media activity,
see Scheduling Movement of Files on page 80.

To view the Age tab:
< Click the Age tab in the Move Rule Properties dialog box. The Age tab appears.

Figure 55: Move Rule Properties: Age Tab
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If you want to move files regardless of age, select Move files with any age. This
is the default.
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To exclude files from movement to media until a certain number of days have
passed since a specific file action, enable the Exclude files with an age less than
option. Then configure the following:

% Type in the number of days you want to elapse from the file action trigger
before the file is written to media in the Days text box.

%  Select the appropriate file action trigger from the Since drop-down box:
Create time, Last access time, or Last write time.

The Settings Tab

The Settings tab allows you choose a different move group to receive the files being
selected for move by the move rule. You can also enable or disable the direct read
and purge files after move options.

NOTE =

If you disabled certain time periods on the Allow fetches from media schedule to
create a time-based restriction of access to purged files, you may want to take that
into consideration when determining whether to purge files immediately after move,
or to mark files for direct read.

To view the Settings tab:
1  Click the Settings tab in the Move Rule Properties dialog box. The Settings tab

appears.
Figure 56: Move Rule Properties: Settings Tab

File Namel Size I Attributesl Age Settings I Statisticsl

—Mowve Target
Maove Group To Receive Files:
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™ Mark file for direct read after move
[+ Purge filez immediately after move

Ok I Cancel Apply Help
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Changing the targeted move group for your move rule changes the media to
which the files moved by this move rule are written.

2 You have the following options:

% To choose a different existing move group to receive the files being selected
for migration by the move rule, select the new move group from the Move
Group To Receive Files drop-down box.

%  To create a new move group to receive migrating files, click New. This
opens the Move Group Wizard and leads you through the creation of a new
move group. Once the wizard completes, you are returned to the Settings
tab of the Move Rule Properties dialog box and the new move group
appears in the Move Group To Receive Files text box.

You may also enable or disable the options in the Move Options section of the
Settings Tab. The options are as follows:

Table 14: Settings Tab: Move Options

OPTION: DESCRIPTION:

Mark file for Enabling this option sets the direct read attribute to all
direct read after files moved to media under this move rule. The direct
move read attribute means that when requested by a client, a

file is read directly from the media rather than being
fetched to the extended drive first and read from there.

Purge files Enable this option to immediately purge file data for
immediately after  all files moved to media under this rule. Purging files
move removes file data from the extended drive while

leaving behind a file tag containing the file attributes.

NOTE =

Purge rules for files can be configured separately if purging after move is not
appropriate for all files that qualify for this move rule. For details on creating
separate purge rules, see Creating Purge Rules on page 143.
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The Statistics Tab

The Statistics tab provides pending file migration statistics from the most recent
drive scan. The statistics shown pertain only to the files selected for migration by
qualifying for this move rule and are valid only until the next extended drive scan.

To view the Statistics tab:

9 Click the Statistics tab in the Move Rule Properties dialog box. The Statistics tab
appears.

Figure 57: Move Rule Properties: Statistics Tab
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The items shown on the Statistics tab are as follows:

Table 15: Statistics Tab: Pending Move Information

ITEM: DESCRIPTION:

Total Files The number of files that at the time of the last drive
scan qualified for migration to media using this move
rule.

Total Bytes The total size, in bytes, of all files that at the time of

the last drive scan qualified for migration to media
using this move rule.
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DELETING A MOVE RULE

A move rule can easily be deleted from the media folder. Deleting a move rule
deletes all configured options for that move rule. Remember, however, that you must
have at least one move rule configured in order to migrate files to media.

To delete a move rule:

1 Right-click the move rule that you want to delete and select Delete from the
shortcut menu.

2 A message appears, prompting you to verify the deletion. Click Yes.

The move rule is deleted and no longer appears in the Move Rule node for that
media folder in the extended drive tree.

PREFETCH REQUESTS

If you configure your move rules to purge files from the extended drive after they are
moved to media, the data from the files is removed from the extended drive, leaving
behind a file tag that identifies the purged file and its attributes.

When a client requests a purged file, depending on the type of media the file has
been migrated to, it may take some time to retrieve the file. In addition, multiple
client requests for purged files may put a critical strain your system resources and
cause media mounting conflicts in your media device.

DISKXTENDER contains a prefetch capability, which allows you to retrieve frequently
used files from storage media in advance of their being requested by a client. This
allows you to reduce read requests during high traffic times by anticipating file
retrieval needs. In addition, if you disable certain time periods of the Allow fetches
from media schedule to create a time-based restriction of access to purged files, you
will want to be sure to have all necessary files prefetched to the extended drive, in
order to maintain access to those files during the times when fetches are prohibited.

NOTE &

The Allow fetches from media schedule only pertains to individual client requests
for purged DX files from media. It does not apply to and will not affect any DX
prefetch requests created through the Prefetch Request Manager.

During a prefetch, DISKXTENDER goes out to media to retrieve specified files from
storage media and writes the file data to the extended drive. Prefetches will fetch all
requested files to the extended drive, to include files marked for direct read.
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Frequently used files can be prefetched during off-peak hours, enabling faster access
to files during high traffic times. Prefetch requests and schedules are created in the
Prefetch Request Manager available from the Tools menu.

There are two kinds of prefetch requests: Direct and Indirect. Both function
identically with respect to retrieving a list of files from media to the extended drive.
Direct prefetch requires you to manually create the list of files to be retrieved.
Indirect prefetch allows you to use a previously saved list of files for Prefetching.
For more information on Direct and Indirect Prefetch Requests, see Direct Prefetch
Request below and Indirect Prefetch Request on page 119.

NOTE &

Prefetch is a memory-intensive procedure. When planning to prefetch a large number
of files, for optimal performance, we recommend you create several smaller prefetch
request lists instead of one large list. You also may want to create separate lists (if
possible) for files fetched from separate pieces of media. This reduces the potential
for drive and media competition within a library, also called “thrashing.”

NOTE =

The Prefetch functions discussed here do not include the Prefetch media task. The
Prefetch media task can be assigned to a particular piece of media and will prefetch
all files on that media to the extended drive. For more information on the Prefetch
media task, see Prefetching Files from Media on page 237.

DIRECT PREFETCH REQUEST

A direct prefetch request is a request where you build a prefetch file list by selecting
files as a step in the wizard. You can select files and folders for prefetch by browsing
for them, or you can add files to the file list by selecting a text file that lists specific
files.

The direct prefetch option is intended for manually creating prefetch requests for
specific files. Direct prefetch requires manual selection of the files to be prefetched.
When a direct prefetch request is made, DX registers the name of each file requested,
even if a list is loaded from a file. If the request is resubmitted, the list of files added
when the request was created will be prefetched. If the contents of a file list loaded
for a direct request changes, DX will not register those changes for resubmission. For
this reason, direct requests should not be used for recurring prefetches where file lists
are being regenerated each time. Instead, save the recurring file list for use later in an
indirect prefetch request. For more information on saving file lists, see Saving a
Prefetch File List to a File on page 132.
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INDIRECT PREFETCH REQUEST

An indirect prefetch request is a request where you load an existing file list. This
option is intended for re-occurring batch prefetches where the list of files being
prefetched may change. You can designate a file where DX can read a file list, and
then rebuild that list as needed. With an indirect request, DX registers only the name
of the file that contains the list of files to be prefetched. As long as that list is saved
under the specified filename, the contents of the list can change as often as required.

Indirect Prefetch File Format

The file for use in the indirect prefetch request should be created before you run the
prefetch wizard to create the request. In the wizard, you can browse for the file or
type it in the file text box. Prefetch request files should be saved with an extension of
.DXP.

If you have an existing list of files, you can load that list into the file list once you
have formatted it correctly. For the list import to be successful, the file must contain
a complete, correct directory path for each file to be added, such as:

\ACCOUNTS\OCTOBER\EXPENSES . XLS

The file should have a single file listing per line (i.e., file listings are separated by
hard returns). Comments can be inserted in the file, but each comment line should be
proceeded by a semi-colon (;).
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USING THE PREFETCH MANAGER

The Prefetch Manager lists pending requests and provides access to prefetch
management functions. This design allows you to manage prefetch requests from a
central location for each extended drive. From the Prefetch Manager you can create
new prefetch requests, and edit, delete, stop, and resubmit existing requests, and
view the Prefetch log.

To open the Prefetch Manager:

< From the Tools menu in the Administrator, select the Prefetch Request Manager.
The Prefetch Manager dialog box appears.

Figure 58: Prefetch Manager Dialog Box

Prefetch Manager [ %]

— Request List
Owner Title Description Status Mext Start Time
BEE agne Reports Prefetch all Rep...  PENDING 5/31/00 10:00:00 Pk
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120 APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Three: Managing File Migration

All prefetch management functions are available through the Prefetch Manager
dialog box. The buttons in the Prefetch Manager perform the following functions:

Table 16: Prefetch Manager Buttons

BUTTON: FUNCTION:

Mew... Opens Prefetch wizard to create a new prefetch request.
Edit... Opens Prefetch wizard to edit selected prefetch request.
Dielete Deletes selected prefetch request.
Riesubmit Resubmits selected prefetch request. This button allows you to

reuse a request after it is completed, reducing your prefetch
configuration time.

Abart Stops the selected prefetch request if it is currently processing.

Log... Provides access to the prefetch log.

The Prefetch Wizard

The Prefetch wizard leads you step-by-step through configuring either direct or
indirect prefetch requests. Once the requests have been configured, they are added to
the list in the Prefetch Manager and will be processed based on the schedule you set
for each prefetch request.

To start the Prefetch Wizard:

9 In the Prefetch Manager page, click Add. The Prefetch Wizard opens with the
Prefetch Information page.
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Configuring Prefetch Information

The Prefetch Information page allows you to configure settings for the prefetch

request.

Figure 59: Prefetch Wizard: Prefetch Information Page
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To configure prefetch information:

1 Inthe Tracking Details section of the Prefetch Information Page, enter the
identifying information for the request. This information appears in the Prefetch
Properties page once the request is complete.

Table 17: Prefetch Information Page: Request Details

ITEM: DESCRIPTION:
Owner The name of the person initiating the prefetch request.
Title The name of the prefetch job.

Description A description of the request, which can be up to 255

characters in length.
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2 Select either Direct or Indirect prefetch type. If you select Indirect, you must
enter or Browse to the name of the file containing the list of files to be
prefetched.

3 Click Next. The Prefetch Schedule page appears.

Scheduling the Prefetch Request

The Prefetch Schedule page defines how frequently the prefetch will occur.
Prefetches can be scheduled to occur ASAP, once, hourly, daily, weekly, and

monthly.

Figure 60: Prefetch Wizard: Prefetch Schedule Page

—when Tao Perform
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" Weskly
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< Back I Mext > I Cancel Help

NOTE &

The Prefetch scheduler functions independently of the Allow fetches from media
activity schedule, and will run when scheduled through the wizard, regardless of
whether the Allow fetches from media schedule is active at that time or not.

To perform an immediate prefetch:

1  Select the ASAP (default) option to configure the prefetch to occur immediately
after you finish configuring the prefetch in the wizard.
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2 You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page on
page 129.)

NOTE =

To schedule a one-time prefetch for a time other than now, use the Once option.

To perform a one-time prefetch:

1 Click Once on the Prefetch Schedule page. The Date and Time spin-boxes

appear.
Figure 61: Once Prefetch Option
—'when To Perform
" ASAP [as soon as possible]
& Onge Date: |05J31 —
" Hourly Time: I £00PM ==
 Daiy
" Weskly
£ Monthly

e Cancel Help

2 In the Date spin-box, specify the date you want the prefetch to occur.

3 In the Time spin-box, specify the time you want the prefetch to occur.
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4  You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page on
page 129.)

To configure the prefetch to occur on an hourly basis:

1 Click Hourly on the Prefetch Schedule page. The Perform every hour(s)
text box and Start Time spin-box appears.

Figure 62: Hourly Prefetch Option

—'when To Perform
€ ASAP [as soon as possile)
Peiform every I 1 hours).
ourhe Start Time: I L00FPM ==

 Daily

" Weskly

£ Monthly

< Back I Mext > I Cancel Help
2 In the Perform every hour(s) text box, specify the hourly rate at which you

want the prefetch to occur. You can enter a number from 1 to 24.

3 In the Time spin-box, specify the time you want the first prefetch to occur.
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4  You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page on
page 129.)

To configure the prefetch to occur on a daily basis:

1 Click Daily on the Prefetch Schedule page. The Perform every day(s) text
box and Time spin-box appears.

Figure 63: Daily Prefetch Option

—'when To Perform
" ASAP [as soon as possible]
" Once Perform every |_1 dals.
= Houry Time: IWM:‘
& Daiy
 \weekly
 Monthly

< Back I Mext > I Cancel Help

2 Inthe Perform every day(s) text box, specify the daily rate for the prefetch.
You can enter a number anywhere from 1 to 365.

3 Inthe Time spin-box, specify the time you want the prefetch to occur.
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4  You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page on
page 129.)

NOTE &

You can configure prefetch requests on particular days of the week using the Weekly
option.

To configure the prefetch to occur on a weekly basis:

1 Click Weekly on the Prefetch Schedule page. The Perform every week(s)
text box, the Time spin-box, and the Days of Week checkboxes appear.

Figure 64: Weekly Prefetch Option

Piefetch Schedule [ x]
—'when To Parform
i ASAP [as soon as possible]
" Onee Peiform every I 1 weekls)
© Haury Time: [amorw =
= Daily Diapls] of Week:
& Weekly " Man [ Tue W Wed I Thu
= Monthly - L E- R

< Back Cancel Help

2 Inthe Perform every week(s) text box, specify the weekly rate for the
prefetch. You can enter a number anywhere from 1 to 52.

3 In the Time spin-box, specify the time you want the prefetch to occur.

4  Under Day(s) of Week, specify which day(s) of the week you want the prefetch
to occur.
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5 You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page on
page 129.)

To configure the prefetch to occur on a monthly basis:

1 Click Monthly on the Prefetch Schedule page. The Perform every month(s)
text box, the Time spin box, and the Day of Month drop-down list box appear.

Figure 65: Monthly Prefetch Option

—'when To Perform
€ ASAP [as soon as possile)
" Onge Peiform every |_1 manth(z
" Hourly Time: IWM:‘
© Daily Crap of Marth: Iﬂ
" Weskly
& Monthly

< Back Cancel Help

2 In the Perform every month(s) text box, specify the monthly rate for the
prefetch. You can enter a number from 1 to 12.

3 Inthe Time spin-box, specify the time you want the prefetch to occur.

4  In the Day of Month drop-down list box, specify the date for the prefetch to
occur.
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5 You have one of two options:

% Ifyou are configuring an Indirect prefetch, click Finish to complete
configuration of your prefetch. (For further instructions, see Completing
Request Configuration on page 135.)

% Ifyou are configuring a Direct prefetch, click Next. The Prefetch File List
page appears. (For further instructions, see The Prefetch File List Page,
below.)

The Prefetch File List Page

For a new request, the Prefetch File List page will initially be blank because no files
have been selected for prefetch. You can add files to the list by browsing for them or
by loading a file with a list of files in it. Once files have been added, you can delete
files from the list. You can also save the list to a file if you would like to use the list
again later. You can sort the list of added files by media ID and file location by
checking Show list in optimized order.

Figure 66: Prefetch Wizard: Prefetch File List Page

Piefetch File List [ x]
List: 2 files, 15,089 bytes
Hame | S@

Di Shared Stuff 25report. it 12,312 ¢
D Shared Stuff 2vrepart2. it 2777

¥ Show list in optimized order

Add.. Dee | LoadFiomFie.. | SaveToFie.. |

< Back I Finigh I Cancel | Help

NOTE =

Saving this list to a file creates a properly formatted file for an indirect prefetch.
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To add files to the Prefetch File List:
1 Click Add. The Select Files dialog box appears.

Figure 67: Select Files Dialog Box

Lookin: [EN =l @
Name Size Modified Al [~
251 Di<40E mps 0 7/
{71 Di<4ZE wtendedD ] 9/22/93 932 AM
1Data ] 9/22/93 932 AM
1 EcRoot ] 2/16/93 313 PM
1JS Alberci ] 8/31/9310:07 &M
1 dudd ] 8/31/9310:08 &M
1 Mail ] 7/23/931:48 PM
{1 Mailtttachments 0 9/05/33 745 PM
{71 My Documents 1] 9/22/9310:59 AM
*30CR ] 6/23/931:33 PM
{71 PDFFiles ] 9/16/93 427 PM
{1 PDFtest ] 7/27/93 244 PM
{1 PSFiles ] 9/09/93 2:48 PM
71 RuthQuestions 0 4/08/3310:42 AM
73 Sarahiviorking ] 8/24/93 548 PM
1 Sarahhack n n F/71/99 919 Ak LI
1]’ I Cancel | Help |

The Select Files page lists files available on the extended drive on the DX
computer. You can select a new drive from the Look in drop-down list, or use
the Up button to move up one directory level at a time on the current drive.

2 Select the files that you would like to add to the prefetch request and click OK.

If you choose to add an entire folder, a message appears, verifying addition of
subfolders.

Figure 68: Include Subfolder Verification Message

DizkXtender Adminigtrator

& Add filez contained in folder "D=40Bmps" (includes files contained in all sublfolders]?

o |

3 Click Yes to include files in subfolders. If a file you are adding is already
present on the extended drive, a message appears, verifying addition to the list.
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Figure 69: Verify Existing File Dialog Box

¥erify Existing File

The follawing file's data alieady exists on the extended drive [prefetch is not currently necessary] ...

M arne:
Add this file to the prefetch file list anpway?

Yes YesTodl | Mo | MoToal

4  You have the following choices:
%
©

Click Yes to verify adding the specified file.

Click Yes To All to verify adding all files that are already fetched (resident
on the extended drive) without verifying them individually.

% Click No to not add the specified file.

%  Click No To All to not add any of the files that are currently fetched

(resident on the extended drive).

Files are added to the list in the Prefetch File List page in accordance with your
selections.

Figure 70: Prefetch Wizard: File List Page

File List: 181 files, 75,847,036 bytes
File Mamne | File Size
RHOBEG1VAUTORUMN.INF 40

RHOS5G1ACD.ICO
RHOS5G1A\COSETUR EXE
RHOS5G1\CHECKACCHECKER.EXE

1078
8736
200,704

]

HECKER.HLP 11521
055G 1Y HECKER.IMI

RHOSSGIADISKIN_INST1E.EX_

RHOSSG1ADISKIS_INST321.Ex_

05!

260,461
320,704

RHO55G1\0ISK1Y_ISDEL EXE 8132
RHO55E11DISKTY_SETUP.DLL 6128
RHOSSG14DISKTY_ SETUR.LIE 33911
RHOS5G 14DISKTY_SETUP32 LI 333320
RHOS5G 1ADISK1\DATA 1 38471
RHO55E 14DISK1ADISKT D 2
RHOSG 14DISK1NSETLIP BMP 181,060
RHOSG 1ADISKINSETLIP EXE 4508
RHOSEE14DISKISSETUPINI 117
RHOS5G11DISKIASETUP INS 226405
RHO55G1\0ISK1VSE TUP PG 2130
RHO55G11DISKI0:DATA 1D 1453143
RHO55E14DISKIDNDISKI0ID 2
RHOS5G 14DISK11\DATA T 1452503
RHO55E 14DISK11SDISKI1 1D E3E |
Add. Dekete Load Fiom Fie... | SaveToFie.. | Hep |
<Back [ Frish | cancel | Hep |
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Saving a Prefetch File List to a File

You can save the currently displayed file list to a file. The saved file can be used or
edited later for an indirect prefetch request.

To save a prefetch file list to a file:

1 Click the Save As button. The Save As dialog box appears.

Figure 71: Save As Dialog Box

Save As 21|
Save jn: Ia Bin j il F
MewFiles. dup
File name: INEWFHESZ dup Save I
Save as ype: IF'refetch File [*.d=p) j Cancel |

Prefetch files are saved by default to the root of the extended drive. The file list
is saved as a prefetch file ((DXP) by default. You can change the directory by
selecting a different location in the Save As dialog box, and change file type by
using the Save as type drop-down list.

2 Enter the file name for the list you are saving and click Save to return to the File
List page.
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Loading Files to the Prefetch File List From a File

If you have an existing list of files, you can load those files into the file list by
selecting the list file once you have formatted it correctly. For the list import to be
successful, the file must contain a complete, correct directory path for each file to be
added, such as:

\ACCOUNTS\OCTOBER\EXPENSES . XLS

The file should have a single file listing per line (i.e., file listings are separated by
hard returns). Comments can be inserted in the file, but each comment line should be

proceeded by a semi-colon (;).

Figure 72: Example of File for List Creation

Bl NewFiles.dxp - DXPAD |_ (O] x|
File Edit ‘“iew Help

= o 8l

; Agent Computer Name @ W3SEG il

Extender Driwve : D:

Y RHOSEG1Y CDSETUR . EXE
4 RHOS55G1Y CHECEY CCHECEER., EXE
% RHOS55G1Y CHECKY CCHECKER., INI _I

Ready I IS I T 7

To load files to the Prefetch File List from a file:

1 Click the Load From File button. The Open dialog box appears. By default, only
prefetch ((DXP) files are listed.
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Figure 73: Browse for a Prefetch File List

Open [ 71|

Laok jn: IaBiﬂ j il I.ET

File name: INewFl\es dep DOpen I
Files af type: IF'refetch File [*.d=p) j Cancel |

2 Navigate to the file that you want to add and click Open. If you successfully
open a file list, the files from the list appear in the File List page.

Figure 74: Prefetch Wizard: File List Page

File List 181 fles, 75,847,036 bytes
File Mamne | File Size |~
RHOBEG1VAUTORUMN.INF 40
RHOB5G1ACD.ICO 1078
RHOB5G1ACDSETUR.EXE 8736

RHOS5G1\CHECKACCHECKER.EXE 200,704
RHOS5G1A\CHECKACCHECKER. HLP 11521
0556 14CHEL HECKER.IMI H
055G TYDISKIS_INSTIBEX_ 260,461
RHOS5GTADISKIY_INST321.Ex_ 320,704
RHOS5G1ADISK1Y_ISDEL.EXE 8192
RHOS5G1ADISKIY_SETUP.DLL E128
RHOSEG1ADISKIY_SETUP.LIE 98911
RHOS5G1ADISKIY_SETUR3Z.LIE 333320
RHOS5G1ADISKINDATA 98,471
RHOS5G1ADISKIDISKIID 2
RHOSEG1ADISKINSETUR BMP 181,080
RHOSEG1ADISKINSETUR.EXE 44 608
RHOSSGADISKANSETURINI 17
RHOSSGTADISKINSETUR.ING 226405
RHOSSGTADISKIWSETUP. PRG 21,307
RHOSEGTADISKIDWDATA D 1453749
RHOSEG1ADISKI0YDISK101D 2
RHOS5G1ADISKI14DATA T 1452502
RHOS5G1ADISKI14DISK11.1D B3|

Add. Dekete Load Fiom Fie... | SaveToFie.. | Hep |

<Back [ Frish | cancel | Hep |

Deleting Files from the Prefetch File List

You can delete files from the file list after you have added them.
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To delete files from the Prefetch File List:
1  Select the files that you want to delete.

2 Click the Delete button in the File List page. A message appears, prompting you
to confirm deletion of the files.

Figure 75: Delete Items Verification Message

DXADMIN =]

& Delete selected items?
Ho |

3  Click Yes. The selected files are deleted from the list.

Completing Request Configuration

After adding the correct files to the Prefetch File List page of the Prefetch wizard,
you can complete the request configuration.

To complete the request configuration:

< Click Finish. The request appears in the Request List in the Prefetch Manager

dialog box.
Figure 76: Prefetch Manager Dialog Box
i Request List

Owner | Title: | Description | Status | Nest Start Time
L] EGagne Reports Prefetch all reports - PENDING 6/5/00 4:00:00 P
I@EBGagne Logos Retiieve logoim.. PEMDING 6/5/00 4:00.00 Pk

New... | Edit... | Delste | Besubmit | Aot | oo,

ok I Cancel | Help |
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Once a prefetch request appears in the Prefetch Manager request list, and until it is
processed, that request can be edited (using the wizard), deleted, resubmitted, and
aborted using the appropriate buttons in this dialog box. You can also add new
prefetch requests to the request(s) listed in the Prefetch Manager.

NOTE &

Prefetch is a memory intensive procedure. To optimize performance, create several
prefetch requests with smaller file lists instead of one request with a large file list.
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SPACE MANAGEMENT

The idea of using a file migration system to help you manage your data and files is to
also help you manage data storage space. After file data is moved to storage media,
that data can be removed from the local storage space, freeing up that space for
additional files. The key is to maintain as much local storage space as possible while
still making files easily available. So that ultimately your data management system is
also a space management system.

Space management refers to management of the available space on your extended
drive. An extended drive is called such because its storage capacity is “extended” for
use by DISKXTENDER’s file migration services. DISKXTENDER allows you to
“extend” an NTFS-formatted hard drive on a DX computer by moving files to media
for storage while making the files appear to remain on the hard drive.

Those files appear to remain on the hard drive because DX uses a “file tag” to
identify the file after the file data is removed. Removing file data while leaving the
file tag behind is called a purge. The file is still accessible, and to a client
workstation, appears to be saved on the extended drive volume. When the client
requests the file, DX goes to the media where the file is stored and retrieves the file
data, displaying it for the client.

In some instances, you may also want to delete files completely when they are no
longer of use. DISKXTENDER allows you to set up delete rules for files that set
specific criteria for what files are to be deleted from both the extended drive and the
storage media.
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The extended drive, media folders, move groups and move rules, their creation and
management are what enable and automate file migration in your data management
system. The purge rules (and the purge after move setting in move rules), and delete
rules are what enable and automate space management within your data management
system. This chapter, devoted to a discussion on managing the space on your
extended drive, discusses creation, configuration, and management of purge rules
and delete rules in DX.

For details on the creation of extended drives and media folders, and creation and
management of move groups and move rules, see Chapter Two: Setting Up File
Migration on page 31.

We recommend that you periodically back up your extended drives in order to
preserve any data that has not yet been migrated to media, and in the event files
deleted from your DX system in error need to be recovered. See the Extended Drive
Administration chapter of the DX2000 System Guide for more information on
scheduling regular extended drive backups.

PURGING DISKXTENDER FILES

Once files have been moved to media, they can be purged from the extended drive,
creating more space for new files. When files are purged, the data in the file is
removed from the extended drive and a “file tag” is left behind. The “file tag”
contains information about the file including name, size, age and other attributes. It
is this tag that allows purged files to appear to remain on the extended drive volume,
making them accessible to clients.

When a client requests a purged file, DX goes to the media where the file is stored,
and retrieves the file data, displaying it for the client. Depending on the type of
storage media you are using, this retrieval (called a fetch) could take up to several
minutes, particularly if there are several other fetches processing, and available
media drives are already in use.

Because space and file retrieval requirements vary, DISKXTENDER provides several
different ways to purge files from the extended drive. In addition, DX allows you to
be very specific as to when files are purged from the extended drive; either as files
qualify for purging, or only when used extended drive space reaches a specified level
or “watermark.”
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PURGE LIST

The Purge List is a listing of files on the extended drive, which based on configured
purge rules, are due to be purged. It is this list that tells DISKXTENDER what files
need to be purged.

Files are written to the purge list in two ways:

% As soon as a file is moved to media, DX checks to see if it qualifies for a
configured purge rule. If it does, the file is written to the purge list.

%  During an extended drive scan, DX checks all extended drive files (that have
previously been moved to media) to see which ones qualify for configured purge
rules. This captures all files that qualify for a purge rule with an age
specification (also called time-delay or age-delay). When a file qualifies for a
purge rule after a specified time-delay, the file is written to the purge list during
the next drive scan.

When the purge list is processed, the files written to it are purged from the extended
drive. By default, the purge list will begin to be processed when the purge start
watermark is reached. The purge start watermark is simply an identification of how
much space on the extended drive must be filled (in percentage) before files will be
purged. The default is 95 percent.

The processing of the purge list (purging of files) will continue until the purge stop
watermark is reached. The purge stop watermark is simply an identification of how
much space on the extended drive must be filled (in percentage) before processing of
the purge list will stop. The default is 90 percent.

The percentage of extended drive space between the purge start and the purge stop
watermarks is how much space must be reclaimed for use by purging files from the
extended drive through processing the purge list.

The purge start and purge stop watermarks are configured through the extended drive
Properties using the Options tab. For more information on configuring extended
drive options, see the Extended Drive Administration chapter of the DX2000 System
Guide.
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WHEN TO PURGE FILES

Files cannot be purged from the extended drive until they are moved to media.
However, once a file is moved to media, you can choose whether to purge that file
from the extended drive immediately, or wait until a specified period of time has
passed, or purge the file when extended drive space is low, or choose not to purge
the file at all, leaving the file data on the extended drive.

Which option you choose is likely determined by a number of factors, including the
type of storage media you are using, how much space you have on your extended
drive and how often files are normally accessed. For example, if you are using NAS
as your storage media, you may want to purge all files as soon as they have been
moved because file retrieval from NAS is much faster than with other types of
media. Or, if you only want to remove infrequently used files, you may decide to
purge files only after a certain number of days have passed since they were last
accessed.

In addition, if you disabled certain time periods on the Allow fetches from media
schedule to create a time-based restriction of access to purged files, you may want to
take that into consideration when determining when to purge files. Purge rules can
be used to purge files based on the age of the file. That capability, in combination
with one or more of the purge options described below, allows you to maintain
necessary extended drive space, while still allowing client access to needed files,
regardless of media access restrictions.

Purge Immediately After Move (Move Rule Option)

The option to purge files immediately after they have been moved to media is
configured in move rules as opposed to purge rules. This is because the attribute that
qualifies the file to be purged is that it was moved to media with no other qualifier
necessary.

When the Purge file immediately after move option is enabled in a move rule, the
files that qualify for the move rule are moved to media and their data is immediately
purged. They are never written to the purge list. Purging files in this way allows you
to maintain a high volume of free space on your extended drive and is particularly
useful if your storage media allows for fast retrieval of files upon client request.

Purging files immediately after they are moved to media and then setting up prefetch
requests for frequently used files allows you to manage very specifically what file
data is resident on the extended drive and when. Using these two options in
conjunction with one another gives you a great deal of control over your extended
drive space. For information on configuring the Purge files immediately after move
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option for your move rules, and for instructions on using the Prefetch Manager, see
Using The Prefetch Manager on page 120.

Purge During Drive Scans (Purge Rule Option)

Setting up purge rules allows you to specify what files will be purged from the
extended drive and when. One of the options for your purge rules allows you to set
up DX to purge files that qualify for the purge rule during the next drive scan rather
than when the used extended drive space reaches the purge start watermark.

When a file is moved to media, DX checks to see if it qualifies for a purge rule. If it
does, that file is written to the purge list. When the next extended drive scan is run
(either scheduled or forced), all files qualifying for purge under a purge rule with the
Purge files during extended drive scans option enabled are purged from the extended
drive.

Using this option in conjunction with regularly scheduled extended drive scans helps
maintain a high volume of free space on your extended drive. For information on
configuring your extended drive scan schedule, see the Extended Drive
Administration chapter of the DX2000 System Guide.

Purge As Disk Space Needed (Purge Rule Option)

Because setting up purge rules is designed to make sure there is always a useful
amount of space on the extended drive for new files, the default setup for purging
files is to do so only when the free space on the extended drive reaches a critical
level.

When a file is moved to media, DX checks to see if it qualifies for a purge rule. If it
does, that file is written to the purge list. Unless otherwise specified, the files written
to the purge list are not purged from the extended drive until the drive’s used space
reaches the purge start watermark, as configured in the extended drive properties. In
addition, the purge list is only processed (listed files purged) until the purge stop
watermark is reached (also configured through the extended drive properties).

The Purge files matching as disk space is needed option for the purge rules also
allows you to set up a priority system for purging qualified files. Purging files in this
way assures that file data will remain on the extended drive until purging them to
recover space on the extended drive is absolutely necessary. This method is
recommended if you are using a type of storage media that does not allow for fast
retrieval of files.
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Move Without Purge (Files Never Purged)

It is not necessary to purge files from your extended drive. However, files moved to
media remain resident on the extended drive if they are not purged. Files then use up
twice as much space as is necessary, as the files are now saved on both the extended
drive and the media. Filling up extended drive space to capacity could also cause
problems if extended drive space is required to run a DX function such as
compaction.

Setting up file migration without purging files may be useful if you are only using
your DX system for file backup or extended drive mirroring. However, if you are
using DX as a tool to manage files and file space, we recommend purging files at a
point that makes the most sense for proper maintenance of your DX system.

PURGE RULES

DX allows you to configure purge rules to reclaim space on the extended drive by
truncating DX files after those files have been moved to media.

Purge rules control when file data from moved files is purged from the hard drive.
Purge rules are designed to allow you to configure, very specifically, what files in a
media folder will have their file data removed from the extended drive. You can
configure file purging based on file age, file extension, file attributes and file size.

When a file’s data is purged by DISKXTENDER, it is removed from the extended drive
and exists only on media. A file “tag” is left on the drive, which makes the file
appear to be present on the drive and points to the file data on the media.

When a user opens a file tag, DX automatically retrieves the file data from media
and either restores it to the extended drive (called a fetch) or reads the file data
directly from media (called a direct read). To the user, the data retrieval from media
is seamless, but may take slightly longer than it would if the file data was on the
drive. You may want to keep the file data on the extended drive for files frequently
accessed by clients, to speed file access. You could also schedule a prefetch to
retrieve frequently used files after they have been purged. For instructions on
scheduling prefetch requests, see Using The Prefetch Manager on page 120.

The purge list for each extended drive is constructed by DX based on the purge rules
you create. The contents of the purge list dictates what files are truncated. When the
purge watermarks for the extended drive are reached, the purge list is processed and
files are truncated to free space on the drive and prevent the drive from overfilling.

If the file qualifies for purge under a purge rule that does not have a file age
exclusion or time delay specified, DX immediately adds the file to the purge list after
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the file is moved to media. If the file qualifies for purge under a purge rule that does
have a file age exclusion or time delay specified, DX adds the file to the purge list
during the first extended drive scan after the time delay has expired.

NOTE =

DX does not attempt to qualify files for purge until they have been moved to media.
Therefore, only files that have been moved to media can be purged using purge rules.

NOTE =

Both forced and scheduled Drive Scans write time-delayed files to the purge list, and
you may force an extended drive scan whenever necessary. However, to ensure that
all qualified files are purged from the extended drive when appropriate, we
recommend you set up a regular drive scan schedule for each extended drive.

CREATING PURGE RULES

Creating purge rules is done through a wizard. The Purge Rule Wizard leads you
through the step-by-step process of creating and configuring a purge rule. Several
pages of the wizard lead you through the purge rule properties. This allows you to
configure your purge rule properties at the time you create the purge rule. You can
also access and change these configurations later.

For clarity and speed, the following procedures for creating purge rules do not cover
these configurations in detail. For a discussion of each of the Purge Rule Properties
pages, see Purge Rule Properties on page 151. This section immediately follows the
instructions for creating your purge rules.

NOTE =

Only files that have been moved to media can be purged from the extended drive.
Files that qualify for the purge rule but that have not been migrated to media will not
be purged.

APPLICATION STORAGE MANAGER 143
Data Management Guide



Chapter Four: Space Management

Starting the Purge Rule Wizard

This section describes how to start the purge rule wizard and briefly describes how to
configure the File Name page.

To start the purge rule wizard:

1

Right-click the Purge Rules node under the appropriate media folder and select
New from the shortcut menu. The purge rule wizard appears, starting with the
File Name page.

Figure 77: File Name Page

File Name E

 File Selection Criteria

Folder:

I Include subfolders Browse... |

File Hame:

< Back I Mest > I Cancel | Help |

The File Name page allows you to define the location and extension for the files
to be purged.

Select the Folder containing the files for which you want to configure this purge
rule. The active media folder is listed by default. To select a subfolder of the
media folder, click Browse. The Select Folder window appears.
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Figure 78: Select Folder Window

Select Folder [ %]
Lok in: I@I E:\Media_1_Imagesh j
Name | size | Modified | Attributes |
{271 Bitmaps 0 B/3/0012:32 PM

ak. I Cancel | Help |

3 Select the subfolder to use for the purge rule and click OK. The file path appears
in the Folder box of the File Name page.

Figure 79: File Name Page

File Hame [ %]
 File Selection Criteria
Fuolder:
I “WWedia_1_lmageshBitmaps' j

¥ Includs subfolders

File Hame:

< Back Mest > Cancel Help
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NOTE =

You cannot include more than one subfolder of the media folder in a single
purge rule. You can include either one or all subfolders only. To purge files in a
different subfolder, create a second purge rule.

Enable or disable the option to include all subfolders in the folder listed in the
Folder text box.

In the File Name text box, enter the file specification to determine which files
are to be purged using this purge rule. For example, entering * . DOC will apply
this purge rule to all files in the specified media folder with a DOC extension.

NOTE &

Only one specified file extension can be configured per purge rule. To purge
files of different specified extensions in the same folder, create a second purge
rule. For more information on using wildcards to designate specific file names
for purge, see The File Name Tab on page 152.

Click Next. The Size Page appears.

Configuring the Purge Rule Wizard Size Page

The Size page allows you to choose to purge all files in the path or configure a
specific size range for the files affected by the purge rule.

Figure 80: Size Page

Size E

~File Size

" Purge files of any size
% Exclude files with the follawing sizes:
V' Exclude files smaller than: |5 KB

¥ Exclude files larger than: 200 KB

Cancel Help
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To continue the purge rule wizard:
1  You have the following choices:
%  To purge files of all sizes, select Purge files of any size.

% To configure a file size range for exclusion from the purge rule, select the
Exclude files with the following sizes option, enable the appropriate
checkboxes, and enter the sizes as appropriate.

2 Click Next. The Attributes page appears.

Configuring the Purge Rule Wizard Attributes Page

The Attributes page allows you to select to only purge files with the specified
attributes.

Figure 81: Attributes Page

 File Attribute:

' Purge files with arw attribute
% Exclude files with the follawing file attributes:

V Beadonly [ Achive [ Compressed
™ Hidden ¥ System

Cancel Help

To continue the purge rule wizard:
1  You have the following choices:
%  To purge files regardless of attribute, select Purge files with any attribute.

%  To exclude files with particular attributes, select Exclude files with the
following file attributes and then enable the options for the attributes for
files that should not be purged.
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WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file purge. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

2 Click Next. The Age page appears.

Configuring the Purge Rule Wizard Age Page

The Age page allows you to purge files of any age or exclude files of a particular
age.

Figure 82: Age Page

Age [ %]

—File Age

" Purge files of any age

% Exclude files with an age less than:
Dayz: ISD
Since: Im

< Back Cancel Help

To continue the purge rule wizard:
1  You have the following choices:
%  To purge files regardless of age, select Purge files with any age.

% To exclude files within a particular age range, enable the Exclude files with
an age less than option and then enter the number of days that must elapse
before a file is purged. Set the date from which that file age is calculated by
selecting one of the following options from the Since drop-down list: Create
time, Last write time, Last access time.

2 Click Next. The Settings page appears.
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Configuring the Purge Rule Wizard Settings Page

The Settings page allows you to specify parameters for when files are purged.

Figure 83: Settings Page

Seltings [ %]
— Purge Option:

& Purge files matching this rule as disk space is needed

Pricrity: I First hd l

' Purge files matching this iule during extended drive scans

< Back I Mest > I Cancel Help

To continue the purge rule wizard:
1  You have the following choices:

%  To purge files only when space is needed, select Purge files matching this
rule as disk space is needed and choose the priority for purge of the files
covered by the rule.

%  To configure the rule to purge files as soon as DISKXTENDER finds them
during a drive scan, select Purge files matching this rule during extended
drive scans.

2 Click Next. The Summary Page appears.
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Completing the Purge Rule Wizard

The Summary page allows you to review the information that you have provided. If
necessary, you can click Back to make a change on a previous page.

Figure 84: Summary Page

=
Action list: m

Mews rule details:

1] Create new purge rule for specified file name
2] Set purge policies to specified settings

File name: ‘Media_1_lmagesh.*

Subfolders: es

Minimum size: 5KB

I awimum size: 800 KB

Inciude subdirs: ‘ex

Minimumn age: 30 days

Age from; Last write time:

Purge on diive scan: Mo

Priciity: First -

Exclude attributes: RS -
] _>I_I

< Back Cancel | Help

To complete the purge rule wizard:

< Review the information you have provided through the Purge Rule wizard. If the
information in the Summary is correct, click Finish. The purge rule is created
and appears under the Purge Rules node of the media folder on the extended

drives tree.
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MANAGING PURGE RULES

You can open the properties for purge rules you have already configured and adjust
those properties. Purge rules control what files on the extended drive get purged. The
path where the files are located is specified, as well as file parameters delimiting
which files within the path are affected by the rule. The file parameters available to
select files for purging include file extension, file attributes, and file size. You can
also control when files are added to the purge list.

NOTE =

Only files that have been moved to media can be purged from the extended drive.
Files that qualify for the purge rule but that have not been migrated to media will not
be purged until the file is moved.

PURGE RULE PROPERTIES

The Purge Rule Properties dialog box contains six tabs: File Name, Size, Attributes,
Age, Settings and Statistics. All but the Statistics tab correspond to pages in the
Purge Rule Wizard and contain the purge rule properties configured when you
created the purge rule.

Accessing the Purge Rule Properties and selecting each of the tabs allows you to
view and change the settings established when the purge rule was created. You can
change the rule name, change or disable the file size specifications, change or disable
the exclusion of files based on file attributes, change or disable the age (time delay)
specifications for purging files and select whether to purge files when they qualify
for purge or to purge qualifying files only when extended drive disk space is needed.

The following sections discuss each of the tabs and their available options.
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To access the purge rule properties:

< Right-click the purge rule whose properties you want to view, and select
Properties from the shortcut menu. The Purge Rule Properties dialog box
appears with the File Name Tab active by default.

Figure 85: Purge Rule Properties Dialog Box

Purge Rule Properties [ %]

File Mame | Size I Attributesl Age I Settingsl Statisticsl

 File Selection Criteria

FEolder:

I \Media_1_lmagesh j
v Include subfolders Browse... |
File Mame:

Cancel | Lpply | Help |

As with most Properties functions in DISKXTENDER, after making changes you
have three options:

% To save changes and close the Properties dialog box, click OK.
% To save changes and keep the Properties dialog box open, click Apply.

% To discard all changes made since the Properties dialog box was opened
and close the Properties dialog box, click Cancel.

The File Name Tab

The File Name tab is the tab that first appears when you open the Purge Rule
Properties dialog box. The File Name tab allows you to view and change the folder
and file name specifications for the purge rule.
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To view the file name tab:

< Click the File Name tab in the Purge Rule Properties dialog box. The File Name
tab appears.

Figure 86: Purge Rule Properties: File Name Tab

Purge Rule Properties [ %]

File Mame | Size I Attributesl Age I Settingsl Statisticsl

 File Selection Criteria

FEolder:

I \Media_1_lmagesh j
v Include subfolders Browse... |
File Mame:

Cancel | Lpply | Help |

The Folder text box allows you to change the location of files to which the purge rule
will be applied. You have the following choices:

% To apply the purge rule to files in a different folder, select the folder/path from
the Folder drop-down list. To select a specific subfolder within the active media
folder, click Browse.

% Enable or disable the Include subfolders option. If enabled, all files in the
specified folder, and all subfolders and their files will be subject to the purge
rule. If disabled, only the files in the specified directory will be subject to the
purge rule.

NOTE =

You cannot include more than one select subfolder of the media folder in a single
purge rule. You can include either one or all subfolders only. To purge files in a
different subfolder, create a second purge rule.

In order to change to which files in the specified location the purge rule will be

applied, you can use the standard windows asterisk (*) wildcard to select only files
with specific extensions or naming conventions for purging. The asterisk represents
one or more characters in the name or extension part of the file name. For example:

% To apply the purge rule to all files in the directory, type * . * in the File Name
text box.
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G

To apply the purge rule to only files of a particular type, type in an asterisk
before the period and the appropriate file extension after the period. For
example, to purge only bitmaps, type * . BMP in the File Name text box.

To apply the purge rule to files with a certain naming convention use the asterisk
as part of the file name. For example, to purge only files indicated as reports,
type *REPORT . * or *REPORT* . * in the file name text box.

To use the wildcard to specify only files of a certain type with a specific naming
convention, use the asterisk in the name part of the file name while specifying
the file extension. For example, to purge only text files indicated as reports, type
*REPORT* . TXT in the file name text box.

NOTE &

Only one file name specification can be configured per purge rule. To purge files of
a different specification in the same folder, create a second purge rule.

The Size Tab

The Size tab allows you to view and change the file size qualifications for the purge
rule.

To view the size tab:

9 Click the Size tab in the Purge Rule Properties dialog box. The Size tab appears.

Figure 87: Purge Rule Properties: Size Tab

Purge Rule Properties E

File Mame Size |Attributes| Age I Settingsl Statisticsl

File Size

" Purge files of any size

¢ Exciude files with the following sizesi
¥ Exclude files smaller than: |5 KB
¥ Exclude files larger than: ISUU KB

(1] I Cancel | Aol | Help |

To purge files of all sizes, select Purge files of any size. This is the default.
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To only purge files of a specified size range, select the Exclude files with the
following sizes. You have the following options:

% Enable the Exclude files smaller than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must match or exceed in order to be
purged from the extended drive.

% Enable the Exclude files larger than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must be equal to or smaller than in
order to be purged from the extended drive.

If both options are enabled, only files whose size falls in between the kilobyte
specifications will be subjected to the purge rule. Files whose size falls outside
of the range set by both options will never qualify for purging from the extended
drive under this purge rule.

The Attributes Tab
The Attributes tab allows you to view and change the specific file attribute

qualifications for the purge rule.

To view the attributes tab:

1  Click the Attributes tab in the Purge Rule Properties dialog box. The Attributes
tab appears.

Figure 88: Purge Rule Properties: Attributes Tab

Purge Rule Properties E

File Namel Size  Altributes |Age I Settingsl Statisticsl

— File Attribute:

" Purge files with any attribute

¢ {Exciude files with the following file attributes:

W Fead-orly [ fwchive [ Compressed
™ Hidden V' System

ak. I Cancel Aol Help
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2 You have the following choices:

%  To purge files with any attributes, select Purge files with any attribute. This
is the default.

%  To exclude files with certain attributes from being purged from the
extended drive, select Exclude files with the following attributes. Then click
a check in the boxes corresponding to the attributes that will disqualify a
file from being purged from the extended drive.

WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file purge. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

The Age Tab

The Age Tab allows you to configure a time delay for the purging of files from the
extended drive.

If there is no age specification configured for the purge rule, all files that have been
moved to media and that otherwise qualify for purge under this purge rule will be
written to the purge list.

If an age specification is configured for the purge rule, all files that have been moved
to media and that otherwise qualify for purge under this purge rule will be written to
the purge list when the entered number of days has elapsed since the selected file
action, and the next drive scan is run.

156 APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Four: Space Management

To view the age tab:

< Click the Age tab in the Purge Rule Properties dialog box. The Age tab appears.

Figure 89: Purge Rule Properties: Age Tab

Purge Rule Properties [ %]

File Namel Size I Aftributes  &ge |Settings| Statisticsl
—File Age

" Purge files of any age

& Exclude files with an age less than:
Days: |3U
Since: ILast wirite time: = l

ok I Cancel | Lpply | Help |

If you want to purge files regardless of age, select Purge files with any age. This
is the default.

To exclude files from being purged from the extended drive until a certain
number of days have passed since a specific file action, enable the Exclude files
with an age less than option. Then configure the following options:

% In the Days text box type in the number of days you want to elapse from the
file action trigger before the file is purged.

%  Select the appropriate file action trigger from the Since drop-down box:
Create time, Last access time or Last write time.

The Settings Tab

The Settings tab allows you to determine when the files qualifying for purge under
this purge rule are actually purged from the extended drive. You can configure DX to
purge these files immediately upon being added to the purge list during an extended
drive scan, or you can select to purge these files only as disk space is needed on the
extended drive.

To view the settings tab:

1  Click the Settings tab in the Purge Rule Properties dialog box. The Settings tab
appears.
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Figure 90: Purge Rule Properties: Settings Tab

Purge Rule Properties [ %]

File Namel Size I Attributesl Age  Settings |Statistics|

— Purge Option:

% Purge files matching this rule as disk space is needed

Ericrity: I First - l

' Purge files matching this rule during extended drive scans

ok I Cancel Lpply Help

2 You have two options:

% Ifyou select the Purge files matching this rule as disk space is needed
option, files that qualify for this purge rule will be written to the purge list
when they qualify, but will not be purged from the extended drive until the
extended drive used space watermark is reached. At that time, the purge list
is processed and files are purged from the extended drive. This is the
default.

% If you select the Purge files matching this rule during extended drive scans
option, files written to the purge list during an extended drive scan by
qualifying for this purge rule, are purged immediately.

Extended drive scans (both scheduled and forced) write qualifying files with an age-
delay configured to the purge lists. In order to see that files are written to both move
and purge lists as appropriate, we recommend setting a regular extended drive scan
schedule. In addition, the watermark for determining when to process the purge file
list to free up needed disk space is configured through the Extended Drive Properties
dialog box, using the Options tab. For more information on extended drive options
and extended drive scan scheduling, see the Extended Drive Administration chapter
of the DX2000 System Guide.
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The Statistics Tab

The Statistics tab provides pending file purge statistics from the most recent drive
scan. The statistics shown pertain only to the files selected for purge by qualifying
for this purge rule, and are valid only until the next extended drive scan.

To view the statistics tab:

9 Click the Statistics tab in the Purge Rule Properties dialog box. The Statistics tab
appears.

Figure 91: Purge Rule Properties: Statistics Tab

Purge Rule Properties E

File Namel Size I Attributesl Age I Settings

Pending Purge
Total Files: 1]
Total Bytes: 1]

(1] I Cancel | Aol | Help

The items shown on the Statistics tab are as follows:

Table 18: Statistics Tab: Pending Purge Information

ITEM: DESCRIPTION:

Total Files The number of files that at the time of the last drive
scan qualified for purging from the extended drive
using this purge rule.

Total Bytes The total size, in bytes, of all files that at the time of
the last drive scan qualified for purging from the
extended drive using this purge rule.
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DELETING A PURGE RULE

A purge rule can easily be deleted from the media folder. Deleting a purge rule
deletes all configured options for that purge rule.

To delete a purge rule:

1 Right-click the purge rule that you want to delete and select Delete from the
shortcut menu.

2 A message appears, prompting you to verify the deletion. Click Yes.

The purge rule is deleted and no longer appears in the Purge Rule node for that
media folder in the extended drive tree.

DELETE RULES

In certain situations, you may not want to keep files after a certain period of time,
even on storage media. You can use delete rules to automatically delete files from
both the extended drive and from storage media. When a file becomes eligible for
deletion under a delete rule, it is deleted from the extended drive by DX and marked
for deletion on the media. The file may still exist on a piece of media, but it becomes
an “orphaned” file and is no longer recognized or tracked by DX.

When the storage media that the file was moved to (and then deleted from) is
compacted, DX does not copy deleted files from the original piece of media back to
the extended drive. Files on compacted media are actually deleted when the
compacted media is reformatted. While it may be possible to recover deleted files
from storage media, we do not support this recovery and recommend you use
extreme caution if using delete rules to delete files on a regular basis.

Since files qualifying for deletion are not deleted until the media is compacted and
reformatted, you may wish to set up the secure file delete option for your extended
drive. The Use secure file delete option can be found in the Extended Drive
Properties dialog box on the Options tab. When a file is deleted and the Use secure
file delete option is enabled, the file is actually overwritten with bogus data, so that
the original file cannot be recovered, even if the media is never reformatted. For
more information on setting up your extended drive properties, see the Extended
Drive Administration chapter of the DX2000 System Guide.
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WARNING é*

It is important to note that DX does not keep copies of deleted files anywhere in the
DX system. To simply clear space on the extended drive, but retain file data on
storage media, use purge rules rather than delete rules.

CREATING DELETE RULES

Creating delete rules is done through a wizard. The Delete Rule Wizard leads you
through the step-by-step process of creating and configuring a delete rule. Several
pages of the wizard lead you through the delete rule properties. This allows you to
configure your delete rule properties at the time you create the delete rule. You can
also access and change these configurations later.

For clarity and speed, the following procedures for creating delete rules do not cover
these configurations in detail. For a discussion of each of the Delete Rule Properties

pages, see Delete Rule Properties on page 169. This section immediately follows the
instructions for creating your delete rules.

Starting the Delete Rule Wizard

This section describes how to start the delete rule wizard and briefly describes how
to configure the File Name page.

To start the delete rule wizard:

1 Right-click the Delete Rules node under the appropriate media folder and select
New from the shortcut menu. A verification message appears.

Figure 92: Create Delete Rule Verification Message

DizskXtender Administrator [ <]

& Delete rules are automatic policies that will permanently delete files from your spstenm.

Are you sure you want to continue?

|

2 Click Yes to continue. The Delete Rule Wizard opens, starting with the File
Name page.
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Figure 93: File Name Page

ﬂ

— File Selection Criteria
Folder.

¥ Inciude subfalders Browse... |

™ Inglude files that have not been migrated

File M ame:

< Back I Mest » I Cancel | Help |

The File Name page allows you to define the location and extension for the files
to be deleted. You can also select to Include subfolders and Include files that
have not been migrated. Unlike the corresponding page in the move and purge
rule wizards, the File Name textbox is empty and requires you to enter
information before moving on with the wizard.

WARNING é*

If you check the Include files that have not been migrated option, DX will
attempt to qualify all files in the media folder against the delete rule(s),
regardless of whether the files have been moved to media or not.

Select the Folder containing the files for which you want to configure this delete
rule. The active media folder is listed by default. To select a subfolder of the
media folder, click Browse. The Select Folder dialog box appears.
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Figure 94: Select Folder Dialog Box

Select Folder [ %]
Lok in: I@ E:\Media_1_Imagesh j
Name | size | Modified | Attributes |
{271 Bitmaps 0 B/3/0012:32 PM

ak. I Cancel | Help |

4  Select the subfolder to use for the delete rule and click OK. The file path appears
in the Folder box of the File Name page.

Figure 95: File Name Page

x

— File Selection Criteria
Folder.

¥ Include subfalders Browse. . |

™ Inglude files that have not been migrated

File M ame:

< Back I Mext » I Cancel Help
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NOTE =

You cannot include more than one subfolder of the media folder in a single
delete rule. You can include either one or all subfolders only. To delete files in a
different subfolder, create a second delete rule.

Enable or disable the option to include all subfolders in the folder listed in the
Folder text box.

Enable or disable the option to include files that have not been migrated for
qualification against the delete rule.

In the File Name text box, enter the file specification to determine which files
are to be deleted using this delete rule. For example, entering * . DOC will apply
this delete rule to all files in the specified media folder with a DOC extension.

NOTE &

Only one specified file extension can be configured per delete rule. To delete
files with a different specified extension in the same folder, create a second
delete rule. For more information on using wildcards to designate specific file
names for delete, see The File Name Tab on page 170.

Click Next. The Size Page appears.
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Configuring the Delete Rule Wizard Size Page

The Size page allows you to choose to delete all files in the folder or configure a
specific size range for the files affected by the delete rule.

Figure 96: Size Page

— File Size

" Delete files of any size
& Exclude files with the following sizes:
V' Exclude files smaller than: |5 KB

¥ Exclude files larger thare  |500 KB

< Back Cancel Help

To continue the delete rule wizard:
1  You have the following choices:
%  To delete files of all sizes, select Delete files of any size.

%  To configure a file size range for exclusion from the delete rule, select the
Exclude files with the following sizes option, enable the appropriate
checkboxes, and enter the sizes as appropriate.

2 Click Next. The Attributes page appears.
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Configuring the Delete Rule Wizard Attributes Page

The Attributes page allows you to select to only delete files with the specified
attributes.

Figure 97: Attributes Page

— File Attribuite:

' Delete files with any attibute
& Exclude filss with the following file attributes:

W Beadorly W fwchive [T Compressed
™ Hidden ¥ System

< Back Cancel Help

To continue the delete rule wizard:
1  You have the following choices:
% To delete files regardless of attributes, select Delete files with any attribute.

%  To exclude files with particular attributes, select Exclude files with the
following file attributes, and then enable the options for the attributes for
files that should not be deleted.

WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file delete. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

2 Click Next. The Age page appears.
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Configuring the Delete Rule Wizard Age Page

The Age page allows you to delete files of any age or exclude files of a particular
age.

Figure 98: Age Page

Age E

—File Age

" Delete files of any age

& Exclude files with an age less than:

Days: IBU
Since: ILast acoess time 'l

< Back Cancel Help

To continue the delete rule wizard:
1  You have the following choices:
% To delete files regardless of age, select Delete files with any age.

% To exclude files within a particular age range, enable the Exclude files with
an age less than option and then enter the number of days that must elapse
before a file is deleted. Set the date from which that file age is calculated by
selecting one of the following options from the Since drop-down list: Create
time, Last write time, Last access time.

2 Click Next. The Summary Page appears.
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Completing the Delete Rule Wizard

The Summary page allows you to review the information that you have provided. If
necessary, you can click Back to make a change on a previous page.

Figure 99: Summary Page

Action list:
1] Create new delete rule for specified file name
2] Set delete policies to specified seftings
Mews rule details:
File name: ‘Media_1_lmagesh.*
Subfolders: es
Minimum size: 5KB
I awimum size: 800 KB
Inciude subdirs: ‘ex
Minimumn age: B0 days
Age from; Last access time
Exclude attributes: RSA
] _>I_I
< Back Cancel | Help |

To continue the delete rule wizard:

2 Review the information you have provided through the wizard. If the
information in the Summary is correct, click Finish. The delete rule is created
and appears under the Delete Rules node of the media folder in the extended
drive tree.

MANAGING DELETE RULES

You can open the properties for an existing delete rule and modify the settings for
that rule. Delete rules control what files in the media folder(s) on the extended drive
are deleted. The path where the files are located is specified, as well as file
parameters delimiting which files within the path are affected by the rule. You can
set file parameters to select files including the file extension, file attributes, and file
size. You can also configure a time delay for files, allowing them to be deleted only
after a certain specified time period has elapsed since file creation, last file access, or
last file write.

In the Extended Drives tree, each delete rule is listed under the Delete Rules node of
each media folder and is represented by a skull and crossbones icon.
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DELETE RULE PROPERTIES

The Delete Rule Properties dialog box contains four tabs: File Name, Size,
Attributes, and Age. Each of the properties tabs corresponds to pages in the Delete
Rule Wizard and contains the delete rule properties configured when you created the
delete rule.

Accessing the Delete Rule Properties and selecting each of the tabs allows you to
view and change the settings established when the delete rule was created. You can
change the rule name, change or disable the file size specifications, change or disable
the exclusion of files based on file attributes, and change or disable the age (time
delay) specifications for deleting files.

The following sections discuss each of the tabs and their available options.

To access the delete rule properties:

1 Right-click the delete rule whose properties you want to view and select
Properties from the shortcut menu. The Delete Rule Properties dialog box
appears with the File Name Tab active by default.

2 As with most Properties functions in DISKXTENDER, after making changes you
have three options:

% To save changes and close the Properties dialog box, click OK.
% To save changes and keep the Properties dialog box open, click Apply.

% To discard all changes made since the Properties dialog box was opened
and close the Properties dialog box, click Cancel.
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The File Name Tab

The File Name tab is the tab that first appears when you open the Delete Rule
Properties dialog box. The File Name tab allows you to view and change the folder
and file name specifications for the delete rule.

To view the file name tab:

=

Click the File Name tab in the Delete Rule Properties dialog box. The File Name
tab appears.

Figure 100: Delete Rule Properties: File Name Tab

Delete Rule Properties =l

File: Name | Size I Attlibutesl Age I

r File Selection Criteria
Folder:
| 4Hew Media =

Browse... |

™ Inglude files that have not been migrated

File Mame:

ok I Cancel | Apply | Help |

The Folder text box allows you to change the location of files to which the delete
group will be applied. You have the following choices:

G

To apply the delete rule to files in a different folder, select the folder/path from
the Folder drop-down list. To select a specific subfolder within the active media
folder, click Browse.

Enable or disable the Include subfolders option. If enabled, all files in the
specified folder and all subfolders and their files will be subject to the delete
rule. If disabled, only the files in the specified directory will be subject to the
delete rule.

Enable or disable the Include files that have not been migrated option. If
enabled, all files in the specified folder will be subject to the delete rule. If
disabled, only the files in the specified folder that have been migrated (moved to
media) will be subject to the delete rule.
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NOTE =

You cannot include more than one select subfolder of the media folder in a single
delete rule. You can include either one or all subfolders only. To delete files in a
different subfolder, create a second delete rule.

In order to change to which files in the specified location the delete rule will be
applied, you can use the standard windows asterisk (*) wildcard to select only files
with specific extensions or naming conventions for delete. The asterisk represents
one or more characters in the name or extension part of the file name. For example:

% To apply the delete rule to all files in the directory, type * . * in the File Name
text box.

% To apply the delete rule to only files of a particular type, type in an asterisk
before the period and the appropriate file extension after the period. For
example, to delete only bitmaps, type *.BMP in the File Name text box.

% To apply the delete rule to files with a certain naming convention use the
asterisk as part of the file name. For example, to delete only files indicated as
reports, type *REPORT . * or *REPORT* . * in the file name text box.

%  To use the wildcard to specify only files of a certain type with a specific naming
convention, use the asterisk in the name part of the file name while specifying
the file extension. For example, to delete only text files indicated as reports, type
*REPORT* . TXT in the file name text box.

NOTE =

Only one file name specification can be configured per delete rule. To delete files of
a different specification in the same folder, create a second delete rule.
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The Size Tab

The Size tab allows you to view and change the file size qualifications for the delete
rule.

To view the size tab:

9 Click the Size tab in the Delete Rule Properties dialog box. The Size tab
appears.

Figure 101: Delete Rule Properties: Size Tab

Delete Rule Properties E

File Mame Size |Attributes| Age I
~File Size

" Delete files of any size

¢ Exciude files with the following sizesi

¥ Exclude files smaller than: |5 B

¥ Excluds files larger than: ISUU KE

(1] I Cancel | Aol | Help |

To delete files of all sizes, select Delete files of any size. This is the default.

To only delete files of a specified size range, select the Exclude files with the
following sizes. You have the following options:

% Enable the Exclude files smaller than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must match or exceed in order to be
deleted.

% Enable the Exclude files larger than _ KB. In the text box, type in the
number of kilobytes (KB) that a file must be equal to or smaller than in
order to be deleted.

If both options are enabled, only files whose size falls in between the kilobyte
specifications will be subject to the delete rule. Files whose size falls outside of
the range set by both options will never qualify for deletion under this delete
rule.
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The Attributes Tab

The Attributes tab allows you to view and change the specific file attribute
qualifications for the delete rule.

To view the attributes tab:

9 Click the Attributes tab in the Delete Rule Properties dialog box. The Attributes
tab appears.

Figure 102: Delete Rule Properties: Attributes Tab

Delete Rule Properties E

File Namel Size  Altributes |Age I

— File Attribute:

" Delete files with any attribute

¢ {Exciude files with the following file attributes:

W Feadorly W frchive [ Compressed
™ Hidden V' System

ak. I Cancel Aol Help

You have the following choices:

% To delete files with any attributes, select Delete files with any attribute.
This is the default.

% To exclude files with certain attributes from being deleted to media, select
Exclude files with the following attributes. Then click a check in the boxes
corresponding to the attributes that will disqualify a file from being deleted
to media.

WARNING é*

Attributes for existing files can be viewed through Windows Explorer. When
extending a system drive, be sure to exclude files with the System attribute to
prevent operating system file delete. Extending a system drive with DX is not
recommended and may cause severe operating system damage.

The Age Tab

The Age Tab allows you to configure a time delay for the deletion of files to media.
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If an age specification is configured for the delete rule, all files that otherwise qualify
for deletion under this delete rule will be deleted when the entered days have elapsed
since the selected file action and the next drive scan is run.

WARNING é*

If there is no age specification configured for the delete rule, all files that otherwise
qualify for deletion under this delete rule, will be deleted immediately after the first
drive scan.

To view the age tab:

< Click the Age tab in the Delete Rule Properties dialog box. The Age tab appears.

Figure 103: Delete Rule Properties: Age Tab

Delete Rule Properties [ %]

File Namel Size IAttributes Age |
—File Age

" Delete files of any age

& Exclude files with an age less than:

Days: IBU
Since: ILast access time 'l

ok I Cancel | Lpply | Help |

If you want to delete files regardless of age, select Delete files with any age.
This is the default.

To exclude files from deletion until a certain number of days have passed since a
specific file action, enable the Exclude files with an age less than option. Then
configure the following options:

% In the Days text box type in the number of days you want to elapse from the
file action trigger before the file is written to media.

% Select the appropriate file action trigger from the Since drop-down box:
Create time, Last access time or Last write time.
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DELETING A DELETE RULE

A delete rule can easily be deleted from the media folder. Deleting a delete rule
deletes all configured options for that delete rule.

To delete a delete rule:

1 Right-click the delete rule that you want to delete and select Delete from the
shortcut menu.

2 A message appears, prompting you to verify the deletion. Click Yes.

The delete rule is deleted and no longer appears in the Delete Rule node for that
media folder in the extended drive tree.

APPLICATION STORAGE MANAGER 175
Data Management Guide






CHAPTER
FIVE

MANAGING STORAGE MEDIA

By adding media services for the DX computer, you create a supply of storage media
that you can use to “extend” the NTFS volumes on DX computers. Media are listed
in the DX system as soon as they are inserted in the device used by the media
service, inventoried if necessary, and added to the media pool for an extended drive.
For more information on configuring a media service to your DX computer, see the
Media Services chapter of the DX2000 Getting Started Guide.

Media that have been allocated to the extended drive but are not yet in use by a
media folder appear under the Available Media tree for each extended drive. Media
that have been added to a media folder can be found under the Media node for the
media folder.

When a piece of media is initially added to a media device, the system evaluates the
media. After DX scans the piece of media, it is then placed in one of the six nodes in
the media tree, depending on whether the media is formatted, labeled, or contains a
recognized file system. Once media attributes are determined, the media can then be
formatted, labeled, added to a media folder, or used to copy a piece of already
existing media.

Although unassigned (Available) media are listed in a separate place from assigned
(Media folder) media, the media management functionality is common to all DX
media. For example, while different media tasks are available depending on the
current use and status of the media, the interface for adding, editing, and deleting the
tasks is the same.
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A discussion of available media activities is provided here, as well as steps for
accessing media commands and information via the shortcut menu. The commands
available through the shortcut menu include the Edit Tasks function. Media Tasks
are discussed only briefly in this chapter. For a detailed discussion on media tasks,
see the Storage Media Tasks chapter beginning on page 225.

This chapter deals primarily with the general management of your storage media,
regardless of its current use or status in the DX system. If you need detailed
information on migrating files to storage media or reccommendations on how to set
up your extended drive to make use of your storage media, see Chapter Two. Setting
Up File Migration on page 31.

THE AVAILABLE MEDIA TREE

The Available Media Tree contains all media allocated for an extended drive
(through the media service(s)) not yet assigned to a media folder. There are seven
nodes in the Media tree: Original, Copy, Duplicate, Blank, Foreign, Unknown and
Unformatted Media.

ORIGINAL MEDIA

All media that have been prepared for use with DX but are not currently assigned to
a media folder appear in the Original Media node. In order for a piece of media to
appear in this list, the media must be:

%  Assigned to the extended drive through the media service

%  Formatted for the file system for which the hardware device is configured
% Labeled

%  Not currently assigned to a media folder

Media appearing in this list is ready to be assigned to a media folder when necessary.
In addition, Original media can be reformatted, deleted (if offline), or renamed, and
its media properties viewed.

CopryY MEDIA

Copy media are media that are being used as copies of Original media on the DX
extended drive. The only difference between an original piece of media and its copy
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is the serial number for each piece of media. If an original piece of media becomes
unreadable, the copy of the media can be promoted to an original piece of media
once the damaged media is removed from the extended drive.

DuPLICATE MEDIA

Duplicate media is any media with the same serial number as another piece of media
on the extended drive. Duplicate media is unusable with DX and must be reformatted
in order to have another serial number assigned to it.

BLANK MEDIA

Blank media are media that have been formatted for use with DISKXTENDER but not
labeled. Blank media can be labeled, reformatted, deleted, renamed, or labeled for
use as a copy and its media properties viewed.

FOREIGN MEDIA

Any media that has been formatted for a file system other than that of its current
device or with a file system not supported for that media type is considered by DX to
be “foreign” media and is placed in the Foreign Media List. Media in this list can be
formatted (if the media is of a type that DX supports), and its media properties
viewed. Foreign media must be reformatted with the appropriate file system in order
to be used for file migration.

UNKNOWN MEDIA

Unknown media encompasses any media in the hardware device that DISKXTENDER
does not recognize. The problem could be an unsupported media type or an
unsupported file system. For detailed information on what File Types and Media
Types are supported by DX, see the Storage Media chapter of the Getting Started
Guide.

UNFORMATTED MEDIA

All unformatted media are listed under the Unformatted Media node. Media in this
list can be formatted, and its media properties viewed.
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MEDIA FUNCTIONS

When a piece of media is selected in the tree view or the contents view of the
Administrator window, the Edit menu contains commands specific to the
management of media on the extended drive. The commands available for media in
the Edit menu are the same commands that appear in the shortcut menu when you
right-click a piece of media in the tree view or the contents view.

Shortcut and Edit menu commands allow you to edit the media tasks assigned for
that piece of media, stop a task in progress, and clear an error status for a piece of
media. You can also view media activity logs or clear the media logs, and view the
properties for the selected piece of media.

What menu commands are available to media is partially determined by the status of
the media selected. For example, the Edit Tasks and Properties commands are
always available, but the Abort Task in Progress command is only available when a
task is processing.

ACCESSING THE MEDIA SHORTCUT MENU

For any piece of media, the shortcut menu allows you access to many common
media functions and commands. The Shortcut menu is accessed by right-clicking a
piece of media from the tree view or the contents view of the DX Administrator.

The commands available for media are the same whether accessed through the
shortcut menu or through the Edit option on the main menu. Those commands are
discussed in detail below.

Removing Media from a Media Folder

The Remove function removes media from its assigned media folder (and move
group if applicable). Logically, the remove command is only available for media
assigned to media folders.

WARNING 6%

Removing media from a media folder removes all files (and file tags) on that media
from the extended drive. To maintain immediate availability of those files, compact
the media before removing it from the media folder.
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To remove media from a media folder:
1  You have the following choices:
% Right-click the media and select Remove from the shortcut menu.

% Select the media and select Remove from the Edit menu.

A verification message appears.

2 Click Yes. Another message appears stating that a drive scan must be run to
complete removal of the media.

3 Click Yes to run the drive scan immediately. Click No to allow the next
scheduled drive scan to complete removal of the media from the media folder.

Once a drive scan is run, the media is removed from the media folder and appears in
the Original node of the Available Media tree for the extended drive.

Deallocating Media from the Extended Drive
For NAS, OTGMS, and TSM media, using the Deallocate command on the shortcut

menu for media removes that piece of media from the extended drive and thereby
from use by DISKXTENDER for file storage.
To deallocate NAS, OTGMS, or TSM media:

1 Remove the media from its media folder (if applicable). For instructions, see
Removing Media from a Media Folder on page 180. The media should now
appear in the Original node of the Available Media tree.

2 You have the following choices:

% Right-click the media. A shortcut menu appears. From the shortcut menu,
select Deallocate.

%  Select the media. From the Edit menu, select Deallocate.
A verification message appears.

3 Click Yes. The media no longer appears in the Available Media tree.

For NAS, OTGMS, and TSM media, you can also use the Media Service Property
dialog box to deallocate media from an extended drive. For instructions, see the
following sections:

Y  Deallocating NAS Media from an Extended Drive, below
Y  Deallocating OTGMS Media from an Extended Drive on page 183

Y Deallocating Virtual TSM Media from an Extended Drive on page 183
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To deallocate ACSLS media, you must remove the media association with the DX
extended drive through the UNIX interface. For instructions, see Deallocating
ACSLS Media from an Extended Drive (Assigning ACSLS media back to the system)
on page 184.

Deallocating NAS Media from an Extended Drive

The Media Service Property dialog box allows you to deallocate a piece of virtual
NAS media from an extended drive.

NOTE &

To deallocate NAS media, the NAS media service should be online. If you attempt to
deallocate media while the media service is offline, the change may not take effect.

To deallocate a NAS media from an extended drive:

1 Remove the media from its media folder (if applicable). For instructions, see
Removing Media from a Media Folder on page 180. The media should now
appear in the Original node of the Available Media tree.

2 From the Service menu, select Configure Media Services. The Configure Media
Services dialog box appears.

3 Select the NAS media service and click Properties (or double-click the media
service). The Media Service Property dialog box appears.

4  Click the Media List tab.
5  You have the following choices:
% Double-click the media you want to deallocate from the extended drive.

%  Select the media and click Deallocate. (You can use a standard Windows
<Shift> or <Ctrl> technique to select more than one piece of media.)

A progress message appears. The Media Service Property dialog box reappears,
with the extended drive letter removed from the NAS media listing.
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Deallocating OTGMS Media from an Extended Drive

The Media Service Property dialog box allows you to deallocate a piece of OTG
MEDIASTOR media from an extended drive.

NOTE &

To deallocate OTGMS media, the OTGMS media service should be online. If you
attempt to deallocate media while the media service is offline, the changes may not
take effect.

To deallocate an OTG MEDIASTOR media from an extended drive:

1 Remove the media from its media folder (if applicable). For instructions, see
Removing Media from a Media Folder on page 180. The media should now
appear in the Original node of the Available Media tree.

2 From the Service menu, select Configure Media Services. The Configure Media
Services dialog box appears.

3 Select the OTGMS media service whose properties you want to edit and click
Properties (or double-click the media service). The Media Service Property
dialog box appears.

4  Click the Media List tab.
5 You have the following choices:
% Double-click the media that you want to deallocate from the extended drive.

%  Select the media. (You can use a standard Windows <Shift> or <Ctrl>
technique to select more than one piece of media.) Click Deallocate.

A progress message appears. The Media Service Property dialog box reappears,
listing the OTG MEDIASTOR media without the extended drive from which it
was deallocated.

Deallocating Virtual TSM Media from an Extended Drive

The Media Service Property dialog box allows you to deallocate a piece of virtual
TSM media from an extended drive.

NOTE &

To deallocate TSM media, the TSM media service should be online. If you attempt
to deallocate media while the media service is offline, the change may not take
effect.
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To deallocate virtual TSM media from an extended drive:

1

Remove the media from its media folder (if applicable). For instructions, see
Removing Media from a Media Folder on page 180. The media should now
appear in the Original node of the Available Media tree.

From the Service menu, select Configure Media Services. The Configure Media
Services dialog box appears.

Select the TSM media service and click Properties. The Media Service Property
dialog box appears.

Click the Media List tab.
You have the following choices:
% Double-click the media that you want to deallocate from the extended drive.

%  Select the media. (You can use a standard Windows <Shift> or <Ctrl>
technique to select more than one piece of media.) Click Deallocate.

A progress message appears. The Media Service Property dialog box reappears,
listing the TSM media without the extended drive from which it was
deallocated.

Deallocating ACSLS Media from an Extended Drive (Assigning
ACSLS media back to the system)

Deallocating ACSLS media from an extended drive is done by reassigning that
media back to the system (making the “system” the owner of the media). This
section describes how to assign media back to the system, effectively removing it
from the DX extended drive (and the DX system altogether). All commands
described in this procedure are entered on the Sun computer where ACSLS is
installed.

To assign media to the system:

1

In the ACSSS Console, change to the appropriate directory. Type the following
command and press <Return>:
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cd /export/home/ACSSS/data/external/volrpt

2 Inthe ACSSS Console, request owner information to find the media that you
want to deallocate. Type the following command and press <Return>:

volrpt -f owner id.volrpt -a x
The placeholder x represents the ACS ID. A list will be displayed showing the
owner of each media. Refer to the following example:

VOLUME REPORT UTILITY
2000-10-05 11:06:52
TOTAL VOLUMES: 2 SEQUENCE: sort by volume identifier

Volume Volume Owner
Label: Status: ID:

000182 VOLUME HOME SYSTEM
004022 VOLUME_HOME DX BENCH E

In this example, the media with volume label 000182 is currently unassigned.
The media with volume label 004022 is currently assigned to DX BENCH_E
(the extended drive E on the computer BENCH).

3 Inthe ACSSA Command Processor Window, assign the media to system. Type
the following command and press <Return>:

set owner “System” VOL MediaRange
In this command, the placeholder MediaRange represents the range of
numbers for the media that you want to deallocate. The following example

assigns the media numbered from 060945 to 060948 to the system, which
deallocates it from the extended drive to which it had been allocated:

set owner "“System” VOL 060945-060948

When the new assignment is completed, the following message appears in the
ACSSA Command Processor Window: “Set: set completed, Success.”
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Renaming Media

The Rename function allows you to rename media through the administrator without
going through the format and label tasks. Renaming a piece of (writable) media
changes the label identifier on that media. Renaming a piece of media does not affect
the files or directories on the media.

The Rename command is only available for media that has already been formatted
and labeled.

NOTE &

While the Rename command is available for NAS media and non-rewritable media,
the renaming is not permanent. The media reverts to its original label the next time
the Administrator refreshes.

To rename a piece of media:

1  You have the following choices:
%  Right-click the media and select Rename from the shortcut menu.
%  Select the media and select Rename from the Edit menu.

% Select the media and click the Rename button on the toolbar.

Figure 104: Rename Toolbar Button

a5

2 The media name appears highlighted in the tree view with a cursor. Retype the
name as desired.

3 Press <ENTER> or click outside of the media name. The media is now listed with
its new name.

186

APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Five: Managing Storage Media

EDITING TASKS FOR INDIVIDUAL MEDIA

The Edit Task function opens the Media Tasks page. Through the Media Tasks page,
you can add or remove tasks, or change option configurations for currently assigned
tasks for the selected piece of media. The shortcut menu provides fast access to the
Edit Tasks command.

Media Task Queue Manager

The Media Tasks page can also be opened through the Media Task Queue Manager,
which is accessible from the Tools menu.

Figure 105: Media Task Queue Manager

Media Task Queue Manager [ %]
Media | Type | Status | Location |
5 SCHED OMLINE - PREFETCH PENDING ‘T ape Library 3
EBLANE (35.0GE) SCHED OMLINE - LABEL COPY PENDING  'Tape Library', SCS12010, Shelf 2
a
Add New Media... Edit Tasks... | Delete Tasks | Aot Tash m Progress
Cloze I Help |

The Media Task Queue Manager, in addition to providing access to editing media
tasks, also allows you to delete all media tasks for a piece of media, to abort a task in
progress, to add media and tasks to the queue and to change the order in which media
is processed.

To edit tasks for media:

1  You have the following choices:
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% Right-click the media and select Edit Tasks from the shortcut menu.
%  Select the media and select Edit Tasks from the Edit menu.

%  Select Media Task Manager from the Tools menu, select the media, and
click Edit Tasks.

The Media Tasks page appears.

Figure 106: Media Tasks Page

Media Tasks E
Task List . .
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2 Add tasks, remove tasks or edit option configurations as needed. For more
specific information on media tasks, see Chapter Six: Storage Media Tasks on
page 225.

3 Click Next. The Media Task Queue Manager appears listing all media with
currently assigned tasks.

NOTE =

If you accessed the Edit Tasks function through the shortcut menu, the Order
Media In Task Queue dialog box appears. This is so that you can see where the
media you right-clicked to access the shortcut menu is in the queue, and adjust it
appropriately.

4  From the Media Task Queue Manager (or the Order Media in Task Queue)
page, you can alter the order in which media is processed by selecting the media
in the Task Queue list and promoting it or demoting it using the arrows on the
right side of the window.
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Figure 107: Order In Media Task Queue Page

Order Media In Task Queue [ %]
Task Queue:

I Media | Statuz | Location |
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< Back I Finizh I Cancel | Help |

5 When you are done, click Finish or Close as appropriate. Changes to the tasks
assigned for the selected media are saved.

STOPPING TASK EXECUTION FOR INDIVIDUAL MEDIA

You can stop a media task in progress for a particular piece of media by using the
Abort Task in Progress command. When you stop a task in progress, one of two
things will happen. Either the next pending task will begin processing or the aborted
task will be left in the media task queue as a failed task. If the aborted task is left in
the media task queue as a failed task, you must clear the error status on the media
before the remaining tasks will be processed. For instructions, see Clearing Task
Error Status on page 190.

NOTE =

Once in progress, the Format task cannot be aborted.

To stop a task in progress:

1  You have the following choices:
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% Right-click the media and select Abort Task in Progress from the shortcut
menu.

%  Select the media and select Abort Task in Progress from the Edit menu.

%  Select the Media Task Manager from the Tools menu, select the media in
the Media Task Queue and click Abort Task in Progress.

2 A verification message appears. Click Yes to stop the currently processing task.

The task that was in process is aborted. If the aborted task remains in the task queue
as a “failed” task, you will have to clear the error status in order to process the
remaining tasks (if any) for that piece of media. For instructions, see Clearing Task
Error Status on page 190.

CLEARING TASK ERROR STATUS

If a pending task for a piece of media fails or an aborted task remains in the task
queue as a failed task, you may need to clear the error status for the piece of media
before any other activities for that media can take place.
To clear the error status:
1  You have the following choices:
% Right-click the media and select Clear Error Status from the shortcut menu.
%  Select the media and select Clear Error Status from the Edit menu.

The Clear Media Error Status dialog box appears.

Figure 108: Clear Media Error Status Dialog Box

Clear Media Eror Status [ =]
Option:

& Delele al pending media tasks and clear media ermor status

€ Clear media erar status and continue [rety pending tasks)

T Cancel Help
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2 You have the following choices:

% To cancel all pending tasks and clear the error status, select Delete all
pending media tasks and clear media error status.

%  To clear the error status and continue processing assigned tasks, select Clear
media error status and continue [retry pending tasks].

3 Select the appropriate option and click OK. The error status is cleared. If
applicable, pending media tasks are processed.

VIEWING MEDIA LOGS

DX maintains a log of activity for each piece of media in the DX system. These logs

are useful for viewing task processing information and error codes/status for failed
tasks.

To open a media log:

<  You have the following choices:
% Right-click the media and select View Log from the shortcut menu.
% Select the media and select View Log from the Edit menu.
The Media Log for the piece of media appears.

Figure 109: Media Log Window

Bl WSTYERNONT - IMAGES_1 Media Log at 5/15/00 11:48:37 AM - RtiPad

File Edit Yiew Help

B | sl

} -
*  DiskXtender Media Log

* Media name: Docs 2

* Media class: ORIGIHAL

* Serial number: 391823DB

* Log start time: 5/9/00 11:51:13 AM

Compact started at 5/9/00 11:51:13 aM
Source media information:

...Drive name:

...Device name: HAZz00002
...Description: Network Attached Storage
..o Hedia: Does_2

Target information:

L AgERt namme: WITVERNCH1
oaDrive lecter: E:

...Directory name: Hedia_1%

Compact options selected:

...(there are no options at this time)
Compact ended at 5/9/00 11:51:13 iM
Compact completion statistics:

..Files processed: 0 (0 bytes)
..Files fetched: 0 (0 bytes)
..Files already fetched: 0 (0 bytes)
..File error count: a
...Total time: o0:00:00 -
| | _’l—l
Ready READ ERROR NUM -~
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CLEARING MEDIA LOGS

You can manually clear the information in a media log using a command from the
shortcut menu for the piece of media. Media logs have a specific size limitation, after
which the log is truncated from the beginning of the file. While the log size is
regulated through automatic truncation, large logs are often cumbersome and
difficult to navigate. Clearing media logs regularly makes it easier to find new
information.

NOTE =

You may want to save your log before clearing it. Display the log and then select
Save from the File menu in the log window. (For instructions on displaying the log,
see Viewing Media Logs above.)

To clear a media log:

<  You have the following choices:
% Right-click the media and select Clear Error Status from the shortcut menu.
% Select the media and select Clear Error Status from the Edit menu.

A confirmation message appears. Click Yes to delete the data in the media log.

OPENING MEDIA PROPERTIES

The media Properties window consists of up to five tabs, including: General, Space,
Location, Statistics and Progress. What tabs appear depends on the type of media and
its status. For a discussion of the information and options available for each of these
tabs, see Media Properties below.
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MEDIA STATUS

You can configure the media items in the tree view of the DX Administrator to
change color depending on their status. The following table lists each color and
describes the status indicated by each color:

Table 19: Media Status Indicated by Color

MEDIA COLOR: MEDIA STATUS:

Red Error

Yellow Offline

Green Online and running a task
Black Online, but not running a task

To configure the tree view to indicate media status by color:

2 From the View menu, select Enable Color. A checkmark next to the Color
option signifies that the option has been enabled. If this option is disabled, all
media items are black, regardless of status.

MEDIA PROPERTIES

The Media Properties dialog box contains multiple tabs with information pertaining
to the selected piece of media. The tabs that may appear for a piece of media are as
follows:

General
Location
Space

Statistics

& & & & F

Progress

Accessing the Media Properties and what information is provided in each of the tabs
is described in the sections that follow.
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OPENING MEDIA PROPERTIES

The Properties command is always available for every piece of media on an extended
drive, regardless of the current use, assignment or status of the media. The Media
Properties window consists of up to five tabs, including: General, Space, Location,
Statistics and Progress. What tabs appear depends on the type of media and its status.
For example, the Statistics tab does not appear for Blank media, and the Progress tab
only appears for media with tasks that are currently processing.
To open the media properties dialog box:
1  You have the following choices:

% Right-click the media and select Properties from the shortcut menu.

%  Select the media and select Properties from the Edit menu.

% Select the media and press <F2>.
The Media Properties dialog box appears with the General tab active by default.

2 Activate a tab by clicking the tab title.
3 Make any necessary changes to the aspect of the Media Properties selected.
4  Once any changes have been made, you have the following choices:

% Click OK to save changes and close the dialog box.

%  Click Apply to save changes to the active tab without closing the dialog
box.

%  Click Cancel to discard all changes and close the dialog box.

The General Tab

The General tab provides identifying information for the media. For all except
foreign media, you can use this tab to enter a brief Description, which is used for
media reports.
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Figure 110: Media Properties: General Tab

Media Properties

General ILocat\on' Spacel Slat\st\csl

— Wolurn
Name: IMAGES_1
Serial Number:  415310F1331B195E
Lahel Time: NA&

Status: OMLINE
— Atribaul

Class: ORIGINAL

Type: TAPE

File System: OTG File Sustem

i~ Description (used for media reports)

Ok I Cancel Al Help

The information found in the General tab is as follows:

Table 20: Media Properties Dialog Box: General Tab Items

ITEM: DESCRIPTION:

Name Name assigned to the media when labeled.

Serial Number Serial number of the media. For more information, see Media
Serial Numbers on page 197.

Label Time Date and time the media was labeled.

Status Current status of media. Status settings include:
offline

online

compact pending/ in progress/ failed/ paused
format pending/ In progress/ failed

label pending/ In progress/ failed

restore pending/ in progress/ failed

file report pending/ In progress/ failed

EEEEEEEE

library inventory pending/ in progress/ failed/ unknown
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ITEM:

DESCRIPTION:

Class

Type

File System

Description

There are seven valid classes to describe the media:
original

copy

duplicate

blank

foreign

unknown

EFEEEEEE

unformatted

The type of storage media: NAS, CD-ROM, DVD-RAM,

WORM, Erasable Optical, Tape

The media’s file system. There are 12 valid file systems:

unknown

otg optical
otg tape

is0 9660 joliet
fat

ntfs

iso 9660

is0 9660 ms
hsg

hsg ms

audio

FEEEEEEEEEEEE

photocd

An editable field where you can enter a media description to be
used for media reports. The maximum number of characters
that can be entered into the Description edit box is 64.
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NOTE &

For Foreign media, the Information tab displays “N/A” for media name, serial
number, and label time. The Description field is unavailable for editing.

Media Serial Numbers

Because media can be taken from one DX system and imported or placed in another,
media name is not sufficient for tracking media. While not recommended, DX does
allow more than one piece of media with the same name. Therefore DX must use the
serial number of media to track it and the files migrated to it.

DX can support more than one piece of media with the same name on an extended
drive, provided they have different serial numbers. If DX identifies two pieces of
media with the same serial number, it will classify one as Duplicate and require that
it be reformatted and given a new serial number before it can be used.

Media serial numbers provide a way to track all DX media uniquely, irrespective of
the DX system in which they were formatted. The serial number is an eight-byte
integer, represented as a hexadecimal string in the following format:
XXXXXXXXYYYYYYYY. The serial number is broken down as follows:

Table 21: Serial Number Interpretation

POSITION: DESCRIPTION:

(XXXXXXXX) The serial number from the Windows system boot drive
(usually drive C:). Windows assigns this number when the
hard drive is formatted. This number is unique for all hard
disks.

(YYYYYYYY) The encoded date/time that the media was labeled, expressed
in seconds elapsed since Midnight, January 1, 1970.
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The Location Tab

The Location tab provides information about the physical and logical location of the
media. You can also enter an offline location for the media, which is used for mount
requests and media reports.

Figure 111: Media Properties: Location Tab

Media Properties E
General Space I Statistics I

— Physical
Crrive: Mitzumi CO-ROM
Library: <media iz not in a library:

— Extended Drive
M ame: WSSEGAD:
Folder: “RHOB5GTY
File Count: 181

Byte Count: 75,847 035

r— Offline Location [used for mount requests, media reports]

Sarah's CD Rack

o ]

Cancel | Lppli |

Help

The information found in the Location tab is as follows:

Table 22: Media Properties Dialog Box: Location Tab Items

ITEM:

DESCRIPTION:

Drive

Library

Name

Folder
File Count

Specifies the drive in which the media is mounted.

Specifies the library in which the media is located, and its
location in the library (drive and/or shelf number).

Name of the computer and the extended drive to which the

media is assigned.

Name of the media folder to which the media is assigned.

Number of files on the media.
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ITEM: DESCRIPTION:

Byte Count Number of bytes used on the media.

Offline Location  Text field into which you can enter up to 32 characters to
describe the physical location where offline media are stored
(e.g., Second Floor Storage Room, Shelf 25D). This location
is shown when a MEDIA NOT FOUND error appears.

NOTE &

For foreign media, the Location tab displays “N/A” for Folder and the Offline
Location field is unavailable for editing.

The Space Tab

The Space tab provides statistical information on the physical and logical capacity of

the media.
Figure 112: Media Properties: Space Tab
Media Properties E
General I Location Statistics I

r— Physical Capacity
Biytes Per Sectar: 65,536
Mumber of Sectars: 573.440
Tatal Space: 37.580,963.840

— Logical Capacity
Sectors Per Cluster: 1
Free Clusters: 511,626
Used Clusters: 61,814
Total Clusters: 573.440
Free Space: 33.529,921.536
Used Space: 4.051,042,304
Total Space: 37.580,962,840

QK I Cancel Lpply Help
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The information found in the Space tab is as follows:

Table 23: Media Properties Dialog Box: Space Tab Items

ITEM: DESCRIPTION:
Bytes per Sector Number of bytes written to the media per sector
(determined by media).

Number of Sectors Total number of sectors on media.

Total Space Total media space, in bytes.
Sectors per Number of sectors per cluster.
Cluster
Free Clusters Number of free clusters on the piece of media.
Used Clusters Number of used clusters on the piece of media.
Total Clusters Total number of clusters on the piece of media.
Free Space Free space in bytes on the piece of media.
Used Space Written space in bytes on the piece of media.
Total Space Total space in bytes on the piece of media.
NOTE &
For foreign media, the Space tab displays “N/A” for all Logical Capacity
information.
200 APPLICATION STORAGE MANAGER

Data Management Guide



Chapter Five: Managing Storage Media

The Statistics Tab

The Statistics tab provides statistics relating to media mounts, file input and output,

and media errors.

Figure 113: Media Properties: Statistics Tab

Media Properties E

Generall Locationl Space  Statistics |

— Mount Information

Mount Court: 1
Last Mount Time: 5415400 17:41:47 &M
140 Infarmation
Fead File Count: 1]
Read Byte Count: 0
Last Read Time: WA
“wirite File Count: 1]
‘wiite Biyte Count: 1]
Last ‘wiite Time: M
Error Information
’7 Media Erors: 1] ‘

Walid Since:r MNAA

QK | Cancel | Lpply | Help |

The information found in the Statistics tab is as follows:

Table 24: Media Properties Dialog Box: Statistics Tab Items

ITEM:

DESCRIPTION:

Mount Count
Last Mount Time
Read File Count
Read Byte Count
Last Read Time
Write File Count
Write Byte Count
Last Write Time

Media Errors

Number of mounts per current session.

Time the media was last mounted.

Number of read requests during current session.
Number of bytes of files read during current session.
Time the media was last read.

Number of write requests during current session.
Number of bytes of files written during current session.
Time the media was last written.

Number of errors encountered per current session.
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NOTE &

The Statistics tab does not appear for foreign media.

The Progress Tab

During certain system activities, the Media Properties dialog box contains an extra
Progress tab, which displays the progress of a current activity. Once the activity has
been completed, the Progress tab no longer appears.

Figure 114: Media Properties: Progress Tab

Media Properties

Generall Lucaliunl Spacal Statistics é\‘ﬁf-agfﬁggé

Media statuz: FILE REFORT IN PROGRESS
Scanning media for files for file report
Files found: 181
<no additional infarmation:
<no additional information
Start tire: 13:06:01

Elapsed time: 00:00:05

Ok I Cancel | Lpply | Help |

The following information appears, as well as descriptive information pertinent and
specific to the activity in progress.

Table 25: Media Properties Dialog Box: Progress Tab Items

ITEM: DESCRIPTION:

Media status  Current status of media.
Start time Time the activity in progress began.

Elapsed time Total amount of time that has passed since the activity began.
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MANAGING CoOPY MEDIA

Copy media can be created for each piece of Original or assigned media on the
extended drive. You can start a Label Copy media task from the Edit Tasks wizard,
the Media Task Queue Manager, or the Copy Media Manager.

The Label Copy task assigned through the Edit Tasks function (either from the media
shortcut menu or through the Media Task Queue Manager) is intended primarily to
assign the task to individual pieces or sides of media and for circumstances such as:

%  You need to label a copy for a single side of an original piece of media.

% You need to copy from a standalone drive to a library drive or vice versa, or
between two stand-alone drives.

%  You need to schedule a label copy in conjunction with another task, such as
format.

The Label Copy feature in the Copy Media Manager is intended for the following
circumstances:

%  You need to label multiple pieces of media for use as copies.

%  Both sides of the original media are original and both sides of the blank media
are blank and will be used as copies.

%  You are copying from a library to a library.

This section deals specifically with using the Copy Media Manager to create,
maintain, and promote copy media. For more information on using the Label Copy
media task to create media copies, see Labeling Copy Media on page 231.

Once a copy is created, whether through the Copy Media Manager or assigned as a
separate media task, the Copy Media Manager allows you to view the update status
of all copy media and when necessary, promote the copy to original, in the event a

piece of original media becomes corrupted.

NOTE &

DISKXTENDER supports remote media copying, meaning that copy media and
selected blank media for copy do not have to be resident on the same MEDIASTOR
server as their associated originals. This allows you to create and maintain off-site
copies of original media for disaster recovery.
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BLANK MEDIA FOR COPY

The blank media selected for copy must match the original. The following must be
identical for the original and the copy media:

%  Media type (i.e., tape must be used to copy tape, WORM must be used to copy
WORM, etc.)

File system (i.e., NTFS media must be copied to NTFS media)
Block size/sector size

Total media capacity

& & & ¢

Compression settings (i.e., both must be compressed or both must be
uncompressed)

CoPIES FROM DX 4.x

DISKXTENDER 4.x copy media was formatted using unique serial numbers. This is
compatible with the DX2000 copy media format. Once DX2000 is installed and the
media from the DX 4.2 system is added to the DX2000 system, these media will be
added to the Copy list under the Available Media tree.

OPENING THE CoPY MEDIA MANAGER

The Copy Media Manager lists all existing copy media, along with the update status,
the copy number and the online/offline status of each. The Copy Media Manager
window gives you easy access to copy functions, allowing you to label new copies,
promote existing copies, and view the status of existing copies.

To open the copy media manager

S From the Tools menu, select Copy Media Manager. The Copy Media Manager
dialog box appears.
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Figure 115: Copy Media Manager Dialog Box

Copy Media Manager

LCopy Media:
Media Mame

| Serial Murber | Copy # | Orline | % Complete
415310F1392045F 4 1 Yes 0%
415310F139204BFC 2

Label New Copy Media... Promote Copy To Original... | Cloze I Help

Within the Copy Media Manager, you can label a new piece of copy media or
promote an existing piece of copy media to an original. You can also view the update
status of existing copies. The information that can be viewed for each piece of media
in the Copy Media Manager is summarized in the following table.

Table 26: Copy Media Manager Information

COLUMN: DESCRIPTION:

Media Name The media label for the piece of copy media (this is the same
the media label for the original).

Serial Number The unique serial number for the piece of copy media.

Copy Number  The number of that copy (i.e., if this was the first copy of an
original created, it would be copy number one; if another copy
already existed when it was created, it would be copy number

two.)
Online Whether or not the piece of copy media is currently online.
% Complete The percentage at which the copy is currently synchronized to

the original.
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Creating a New Copy

You can create one or more copies of one or more original pieces of storage media
from the Copy Media Manager using the Label New Copy Media option. The Label
New Copy Media function allows you to assign the Label Copy media task to
multiple pieces of media at once, and add those media to the Media Task Queue. For
more information on the Label Copy task or the Media Task Queue, see Chapter Six:
Storage Media Tasks on page 225.

NOTE &

DISKXTENDER supports remote media copying, meaning that copy media and
selected blank media for copy do not have to be resident on the same MEDIASTOR
server as their associated originals. This allows you to create and maintain off-site
copies of original media for disaster recovery.

NOTE =

When using the Copy Media Manager to Label Copy media, the task is set to
automatically process ASAP — as soon as possible. To change the processing to
Scheduled — Next active task schedule, you must change the status using the Edit
Tasks function. For instructions, see Editing Tasks for Individual Media on page 187.

To create a new copy:

1 From the Copy Media Manager, click Label New Copy Media. The Label Copy
Media page appears.
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Figure 116: Label Copy Media Page

Label Copy Media [

Select the type of copy media you would like to label:

Select thiz option ta label copy media far original
media that do not already have a copy.

" Label additional copy media

Select this aption to label additional copy media
for original media that already have a copy.

< Back I Mext > I Cancel Help

2 You have the following choices:

% Ifyou are creating a copy of an original piece of media that does not already
have a copy on the extended drive, select Label first copy media.

% If you are making additional copies of original media that already has a
copy or copies on the extended drive, select Label additional copy media.

3 Click Next. The Select Original Media dialog box appears.
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Figure 117: Select Original Media Page

Select Original Media

The following list containg original media that do not have a copy.
Select one or more oniginals and press Nest to label new copies,
DOriginal Media:
Media Mame Serial Mumber

SMEDIAA 36 7BC
@UNIFTY 3B9EFD7E3R43B185
g PHILADELPHIA_A 3611184336303032
I I

< Back I Mest > I Cancel I Help |

4  Select the piece (or pieces) of media that you would like to make copies of and
click Next. The Summary page appears.

NOTE &

You must always select the front and back of two-sided media to copy the media
in this wizard. To copy a single side of a piece of media, use the Edit Tasks
function. For details on how to configure an individual Label Copy task, see
Labeling Copy Media on page 231.
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Figure 118: Summary Page

Sumniry |
=

Action list:
1] Label new copy media

Selected originalz --> Location of media to label as copy:
MEDI&1A > Drive: 'Plasmanl’, SC512030

L o

Finish | Cancel | Help

5 Click Finish to complete the copy media labeling process.

After completing the wizard, the selected blank media will be scheduled for the
Label Copy task in the Media Task Manager. The Label Copy task will execute
when the Process scheduled media tasks activity schedule is active. Once complete,
the copy media appear in the Copy media list in the tree view of the Administrator.

Figure 119: Copy Media Manager

Capy Media Manager B
Copy Media
Media Name Copy | Online | % Complele
TBE<001 B Ves
S MEDIATA 1 No 1005

Label Mew Copy Media Promoia Copy To Original._ | Cose | Help
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PROMOTING CoPY MEDIA TO ORIGINAL MEDIA

Copy media is useful as a backup for original media. In the event the original piece
of media is lost or damaged, it may become necessary to replace the original using
the copy. In order to use copy media as original media, the original piece of media
must be removed from the media folder and deleted from the extended drive. The
copy may then be promoted to an original.

WARNING é*

If you promote a copy that is not 100% updated to an original, any changes not
updated on the copy will be lost.

NOTE &

Promoting copy media is intended for disaster recovery when an original is lost or
damaged beyond repair. Demoting a copy promoted to original and re-inserting the
original media will cause the copy to be inaccurate and is not supported. Once a copy
has been promoted to original, it should remain as an original.

Deleting the Original from DISKXTENDER

The first step in promoting a copy to an original is to delete the original from
DISKXTENDER.

To delete the original media from DX:

1 Ifthis piece of media is currently assigned to media folder, remove it from the
media folder using the Remove command in the media shortcut menu. A drive
scan must be performed to remove files from the extended drive that reference
the original media.

2 Once the media has been removed from the media folder, deallocate the media
from the extended drive.

3 Ifapplicable, remove the piece of media from the media service.

Once the original piece of media has been deleted from DISKXTENDER, the copy
media can be used as an original.

Promoting the Copy to an Original

Once the original has been deleted from DX, you can promote the copy to replace
the original.
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To promote the copy media to an original media:

1 Inthe Copy Media Manager, select the piece of copy media to be used as an
original.

2 Click Promote Copy to Original.

Figure 120: Promote Copy To Original Button

PBromate Copy To Original... |

A verification message appears.
Figure 121: Message: Copy Treated As Original

DizkXtender Administrator [ <]

& Are you zure wou want b use this copy media az an aniginal?

o |

3 Click Yes to promote the copy to original. A confirmation message appears
letting you know that the copy has been promoted and will no longer be
considered a copy.

Figure 122: Confirmation Message

DiskXtender Administrator E

& Copy successfully promaoted.

This message alerts you that the process is complete. The media can now be
added to a media folder, and files can be read from and written to it.

Once a piece of copy media has been changed to original media, DISKXTENDER no
longer views the piece of media as a copy.

To undo the process, you must remove the piece of copy media that has now been
promoted to original from the system (i.e., removed from the media folder and
deleted from the extended drive media pool). Reinsert the previously original piece
of media and then reinsert the copy (that had been promoted). DISKXTENDER will
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now view the two pieces of media as it did before removal of the original and
promotion of the copy took place.

WARNING é*

Trying to “undo” the promotion of a copy to original creates the risk of losing all
data newly written to the promoted original. For this reason, we do not recommend,
under any circumstances, attempting to undo the promotion of a copy to original
media.

Updating Media Copies

DX updates all copy media according to the schedule set for the Update Media
Copies media activity.

Figure 123: Schedule Update Copy Media Activity Option

— Activities

¥ Process scheduled I
media tazks

¥ Update copy media 1 >

¥ &llow fetches fom media 11

Set Clear
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DX automatically updates all copies with a status of less than 100% updated during
active copy schedule times. When a copy is performed, it is managed and tracked
automatically by DISKXTENDER. DX searches for written data, and knows how much
of the media it has left to copy.

Copy media is automatically updated to match the original whenever the Update
copy media activity runs. For information on setting the extended drive schedule and
the associated times to update copy media, see the Media Activity Scheduler section
on page 219.

NOTE &

If the copy media is offline at the time the Update copy media schedule is active, the
copy will not be updated.

MEDIA ACTIVITIES

DISKXTENDER provides scheduling for common media activities, including file
migration. Although you can process many of these activities immediately,
scheduling them during inactive times ensures the activities do not compete with
network clients for system drive or library resources.

Activity scheduling is managed using the Settings tab in the Extended Drive
Properties dialog box. Each schedulable option (drive scans, media activities,
backups) only affects the media activities for that extended drive. For more
information on extended drive properties and schedules, see the Extended Drive
Administration chapter of the DX2000 System Guide.

DX AcCTIVITY PRIORITIES

In addition to the scheduling mechanism, DX has a built-in precedence system that
causes particular activities to always take precedence over others. Understanding the
priority system will allow you to schedule activities in the most efficient way
possible in order to avoid conflicts with system resources.

For example, retrieval of requested files from media always takes precedence over
all other media activities. If a client requests a file that has to be retrieved from
media, the media activity precedence rules observed by DX ensure that the client
does not have to wait for other pending media activities to take place before the piece
of media containing the needed file is mounted.
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For this reason, we generally recommend that you schedule file migration, media
tasks, and media copy updates at a time when client retrieval requests are at a
minimum.

The following list outlines the order of precedence for DISKXTENDER activities.
Fetch files from media (to include deferred fetches)

Drive scan

Move files to media

Prefetch files from media

Process Media Task Queue

& & & & F &

Flush media transactions (library drives only)

When schedules overlap, DISKXTENDER performs activities according to these
priorities. For example, a drive scan will be performed before files are moved to
media, if they conflict.

Move files to media and Flush media transactions are interruptible events; the others
are not. This means, for example, if a file move is in progress and media restore is
scheduled to begin, the file being moved at that time will finish, but no other files
will be moved, allowing the media restore to begin. Conversely, if an extended drive
scan is running, and the Move files to media schedule becomes active, the drive scan
will finish before the movement of files will begin.

For a more detailed discussion of each of the activities listed above, except drive
scans, see Types of Storage Media Activities below. Drive scans are an extended
drive activity, as opposed to a storage media activity. For a more detailed discussion
of drive scans, see the Extended Drive Administration chapter of the DX2000
System Guide.

NOTE &

The priority listing above only applies when activity processing happens to occur
simultaneously, due to either overlapping schedules or other system requests.

TYPES OF STORAGE MEDIA ACTIVITIES

A media activity is an activity that requires a piece of media to be online and
accessible to DX in order for the activity to take place. In the case of media services
that store files to removable media, the piece of media has to be mounted in a drive.
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Frequent mounting and dismounting of media can have a wear-and-tear effect on the
library devices that move media to and from the drives where the media is mounted.
Problems can also arise when there are requests pending to mount more pieces of
media than there are drives available.

DX gives you control over media activities by allowing you to schedule four of the
types of storage media activities: Move files to media, Process scheduled media
tasks, Update media copies and Allow fetches from media. These activities are
scheduled using the Schedule button accessible through the Settings tab in the
extended drive Properties. In addition, you can schedule prefetch requests through
the Prefetch Request Manager. Scheduling of these media activities lets you ensure
efficient management of media mounts and dismounts within a device, and allows
you to reduce competition for available drives during peak usage times.

Fetch Files From Media

DISKXTENDER provides virtually limitless background mass storage services by
creating the illusion that all files on an extended drive are actually on the NTFS
volume to which clients are connected. In reality, some files on the volume have
been moved to media and truncated (purged) from the extended drive. When a file
has been moved to media and then purged, DX leaves behind a file “tag” which
contains only the file details (size, creation date, etc.) and the location of the file on
storage media. When viewed through the Windows Explorer, all proper file details
(i.e., correct size, date, etc.) appear.

When a client attempts to open a file on the extended drive, the file data may or may
not be present on the extended drive. If the file is present, DX allows Windows to
handle the file request. If only the file tag is present on the extended drive (file data
has been moved to storage media and purged from the volume), DX retrieves the file
from media, copies the file back to the extended drive, and completes the client
request. When a file is retrieved, this process is referred to as a “fetch.”

A fetch is a media activity because it requires that media to be mounted, and may use
network resources for the transfer of fetched files. Fetches can only occur when the
Allow fetches from media schedule is active. However, because the retrieval of files
is one of the most important DX activities, the Allow fetches from media schedule,
by default, is always active. Unless the extended drive schedule is set to not allow
fetches from media at specific times, and a purged file is requested during a time
when the fetch schedule is inactive, fetch requests are carried out as soon as the
request is issued. If you have time-based restrictions for file fetches set, and the
Defer fetch requests if fetch is disabled extended drive option enabled, file requests
made during an inactive fetch schedule will be processed as soon as the fetch
schedule becomes active again.
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NOTE &

The Allow fetches from media schedule only pertain to individual client requests for
purged DX files (to include files marked for direct read). It does not apply to and will
not affect any DX prefetch requests created either as media tasks or through the
Prefetch Request Manager.

Move files To Media

The Move files to media activity occurs only when the schedule for that activity is
active. Files that have been added to the move lists are migrated to storage media.
When a client writes a file to an extended NTFS volume managed by DISKXTENDER,
the file is saved on the extended drive visible to the client. Files remain on the
extended drive until eligible for migration, then, transparently to the client, DX
moves them to storage media. You create the move rules that determine if and when
a file becomes eligible for move.

When a file becomes eligible for move, the name of the file will be added to a list of
files to be moved. Depending on the move rule settings, the file name is added either
immediately or during the next drive scan. When a drive scan is run, every
potentially eligible file on the drive will be checked and a move list created from the
results.

During the time scheduled for the Move files to media activity, DX copies the files
on the move list out to storage media and purges any moved files that have Purge
files immediately after move configured. The Move files to media schedule applies
to all files currently on the move list.

NOTE =

When a file is eligible to be purged based on Purge rules, it is added to a purge list in
the same way files are added to a Move list, either immediately or during the next
drive scan. If the Purge files immediately after Move setting is in effect, however,
the file is purged immediately. For more information on creating move rules and
enabling a Purge after Move, see Creating Move Rules on page 71.

Prefetch Files From Media

When a file is retrieved in response to a configured, scheduled request, this process
is referred to as a “prefetch.” DISKXTENDER has a prefetch utility that allows you to
schedule this file retrieval. You can designate which files should be fetched to the
extended drive and schedule when the file retrieval will occur. Any files that you
know will be needed can be marked for prefetch so that they will already be present
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on the extended drive when they are requested. Prefetches will fetch all requested
files to the extended drive, to include files marked for direct read.

You can schedule a prefetch request to occur once at a set time, to occur regularly at
set times, or to be processed immediately. Prefetching files at low traffic times frees
system resources and speeds read request response during high traffic times.

A prefetch request is a media activity because it requires media to be mounted.
Configuration and scheduling of prefetch requests is done through the Prefetch
Request Manager. This allows you to control the scheduling of each individual
prefetch request. The Prefetch Request Manager, in the Tools menu in the
Administrator, can be used to schedule, configure and manage prefetch requests. For
more information on prefetch requests, see Prefetch Requests on page 117.

NOTE &

DISKXTENDER has two types of Prefetch functionality: Prefetch Request Manager
and the Prefetch Media Task. The prefetch activity discussed above and listed in the
Prefetch Requests section on page 117 refers to prefetch requests configured through
the Prefetch Request Manager. Prefetch Media Tasks are assigned and processed as
part of the Media Task Queue. For more information, see Process Media Task Queue
below.

Process Media Task Queue

Media tasks are activities that you can actively assign to specific pieces of media.
Media tasks include prefetch (all files on a specified piece of media), compact, file
report, format, label, label copy, file restore, add to move group, remove from move
group, add to media folder, remove from media folder, and check disk.

When you assign media tasks to a piece of media, you can choose to process the
tasks immediately or to schedule them to process later. When you select the
immediate processing option, DX will start processing the task right away. When
you choose to schedule a task, the activity will not occur until the Process scheduled
media tasks activity in the extended drive scheduler activates.

During the times when the Process scheduled media tasks option is active in the
extended drive schedule, DX will process all scheduled tasks for media listed in the
Media Task Queue, in the order in which the media are listed. Once all scheduled
tasks for a piece of media are complete, DX will remove the media from the queue
and proceed to the next piece of media.
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NOTE &

For detailed information and instructions on assigning, editing, and scheduling media
tasks, see Chapter Six: Storage Media Tasks on page 225.

Update Media Copies

DX automatically updates any piece of copy media that is less than 100% updated
during active copy schedule times. When a copy created, it is managed and tracked
automatically by DISKXTENDER.

When the Update Media Copies schedule is active, DX checks each copy against its
original to determine whether any updates should be made to the copy. DX searches
for the number of sectors written, and knows how much of the media it has left to
copy. If updates are required, DX will update the copy. Update status for individual
pieces of copy media can be viewed through the Copy Media Manager, which is
accessible from the Tools menu in the DX Administrator. For more information on
creating and managing copies, see Managing Copy Media on page 203 or Labeling
Copy Media on page 231.

Flushing Transactions to Media

When changes are made to file attributes on the extended drive, the piece of media
where that file is stored is not always immediately mounted to change the file on the
media. Instead, DX will log the change to the file in a transaction log for the piece of
media and save that information until the next time the media is mounted. The
transaction log is an area reserved on the DX computer’s hard drive to automatically
record all file changes made. When the media is mounted, DX will “flush” the
transaction logs out to media and the file changes will be reflected on the media.

For currently mounted media in a library drive, DX will always flush transaction
logs to media before responding to fetch requests, moving files, or processing media
tasks. Transaction logs for media mounted in a standalone drive or tower are flushed
automatically every minute (or immediately when a media rename occurs).
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In libraries, DX can use the library robotics to mount and dismount media without
requiring manual insertion and removal of media by the administrator. For this
reason, DX will mount media in a library specifically to flush transaction logs to the
media and keep the media updated. DX uses the following rules for dismounting
media currently in a library drive and mounting media on shelves in a library to
transfer logged information to the media:

%  Media currently mounted in the drive for fetch: Transactions will be flushed
when drive becomes available after timeslice expires.

% Media currently mounted in the drive for move: Transactions will be flushed
when nothing left to move (or the schedule is inactive).

% Media mounted for media task processing: Transactions will be flushed when no
tasks are left (or the schedule is inactive).

% Media mounted for copy: Transactions will be flushed when no copies are left to
update (or the schedule is inactive).

MEDIA ACTIVITY SCHEDULER

DISKXTENDER provides scheduling for many system events, including file
movement to media and drive scans. This allows you to schedule time-consuming
processes to occur at more convenient times, such as nights, weekends and holidays,
providing more efficient and effective system functionality.

Scheduling these events during inactive times ensures the events do not compete
with network clients for system, drive, or library resources. Schedules can be
defined, modified, and deleted using DX Administrator. In addition, many schedules
have corresponding event logs that track event completion and errors.

The scheduler also contains an option to restrict access to purged files during times
when access to the media from which the files would be fetched is prohibited.

You should set event schedules based on the needs of the individual system. Issues to
consider when setting up your schedule include the importance of specific media
activities, the length of time required, and the available resources necessary to
complete each activity.

There are four storage media activities that can be scheduled for each extended drive.
Those activities are:

%  Move files to media
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% Process scheduled media tasks
% Update copy media
% Allow fetches from media

There are three additional system activities that have their own separate scheduling
capabilities. Those activities are:

%  Drive Scans
%  Prefetch Requests
% Extended Drive Backups

All of the media activities listed above are specific to the extended drive for which
they are configured and must be scheduled and maintained separately for each
extended drive in your DX system.
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SCHEDULING STORAGE MEDIA ACTIVITIES

DISKXTENDER media activities are scheduled for a time range (e.g., 2am-4am). This
range provides a “window of opportunity” for the activity(s) to occur. Any time
within this range that an activity can begin, it will. If for any reason the activity does
not begin during this time, it will not be performed until the next time the schedule is
active. When these activity schedules overlap, they occur based on the priority
system noted in the DX Activity Priorities on page 213.

The activity scheduler exists as a property of each extended drive, and can be

accessed through the Settings tab of the Extended Drive Properties dialog box. These
schedules are specific to and must be configured separately for each extended drive.

Figure 124: Extended Drive Schedule Dialog Box
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Within the scheduler, colored lines represent each activity, allowing you to quickly
see which activities are scheduled for what blocks of time. When the scheduler first
appears, three of the four available activities are scheduled to occur from 8 p.m. to 9
a.m. every day of the week. The Allow fetches from media activity is scheduled to
occur 24 hours a day, 7 days a week (always active). These are the defaults for each
DX extended drive, and these schedules will remain set this way until changed.

The schedule grid contains columns for each hour of the day and rows for each day

of the week, creating cells which each represent one hour. For example, the blacked
out cell in Figure 124 above represents 5 p.m. to 6 p.m. on Sunday. DISKXTENDER’S
scheduler allows you to set scheduled activities by selecting one or many cells in the
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grid and by selecting one or more activities for those time period cells. You can
easily schedule all activities for a large block of time, or you can schedule specific
activities for smaller blocks of time.

When you select an area in the schedule grid and click the Set button, any activities
checked will be scheduled for that time period. Any activities not checked will be
cleared for the selected area, even if they were already scheduled for some or all of
the time blocks.

NOTE &

Any time the Allow fetches from media schedule is not active, client fetch requests
for files whose data has been purged (to include files marked for direct read) will not
be honored. Changing the schedule for this activity may prevent clients from having
access to necessary files. We recommend that you retain the default setting for
fetches (always active), unless your organization requires a time-based restriction of
access to purged files. If you have a time-based restriction configured, you may want
to set the Defer fetch requests if fetch is disabled extended drive Properties option.

To set up a media activity schedule:

1 From the Settings tab in the extended drive Properties dialog box, click
Schedule. The Schedule dialog box appears.

2 To change schedule settings, select the area of the grid that corresponds to the
time period during which you would like to schedule or clear an activity.

% To set an activity for the selected blocks, check the appropriate option(s) in
the Activities section of the Schedule dialog box.

% To clear an activity for all selected blocks, uncheck the appropriate
option(s) in the Activities section of the Schedule dialog box.

Use the buttons described below to make and save changes as needed.

Table 27: Schedule Properties Dialog Box: Set/Clear Buttons

BUTTON: ACTION:

Set Sets the activities that are checked and clears the activities that are
not checked in the highlighted area of the schedule grid.

Clears all scheduled activities in the highlighted area of the

schedule grid, regardless of which options are checked in the
Activities section.
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3 Once you have made changes to the schedule, you have the following choices:
% Click OK to save changes and close the dialog box.

%  Click Cancel to close the dialog box without saving changes.

NOTE &

You must save changes to the schedule using the Set and Clear buttons before
selecting OK or Apply. Making changes and selecting OK without using the Set or
Clear buttons will close the dialog box without saving your changes.
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CHAPTER
SIX

STORAGE MEDIA TASKS

Media tasks are media activities that you can actively assign to specific pieces of
media. Media tasks include prefetch (all files on a specified piece of media),
compact, file report, format, label, label copy, file restore, add to move group,
remove from move group, add to media folder, remove from media folder, and check
disk. In addition, you can assign media prepare functions (format and label) to media
through the Media Prepare Manager or prepare and create copies of Original media
through the Copy Media Manager.

When you assign media tasks to a piece of media, you can choose to process the
tasks immediately or to schedule them to process later. When you choose to schedule
a task, the media to which the task is assigned is added to the Media Task Queue.
You can then control the order of media in the queue, thereby controlling when
media with scheduled tasks are processed.

This chapter addresses each of these media activities in detail and discusses
procedures for processing the tasks when they are assigned or scheduling them to
occur at another time.

You can access media task information from two points in the DX system. The Edit
Tasks option, accessible from the shortcut menu for each individual piece of media
allows you to edit tasks for an individual piece of media. The Media Task Manager,
accessible from the Tools menu allows you to edit media tasks and manage the
processing order for media with pending tasks. Tasks assigned through the Media
Prepare Manager and the Copy Media Manager can be viewed and edited through
the Media Task Queue Manager.
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TYPES OF MEDIA TASKS

This section contains a detailed description of each media task available in
DISKXTENDER and the options available for each task when assigned to media. After
that, you will find a section that describes how to use the Media Task Manager,
including how to edit tasks and adjust the order of media in the Media Task Queue.
At the end of this chapter, you will find information and procedures for managing the
Scheduler that activates processing of the Media Task Queue.

Each media task described below can be scheduled to occur when the Process
scheduled media tasks schedule is active, or to occur immediately, independent of
the Process scheduled media tasks activity schedule.

FORMATTING MEDIA

All media must be formatted for use with DISKXTENDER. Formatting verifies the
integrity of the media, and makes it available for use with system hardware. It
prepares the media for file writes by creating the specified file system on the media.
DISKXTENDER allows you to format media in a standalone drive one side at a time,
or in a library on multiple drives at one time.

You can perform a format on unformatted media, or media that has previously been
formatted for the same or another file system. Media that has never been formatted
will appear in the Unformatted media node. Media formatted in a file system other
than the one configured for the drive or device it is in will appear in the Foreign
media node.

Media is formatted for a particular file system. Media formatting options differ
depending on the file system configured for the hardware device being used as a
media service. For example, if a device has been configured for OTG file systems,
the format command automatically formats media for this file system; likewise with
Windows Native file systems. Media formatted for Windows Native file systems
cannot be mixed in a hardware device with media formatted for OTG file systems.

It is important to examine system needs before deciding on a file system. DX will
read media from OTG, FAT or NTES file systems. OTG media is only recognized by
DX, and provides faster performance. However, if the media will need to be read by
another file system or software program, it may be more appropriate to use a
Windows Native file system.
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NOTE &

For information on file system recommendations and the relationships between file
systems and media types, see the Storage Media chapter of the Getting Started
Guide.

Reformatting Media

Previously formatted media can be reformatted if necessary. The formatting process
erases existing data and recreates the file system on the media. To reformat, assign
the Format task for that piece of media.

If you want to reformat a piece of media currently assigned to a Media Folder, you
should first assign the Compact task. (For instructions, see Compacting Media on
page 235.) Compaction places all of the files currently on the media onto the
extended drive and removes the media from the media folder. After assigning the
Compact task, you can assign the Format task to reformat the media. The media is
formatted, and if you do not select to label it after reformat, it is placed in the Blank
media node in the Available Media list.

Force Low-level SCSI Format

By default, when NTFS media is formatted, a quick format is performed. Quick
format erases the pointers to all files on media, but not the actual information. A
quick format is sufficient if the media is pre-formatted or has been previously low-
level formatted for the file system being used.

A low-level SCSI format is necessary when media has been formatted in a different
file system than the one to be used for the current drive, or if the media has
repeatedly failed due to media errors. Select this option to perform a low-level SCSI
format, prepare the media for the current file system, and drive type.

NOTE &

If a format fails initially, it is usually an indication that a low-level SCSI format is
necessary to prepare the media for the current file system and drive type.

Enable Compression for the media

If compression is enabled for a piece of media, files are compressed when they are
written to the media, allowing you to in some cases conserve storage media space.
Whether or not the Enable compression option is available for the format task is
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determined by which file system is being used and whether the device in which the
media resides supports file compression.

To assign a format task:

1

There are two ways to open the Media Tasks page:
% Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

In the Media Tasks page, select Format from the Next Task drop-down list in
the Manage Task List section and click Add Next Task.

Figure 125: Format Media Task
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In the Format Options section, select a file system from the File System drop-
down list, and use the checkboxes to enable or disable the Force low-level SCSI
format and Enable Compression (on this media) options.

Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.
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5 Click Next to add the media and the Format task to the Media Task Queue or
click Add Next Task to add another media task.

Once media has been formatted (and before it is labeled) it will appear in the Blank
media node of the Available Media list.

NOTE &

Formatting double-sided optical media in a standalone drive formats only one side of
the media. You must dismount, flip, and format the reverse side as well. Always
format both sides of double-sided media at one time, to avoid confusion.

NOTE &

DISKXTENDER does not support formatting of WORM media. WORM media cannot
be formatted through DX.

LABELING MEDIA

When media is inserted in a device, DX inventories the media to determine if it
recognizes the file system format, and reads the media label as well. If the media is
properly formatted but has not been labeled, DX identifies the media as blank and
adds it to the Available Media list under the Blank media node. Once media has been
labeled, the media appears with the new label in the Original Media list. Media in the
Original Media list can be assigned to a media folder.

Labeling assigns a name and serial number to a piece of media, allowing it to be
tracked by DISKXTENDER. Labeling a piece of formatted media adds the media to the
Original media node, making it available to be added to a media folder. No two
pieces of original media should have the same label, because the media label should
be a unique identifier.

The Label task can be assigned to follow a Format task for a piece of media, or blank
media can be labeled as needed. For example, you can format all the media in a
library, making it ready for use, but wait until a piece of media is needed to label it.
This creates a reserve of blank media, available to be used when needed and then
labeled accordingly.

Media Naming Conventions

Media label names may be up to sixteen alphanumeric (a-z or 0-9) characters in
length, with no spaces. Media names may also include the following special
characters: $ ! - ?.
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Certain standards should be applied when naming media. It is best to use a
descriptive and consistent naming convention (as opposed to the date and time, or
1,2,3...). This will assure easy tracking of all media by name, and reduce confusion
if different media are accidentally mixed together.

The recommended approach to naming media is to use a prefix and a sequence
number. The prefix should represent the extended drive name, application name, or
other similar quality that identifies the use of the media (i.e., CAD, IMAGES,
DOCS). The sequence number represents the order of the media in the group and
optionally should reflect the side of media (i.e., 1,2,3 or 1A, 1B, 2A, 2B, 3A, 3B).
Combined, they give an orderly system for naming media (i.e., CAD1A, CADIB,
CAD2A, CAD2B, etc.).

Depending upon data organization, all media could be given the same prefix, with
the only difference being the number following the prefix. Or, different prefixes
could be given to media depending upon file type or location. When labeling media
in a standalone drive, one side should be labeled LABEL1A, while the other side
should be labeled LABEL1B, where LABEL is the descriptive prefix.

Assigning a Label Task

The Media Tasks window allows you to assign a Label task.

To assign a label task:
1  There are two ways to open the Media Tasks page:
% Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 Inthe Media Tasks page, select Label from the Next Task drop-down list in the
Manage Task List section and click Add Next Task.
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Figure 126: Label Media Task
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3 Inthe Label Options section, enter a label in the Media Name text box. For

recommendations on labeling media, see Media Naming Conventions on page

229.

4  Select an option of When To Process, either ASAP — As soon as possible or

Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see the Media Task
Scheduling section on page 268.

5 Click Next to add the media and the Label task to the Media Task Queue or

click Add Next Task to add another media task.

Once media has been labeled it will appear in the Original media node of the

Available Media list.

LABELING CoPY MEDIA

The Label Copy task allows you to assign a piece of blank media to be used as a
copy of a piece of existing media. Label Copy can only be performed on Blank
media that has size and file type specifications identical to the piece of Original

media being copied. The Label Copy task is processed in the same way as any other

media task (ASAP or added to the Media Task Queue for scheduled processing

during the Process scheduled media tasks schedule).
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Copy media has the same label as the Original it corresponds to, but has a unique
serial number.

The Label Copy task discussed here allows you to Label individual pieces of Blank
media for use as copies. To assign Label Copy to multiple pieces of media, use the
Copy Media Manager function. For information, see Copy Media Manager on page
252.

NOTE &

The Blank media selected for the Label Copy task must have the exact same storage
size and file type as the original piece of media being copied.

To assign a label copy task:
1  There are two ways to open the Media Tasks page:
%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 Inthe Media Tasks page, select Label Copy from the Next Task drop-down list
in the Manage Task List section and click Add Next Task.

Figure 127: Label Copy Media Task
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3 Inthe Label Copy Options section, select the piece of media you want to want to
make a copy of from the Original Media drop down list.

4  Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

5 Click Next to add the media and the Label Copy task to the Media Task Queue
or click Add Next Task to add another media task.

Once the Label Copy task has completed, the media appears with the new label in
the Copy media node of the Available Media list.

WARNING é*

For media in standalone drives, DISKXTENDER allows you to Label Copy the flip
side of an original piece of media as a copy of that same original. However, if you
use the other side of an original for its copy, DX is unable to update the copy.

RESTORING FILES FROM MEDIA

The File Restore task makes files on media available for access through
DISKXTENDER by placing tags on the extended drive that point to the files on the
media. Whenever media is added to a media folder, this task is automatically
assigned and can be viewed from the Media Task Manager. However, the file restore
task can be performed any time necessary.

During a File Restore, file tags for all files on the media are placed in the media
folder on the extended drive. If there are duplicate files, the newest file (tag) is
restored and older versions are always replaced. Since all files from media are
restored during this task, you may wish to delete restored file tags deemed
unnecessary from the extended drive after the restore is complete. Files from CD-
ROM and WORM media are restored with tags having a read-only attribute. You
must remove that attribute to delete the file tag.

Restore File Options

The File Restore task has two options that can be enabled or disabled when adding
the task to media: Log Duplicates (list file names in media log) and Direct Read
(read files directly from media).

The Log Duplicates option creates a list of all files on the media that had duplicate
file tags on the extended drive. This list can be found in the media log. This is
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particularly useful if a piece of media becomes corrupted and you have to replace it
with a copy.

The Direct Read option places the direct read attribute on all files restored from the
media. Setting direct read causes files to be retrieved directly from media when
accessed by a client rather than fetched to the extended drive first and read from
there.

NOTE &

File tags are information about the file including: name, location, attributes, size and
create time.

Assigning a File Restore Task

The Media Tasks window allows you to assign a file restore task.

To assign a file restore task:
1 There are two ways to open the Media Tasks page:
%  Select the Edit Tasks option from the shortcut menu for a piece of media.

% Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 Inthe Media Tasks page, select File Restore from the Next Task drop-down list
in the Manage Task List section and click Add Next Task.
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Figure 128: File Restore Media Task
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3 In the Restore Options section, select to enable or disable the Log Duplicates

and Direct Read options. (For detailed information on these options, see Restore

File Options above).

4  Select an option of When To Process, either ASAP — As soon as possible or

Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task

Scheduling on page 268.

5 Click Next to add the media and the File Restore task to the Media Task Queue
or click Add Next Task to add another media task.

NOTE =

The restore process can be time-consuming for media with a large number of files;

therefore, you may want to configure the File Restore task as a scheduled event

rather than processing it immediately.

COMPACTING MEDIA

Media compaction allows you to reclaim deleted space on media formatted with
OTG file systems by relocating files from one or more pieces of media to other

storage media. Compaction also allows you to migrate files from one type of media
to another (e.g., CD-ROM to optical or optical to tape).
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The compaction process copies all files from a piece of media into the media folder
on the extended drive to which it is assigned. Then the file tag for each of those files
is deleted from the media and the media is automatically removed from the media
folder. The compacted files (those placed on the extended drive) remain in the media
folder until transferred back to storage media based on the move rules established for
that folder.

Since most if not all of the compacted files will qualify for migration, those files will
be written back to the storage media assigned to the move group as soon as the Move
files to Media schedule is active. Once a piece of media has been compacted, it can
be reformatted for reuse or removed from the system (depending upon the type of
media).

NOTE &

To help ensure successful compaction, you should have free space equivalent to one
side of media available on the extended drive.

To assign a compact task:
1 There are two ways to open the Media Tasks page:
% Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 Inthe Media Tasks page, select Compact from the Next Task drop-down list in
the Manage Task List section and click Add Next Task.

236

APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Five: Managing Storage Media

Figure 129: Compact Media Task
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3 Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

4  Click Next to add the media and the Compact task to the Media Task Queue.

NOTE &

If media compaction fails, some, all or none of the data may have been moved to the
next media in the move group. If the cause of the compaction failure can be
determined, make the appropriate adjustments and reschedule the compaction. The
compaction process will resume with the next file that must be compacted
(compaction of already moved files will not be duplicated).

PREFETCHING FILES FROM MEDIA

The Prefetch media task writes all files from the selected media to the media folder
on the extended drive (ignoring duplicates). This task makes it possible to eject the
media from the system without the risk that it may be needed to provide file data to
complete client requests.
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NOTE &

The Prefetch media task is governed by the Process scheduled media tasks activity
schedule, and is in no way affected by the Allow fetches from media schedule.

To assign a prefetch task:
1  There are two ways to open the Media Tasks page:
% Select the Edit Tasks option from the shortcut menu for a piece of media.

% Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 Inthe Media Tasks page, select Prefetch from the Next Task drop-down list in
the Manage Task List section and click Add Next Task.

Figure 130: Prefetch Media Task
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3 Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

4  Click Next to add the media and the Prefetch task to the Media Task Queue or
click Add Next Task to add another media task.
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NOTE &

Running Prefetch through the Media Task function does not allow you to prefetch
specific files. To prefetch specific files or to schedule prefetch activities separately
from media tasks, use the Prefetch Request manager. For more information, see
Prefetch Requests on page 117.

REPORTING FILES ON MEDIA

The File Report task obtains information from media, making that information
available for a media files report. The media files report is created separately using
the Report Generator in the Administrator. You must run this task before running a
report in order to have current media information in the report. You can select to
obtain a complete listing of all files on the media or summary information about the
media files.

To assign a file report task:
1  There are two ways to open the Media Tasks page:
%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 In the Media Tasks page, select File Report from the Next Task drop-down list
in the Manage Task List section and click Add Next Task.
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Figure 131: File Report Media Task
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3 Inthe File Report Options section, select to obtain a Complete listing of all files
on this media or a Summary only (file totals, no file listing).

4  Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

5 Click Next to add the media and the File Report task to the Media Task Queue.

NOTE &

The File Report task only generates the information about the files on the media. For
details on using the Report Generator to run the Media Files Report, see the Reports
chapter of the DX2000 System Guide.

RUNNING CHECK DisK ON A PIECE OF MEDIA

The Check Disk task is used to run NT’s CHKDSK.EXE on NTFS media. For OTG
rewritable media, DX will perform a scan of DX file trailers.

To assign a check disk task:

1 There are two ways to open the Media Tasks page:
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%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 In the Media Tasks page, select Check Disk from the Next Task drop-down list
in the Manage Task List section and click Add Next Task.

Figure 132: Check Disk Media Task
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3 Inthe Check Disk Options section, select to Report errors only (do not fix) or to
Report and fix errors when found.

4  Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

5 Click Next to add the media and the Check Disk task to the Media Task Queue.

ADDING MEDIA TO A MEDIA FOLDER

The Add Media to Media Folder task can only be assigned to media that has been
formatted and labeled. The task is available for Original media, or for other media
that have the Format and/or Label tasks scheduled. This allows you to add media
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after other tasks are completed without any need for manual intervention, This task
can also be used in conjunction with the Add to Move Group task to automatically
add media to a media folder, then to a move group, all within a single process. For
more information about adding media to a media folder, see Adding Media to a
Media Folder on page 54.

To assign an add to media folder task:
1  There are two ways to open the Media Tasks page:

% Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 In the Media Tasks page, select Add To Media Folder from the Next Task drop-
down list in the Manage Task List section and click Add Next Task.

Figure 133: Add to Media Folder Task
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3 Inthe Add To Media Folder Options section, you have two choices:

%  Add the media to an existing media folder by selecting one from the Media
Folder drop-down list.
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% Create a new media folder for the media by clicking New and following the
prompts. When finished, the new media folder will appear in the Media
Folder drop-down text box.

4  Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

5 Click Next to add the media and the Add To Media Folder task to the Media
Task Queue or click Add Next Task to add another media task.

REMOVING MEDIA FROM A MEDIA FOLDER

The Remove Media from Media Folder task automatically removes the media from
the media folder on the extended drive. When media is removed from a media folder,
the file tags for the files on that piece of media are removed from the media folder as
well. The media is then placed in the Original Media list until it is moved back into a
media folder, deallocated from the extended drive, or reformatted.

To assign a remove from media folder task:
1  There are two ways to open the Media Tasks page:

%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 In the Media Tasks page, select Remove From Media Folder from the Next Task
drop-down list in the Manage Task List section and click Add Next Task.
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Figure 134: Remove From Media Folder Media Task
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3 Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

4  Click Next to add the media and the Remove From Media Folder task to the
Media Task Queue or click Add Next Task to add another media task.

ADDING MEDIA TO A MOVE GROUP

This task adds a piece of media to a move group making it available for DX to write
files to it based on the move rules configured for that move group. The task is
available for media already assigned to a media folder, or for other media that have
the Format and/or Label and/or Add Media To Media Folder tasks scheduled. This
allows you to add media after other tasks are completed without any need for manual
intervention, Used in conjunction with the Add To Media Folder task, you can
automatically add media to a media folder, then to a move group, all within a single
process.

For more information about adding media to move groups, see Move Groups on page
60.
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To assign an add to move group task:

1

2

There are two ways to open the Media Tasks page:
%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

In the Media Tasks page, select Add To Move Group from the Next Task drop-
down list in the Manage Task List section and click Add Next Task.

Figure 135: Add To Move Group Media Task
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In the Add To Move Group Options section, select the move group for the
media from the Move Group drop down list.

Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.

Click Next to add the media and the Add To Move Group task to the Media
Task Queue or click Add Next Task to add another media task.
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REMOVING MEDIA FROM A MOVE GROUP

This task removes a piece of media from a move group making it unavailable for DX
to write files to it based on the move rules configured for that move group. Unless
specified by scheduling a subsequent Remove From Media Folder task, the piece of
media remains in the media folder, though no longer part of the move group.

To assign a remove from move group task:
1 There are two ways to open the Media Tasks page:

%  Select the Edit Tasks option from the shortcut menu for a piece of media.

%  Select Media Task Manager from the Tools menu and use the Add new
media or Edit Tasks button as appropriate. For more information on the
Media Task Queue Manager, see Using the Media Task Queue Manager on
page 257.

2 In the Media Tasks page, select Remove From Move Group from the Next Task
drop-down list in the Manage Task List section and click Add Next Task.

Figure 136: Remove From Move Group Media Task
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3 Select an option of When To Process, either ASAP — As soon as possible or
Scheduled — Next active task schedule. A scheduled task will process when the
next media task schedule is active. For more information, see Media Task
Scheduling on page 268.
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4  Click Next to add the media and the Remove From Move Group task to the
Media Task Queue or click Add Next Task to add another media task.

MEDIA PREPARE MANAGER

The Media Prepare Manager allows you to assign the Format and/or Label tasks to
multiple pieces of library media at one time. This is particularly useful if you have a
library with a large number of media that need to be formatted and/or labeled for use
in DX.

The Media Prepare Manager uses an easy-to-follow format that lets you format
media, label media, or format and label media. For recommendations and
information pertaining to the available options for the Format and Label media tasks,
see the discussions in the Formatting Media section on page 226 and the Labeling
Media section on page 229.

Once you have assigned the Format and/or Label tasks to media through the Media
Prepare Manager, you can view the media and the tasks through the Media Task
Queue Manager. For more information, see Using the Media Task Queue Manager
on page 257.

NOTE =

The Media Prepare Manager can only be used for media in libraries configured for
use with DISKXTENDER.
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To open the media prepare manager:

1 From the Tools menu, select Media Prepare Manager. The Media Prepare
Manager — Select Library page appears.

Figure 137: Media Prepare Manager: Select Library Page
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2 From the Library Name list, select a library. Click Next. The Media Prepare
Manager — Select Media page appears.

Figure 138: Media Prepare Manager: Select Media Page
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3 Select the media that you would like to prepare from the list. Click Next. The
Media Prepare Manager — Format page appears.
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Figure 139: Media Prepare Manager: Format Page
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4  You can choose to format or not to format the selected media. If you choose to
format the media, select a file system from the dropdown list box. The file
system must match that configured for the selected library.

5 Under the File System drop-down list, enable or disable the Force low-level
SCSI format and Enable compression for this media options (if available).

6  Once you have selected formatting options, click Next. The Media Prepare
Manager — Label page appears.
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Figure 140: Media Prepare Manager: Label Page
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7  You can choose to label or not to label the selected media. If you choose to label
the media, you have the following choices:

%  You can choose to use the standard method. Type in a Label Prefix. Type in
a Start Number to configure the first number that DX should use when
labeling media. Select a Number Width to limit the length of the number
that DX adds to the prefix to create the media label. The Sample Media
Name box displays a sample of the configured label settings.

%  You can choose to use the barcode. (Barcode labeling is only available for
some libraries. For more information, refer to your hardware manual.)

8 Once you have selected labeling options, click Next. The Media Prepare
Manager — Schedule page appears.
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Figure 141: Media Prepare Manager: Schedule Page
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9  Select whether you want the media prepare task(s) to occur immediately or to
occur when the next Process media tasks schedule is active.

10 Once you have selected the appropriate formatting, labeling and scheduling
options, click Next. The Summary page appears.

Figure 142: Summary Page
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11 Click Finish to assign the configured media tasks to the media. Each format and
label task will be assigned to the selected media as configured, and can be
viewed in the Media Task Queue.

CorY MEDIA MANAGER

The Copy Media Manager allows you to label new copies, promote existing copies,
and view the status of existing copies. This chapter discusses using the Copy Media
Manager to label new copies. For more information on the other functions available
through the Copy Media Manager, see Chapter Five: Managing Storage Media on
page 177.

The Label New Copy Media function of the Copy Media Manager provides you with
the ability to assign the Label Copy task to multiple pieces of Blank Media at once.
This is particularly useful if you have several pieces of Blank media (formatted but
not labeled) that you need to use as copies of Original media.

Once you have assigned the Label Copy tasks to media through the Copy Media
Manager, you can view the media and the tasks through the Media Task Queue
Manager. For more information, see Using the Media Task Queue Manager on page
257.

252 APPLICATION STORAGE MANAGER
Data Management Guide



Chapter Five: Managing Storage Media

To open the copy media manager

< From the Tools menu, select Copy Media Manager. The Copy Media Manager
dialog box appears.

Figure 143: Copy Media Manager Dialog Box
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The Copy media manager window appears listing all currently existing copy media.
The information listed with each piece of media is summarized in the following
table.

Table 28: Copy Media Manager Information

COLUMN: DESCRIPTION:

Media Name  The media label for the piece of copy media (this is the
same the media label for the original).

Serial The unique serial number for the piece of copy media.
Number

Copy The number of that copy (i.e., if this was the first copy of an
Number original created, it would be copy number one; if another

copy already existed when it was created, it would be copy
number two.)
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COLUMN: DESCRIPTION:

Online Whether or not the piece of copy media is currently online.

% Complete  The percentage at which the copy is currently synchronized
to the original.

CREATING NEw CopY MEDIA

You can create one or more copies of an original piece of storage media from the
Copy Media Manager using the Label New Copy Media option.

NOTE &

DISKXTENDER supports remote media copying, meaning that copy media and
selected blank media for copy do not have to be resident on the same MEDIASTOR
server as their associated originals. This allows you to create and maintain off-site
copies of original media for disaster recovery.

To create a new copy:

1 Click Label New Copy Media in the Copy Media Manager to label a new piece
(or pieces) of media for copy. The Label Copy Media page appears.

Figure 144: Label Copy Media Page
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2 You have the following choices:

% Ifyou are creating a copy of an original piece of media that does not already
have a copy in the DX system, select Label first copy media.

% If you are making additional copies of original media that already has a
copy or copies in the DX system, select Label additional copy media.

3 Click Next. The Select Original Media page appears.

Figure 145: Select Original Media Page
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4  Select the piece (or pieces) of media that you would like to copy and click Next.

NOTE &

You must always select the front and back of two sided media to copy the media
in this wizard. To copy a single side of a piece of media, you must assign the
Label Copy task to that media individually. For details on how to configure a
Label Copy task for a single piece of media, see Labeling Copy Media on page
231.
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Figure 146: Summary Page
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5 The Summary page appears. Click Finish to complete the copy media labeling
process.

After completing the wizard, the selected blank media will be scheduled for Label
Copy for the selected originals in the Media Task Manager. Once the copy process is
complete, copy media appear in the Copy Media list.
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Figure 147: Copy Media Manager
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For more information on using the Copy Media Manager to manage copies once they
have been made, see Chapter Five: Managing Storage Media on page 177.

USING THE MEDIA TASK QUEUE MANAGER

The Media Task Manager allows you to manage the processing order for all media
that have pending tasks. Opening the Media Task Manager displays the Media Task
Queue, which lists all media that have assigned tasks ready to be performed. When a
piece of media is processed, all tasks for that media are processed before DX moves
to the next media in the queue. Media are processed in the order they appear in the
Media Task Queue, meaning you can alter the order in which pieces of media are
processed by changing their order in the Media Task Queue.

You can also use the Media Task Manager to edit tasks for a particular piece of
media in the queue. When a piece of media is in the task queue, the task listed is the
one that will be processed first. Using the Edit Tasks function, you can view all tasks
assigned to the media. If new tasks are available for that piece of media, you can add
tasks. You can also delete existing tasks, or change the options for existing tasks.
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DX only allows you to set up certain combinations of tasks. Which tasks are
available is dependent on the status of that piece of media. For example, if you set a
Format task for a piece of media, DX will allow you to set up a Label task to follow
it, but will not offer you the option of adding the media to a media folder until it is
labeled (or until you schedule a Label task). Or if a piece of media is configured to a
Move Group, the Remove from Move Group task is available, but not the Add to
Move Group task. For tasks that cannot be queued in combination, you can set up
one set of tasks, allow the tasks to process, and then set up another set of tasks.

NOTE &

Each Media Task Queue is specific to each extended drive. If you have more than
one extended drive listed in your tree view, make sure the active extended drive is
the one for which you want to view pending media tasks.

OPENING THE MEDIA TASK QUEUE MANAGER

To open the media task queue manager:

< From Tools menu, select Media Task Manager. The Media Task Queue
Manager dialog box appears.

Figure 148: Media Task Queue Manager Dialog Box

Media Task Queue Manager | x]

Media | Tupe | Status | Location ‘
OFFLINE - FILE REPORT PENDI cnaot in a libran

Add Mew Media. | Edit Tasks. | Delete Tasks | Abart Task [n Frogress

Cloze I Help |

Media with pending tasks are listed in the order in which they will be processed.
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The following sections provide instructions for each of the functions available from
the Media Task Queue Manager. Those functions include:

%  Assigning tasks to media not already in the queue. For instructions, see Adding
New Media to the Queue on page 259.

% Viewing tasks (seeing what tasks are assigned to each piece of media in the
queue).

% Changing what tasks are assigned, or the options for assigned tasks for media
already in the queue. For instructions, see Editing Tasks for Media in the Queue
on page 263.

% Removing all tasks for media in the queue. For instructions, see Deleting Tasks
for Media in the Queue on page 267.

% Stopping a task from completing. For instructions, see Canceling a Task in
Progress on page 265.

% Changing the order in which media is processed. For instructions, see Ordering
Media in the Queue on page 266.

Adding New Media to the Queue

Media is added to the Media Task Queue whenever you assign a task to a piece of
media that did not have a task assigned to it before. Using the Add New Media
button in the Media Task Queue Manager, you can select a piece of media and assign
tasks to it, thereby adding it to the Media Task Queue.

NOTE =

You can add tasks to media through the Edit Tasks option on the shortcut menu for
media. Adding a task to media automatically adds that media to the Media Task
Queue.

To add a new piece of media to the queue:

1 Open the Media Task Queue Manager by selecting Media Task Manager from
the Tools menu.

2  Click Add New Media.
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Figure 149: Add New Media button

Add Mew Media

The Select Media for New Tasks page of the Add Media wizard appears listing
all Media With No Tasks currently assigned.

Figure 150: Select Media For New Tasks Page

Select Media For New Tasks

Media ‘With No Tazsks
Media Name Location

:FOREIGH (2.4 GB] 0. Shelf 12

@A FOREIGN [1.2 GB) ‘Dpticall’, SCS12040, Shelf 52

@A FOREIGN [2.4 GB) 'Dpticall’, SC512040, Shelf 16
@A FOREIGN [1.2 GB) 'Dpticall’, SCE12040, Shelf 5B

< Back I Mext » I Cancel Help

3 Select a piece of media for assignment of one or more tasks and click Next. The

Media Tasks page appears.
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Figure 151: Media Tasks Page

Media Taszks

Task List
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File System:

|07 File System =l
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Mewt Task: |ADD TO MEDIA FOLDER j " ASAP - Az soon as possible
Add Megt Task Delete Selected Task | & Scheduled - Next active task schedule

¢ Back I Finizh I Cancel | Help |

This page allows you to add and configure media tasks for the media. The
following table briefly outlines the options available for configuration for each
media task. For detailed discussions on media task options as well as
information on sequencing media tasks, see Using the Media Task Queue
Manager on page 257.

Table 29: Available Media Tasks and Options

MEDIA TASK: MEDIA TASK OPTIONS:

Format %  File System — select the file system
appropriate to the media and the device

%  Force low-level SCSI format — enable if
formatting for a different file system of if
media has failed due to media errors

% Enable compression — select to allow DX to
compress files when writing to this media

Label % Media Name — type in a name for the piece of
media
Label Copy %  Original Media — select the piece of media of

which you want to create and maintain a copy
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MEDIA TASK:

MEDIA TASK OPTIONS:

File Restore

Compact
Prefetch
File Report

Check Disk

Add Media to Media
Folder

Remove Media from
Media Folder

Add Media to Move
Group

Remove Media from
Move Group

Copy Update

%

Log Duplicates — select to create a list of files
in the media log that existed on both the media
and the extended drive

Direct Read — select to mark all files being
restored from the media for direct read (rather
than allowing them to be fetched to the
extended drive when requested by a client)

No options available for this task

No options available for this task

G

Complete Listing — select to provide complete
file information for files on the media,
including name and file size

Summary Only — select to provide only file
totals for the media

Report errors only — select to only report errors
found by the Check Disk function

Report and fix errors — select to allow the
Check Disk function to fix errors it finds

Media Folder text box — either select an
existing media folder from the drop-down list
or click New to create a new media folder

No options available for this task

©

Move Group text box — select an existing
move group from the drop-down list

No options available for this task

No options available for this task. (They are
available only for blank media after label copy task
is assigned.)

In addition to the options available for the media tasks listed above, you must
also select whether to process the task(s) immediately or when the Process
scheduled media tasks schedule is active. For more information, see Media Task

Scheduling on page 268.
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NOTE =

Since all tasks for media are processed at once, if you schedule multiple tasks
for media, be sure to select the same When to Process option for all tasks. If one
task has the ASAP — as soon as possible option selected, all tasks will process
ASAP by default.

4  Once tasks have been added and configured as needed in the Media Tasks page,
click Finish. The Media Task Queue Manager appears with the new media listed
and the tasks pending. Clicking Cancel will exit the Media Tasks dialog box and
discard all tasks added to the media.

All media with tasks assigned will appear in the Media Task Queue Manager until
they are processed. For media with tasks selected to process ASAP — as soon as
possible, those media may only appear briefly in the queue before the processing
completes and the media is removed from the queue.

Editing Tasks for Media in the Queue

The Media Task Queue Manager provides access to the Media Tasks dialog box,
which allows you to edit tasks assigned to media already in the queue. When editing
tasks for a piece of media, you can change what tasks are assigned (add or remove
tasks) or change the options configured for existing tasks.

NOTE =

You can access the Media Tasks dialog box either through the Media Task Queue
Manager or through the Edit Tasks option on the shortcut menu for media.

To edit the tasks assigned to media in the queue:

1 Open the Media Task Queue Manager by selecting Media Task Manager from
the Tools menu.

2 Select the media for which you want to edit the assigned tasks.

3 Click Edit Tasks.

Figure 152: Edit Tasks Button

Edit Tasks..

The Media Tasks page appears.
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Figure 153: Media Tasks Page

Media Taszks

Task List
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—idd To Media Folder Options

Mediz Folder:

\Media & =] Hew. |

ADD TO MEDIA FOLDER
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Table 30: Using The Media Tasks Dialog Box

TO DO THIS: PERFORM THESE STEPS:
Add a task to the % From the dropdown list, select the task.
Task List %  Click Add Next Task.

% Configure the appropriate options in the
Options section.

% Configure a processing option in the When to
Process section.

&

Edit the options for a From the Task List, select the task

task in the Task List % Change the Options selected and When To

Process selection as appropriate

&

From the Task List, select the task.
Click Delete Selected Task.

Remove a task (and
all tasks listed below
it) from the Task List

&

% In the confirmation message, click Yes

4 Add, Delete, or change the options for tasks as appropriate.
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5 Click Finish. Changes to the tasks assigned for the selected media are saved.
The Media Task Queue Manager dialog box reappears. Clicking Cancel will
close the Media Tasks dialog box and discard any changes made.

Canceling a Task in Progress

The Media Task Queue Manager lists the status of media with pending tasks, to
include the task currently in progress. You can choose to stop the task currently in
progress using the Abort Task in Progress button in the Media Task Queue manager.

All media tasks with the exception of the Format task can be stopped in progress.
Once you stop a media task in progress you may have to clear the error status for the
media before the next scheduled task will begin. If there is no error status to be
cleared, the next pending media task will start processing automatically.

To stop a task already in process:

1  Open the Media Task Queue Manager by selecting Media Task Manager from
the Tools menu.

2 Select the media for which you want to cancel the processing task.

3 Click Abort Task in Progress.
Figure 154: Abort Task In Progress Button

Media Task Queue Manager

I e edi | Status
1 OMLIME - FILE RESTORE IM PR... A, edia 2
_1[COPY) ASAP OFFLINE - FORMAT PENDING ape Library', 0. 5helf 2
Boocs SCHED  OFFLINE -PREFETCH PENDIMG  'Tape Library’, SCS12010, Shelf 1

Add Mew Media Edit Tasks. I DElete Tasks Abart Task In Progress |

Close I Help |

A message appears, prompting you to confirm that the task should be stopped.
4 Click Yes. The task is stopped and removed from the list of pending tasks.
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5 If stopping the process caused an error status on the media, you will have to
clear the error status before the next pending task will process. Right-click on
the media in the extended drive tree and select Clear Error Status from the
shortcut menu.

6 If there is no error status on the media the next pending task will automatically
begin processing.

NOTE &

The Format task cannot be canceled once it is in progress.

Ordering Media in the Queue
You can change the processing order of the media in the Media Task Queue

Manager using the arrows on the right side of the dialog box.

Figure 155: Promote/Demote Arrow Buttons

Media Task Queue Manager 5

Media | Tvpe | Statug | Location |.I'
@ Docs_2 SCHED  OMLIME - FILE RESTORE PEMD... “Wwsbgagne\Di Shared Stuff 2
SCHED  OMLINE - PREFETCH PENDING

Ww'shgagne!

Add Mew Media... I Edit Tasks... | Delete Tazks | St Trask [ Erogress
Cloge I Help |

Since all assigned tasks for a piece of media are processed at once, moving a piece of
media in the queue also moves all tasks assigned to that media.

To promote a piece of media in the queue:

9 Select the piece of media and click the up button.
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To demote a piece of media in the queue:

<2 Select the piece of media and click the down button.

Deleting Tasks for Media in the Queue

You can remove all pending tasks for a piece of media from the Media Task Queue
Manager dialog box. When you use the Delete Tasks button for a piece of media, al/
assigned tasks are deleted which removes the media from the queue.

NOTE &

To delete only a portion of assigned tasks for a piece of media, use the Edit Tasks
function.

To delete tasks for media in the queue:

1  Open the Media Task Queue Manager by selecting Media Task Manager from
the Tools menu.

2 Select the media for which you want to delete all assigned tasks.

3 Click Delete Tasks.

Figure 156: Delete Tasks Button

J Delete Tasks |

4 A message appears, confirming that all tasks should be deleted for the piece of
media. Click Yes. All tasks are deleted and the media is removed from the
queue. The Media Task Queue Manager dialog box reappears, without the
media in the queue.
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MEDIA TASK SCHEDULING

When assigning tasks to media, whether through the Edit Tasks option on the
shortcut menu, the Manage Media Tasks option in the tools menu, the Copy Media
Manager, or the Media Prepare manager, you can choose whether to have those tasks
process immediately using the ASAP — as soon as possible option, or to schedule the
processing of the tasks at a time when system resources are more readily available
and system traffic is at a minimum.

Each extended drive configured for the DISKXTENDER system has its own scheduling
capability that allows you to set up specific processing schedules for DX system
events. This scheduling capability allows you to process the tasks for extended drive
media at whatever time is most convenient for you.

The DISKXTENDER scheduler allows you to schedule begin and end times for four
different media activities: Move files to media; Process scheduled media tasks;
Update copy media; and Allow fetches from media. This section deals specifically
with configuring the scheduler to activate the media task queue and run the
scheduled tasks listed there by enabling the Process scheduled media tasks option in
the scheduler. The above sections of this chapter describe these media tasks and how
to add them to the media task queue.

DISKXTENDER media activities can be scheduled for a time range (e.g., 2am-4am).
This range provides a “window of opportunity” for the task(s) to occur. If for any
reason the task does not begin during this time, it will not be performed until the next
time the schedule is active.
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Figure 157: Media Activity Schedule Dialog Box
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QK. Cancel Help

You can access the scheduler by opening the extended drive properties, clicking on
the Settings tab then clicking the Schedule button. Colored lines represent each
activity and, when scheduled for a timeframe, appear in the appropriate block(s).

The schedule grid contains columns for each hour of the day and rows for each day
of the week, creating cells which each represent one hour. For example, the blacked
out cell in Figure 157 above represents 5 p.m. to 6 p.m. on Sunday. DISKXTENDER’S
scheduler allows you to set scheduled activities by selecting one or many cells in the
grid. You can easily schedule all activities for a large block of time, or you can
schedule specific activities for smaller blocks of time. In Figure 157 above the
Process scheduled media tasks activity is the only activity scheduled and will run
from 6 p.m. to 6 a.m. every day of the week.

For details on how to use the extended drive scheduler to set up media activity
schedules, see the Media Activity Scheduler section on page 219.
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